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Foreword 

 
The National Vocational & Technical Training Commission (NAVTTC) developed a National Skills Strategy (NSS) 
after extensive research and consultation with experts and stakeholders including policy makers and 
representatives from Industry, Academia and the Provincial Government departments dealing with technical and 
vocational training. The strategy aims at establishing a regime that facilitates competency-based and demand-
driven training and assessment.  
 
NAVTTC has developed competency-based training programs with the technical support of TVET Reform Support 
Programme (TVET-RSP), which is funded by the European Union, the Kingdom of the Netherlands, the Federal 
Republic of Germany and the Royal Norwegian Embassy. The Programme has been commissioned by the German 
Federal Ministry for Economic Cooperation and Development (BMZ) and is being implemented by the Deutsche 
Gesellschaft für Internationale Zusammenarbeit (GIZ) GmbH in close collaboration with NAVTTC. These vocational 
training programs have been approved by the National Curriculum Review Committee (having representation from 
all over the country from TEVTAs and industry) for implementation in Public and Private Training institutions. 
 
The purpose of developing competency-based training programs is to equip the learners with modern skills and 
knowledge for each of the trades to meet the requirements of local as well as international markets. These training 
programs include competency standards, qualification, curriculum, assessment material and teaching & learning 
material that will aid in implementation of competency-based and demand driven training in the country.  
 
This Teaching and Learning Material is part of the competency based training program exclusively developed to 
support the implementation of CBT curricula. This Material is intended for the use of learners undertaking training 
in National Vocational Certificate Level-3 in Information Technology (Computer Graphics – Print) under the 
guidance of experts and appropriate trainers. This Teaching and learning material has been designed in 
consultation with industry, academia and researchers to ensure that the material is relevant and current.  
 
On behalf of the Federal Government/NAVTTC, I wish to express my sincere appreciation and gratitude to all 
subject matter experts, industry representatives and TVET-RSP experts who have diligently contributed in 
producing this valuable Teaching and Learning Material. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Executive Director 
National Vocational & Technical Training Commission 

(NAVTTC) 
 
  



Introduction 

 
Computer Graphics Print is an area in Information Technology that helps in producing colorful cards, 
advertisements, logos, illustrations, charts, banners and other printable items. A Computer Graphic Designer can 
be employed in government and non-government organizations dealing with printing especially the print media. 
 
The National Vocational & Technical Training Commission (NAVTTC) has developed a national qualification 
entitled, “National Vocational Certificate Level-3 in Information Technology (Computer Graphics - Print)”. Relevant 
industry and employers were consulted in the design and validation processes in order to come up with a national 
qualification that fulfills the requirements of the sector in general and the occupation in particular.  
 
This Teaching and Learning Material (TLM) is developed based on competency standards and curriculum of the 
Computer Graphics (Print) national qualification. It carries a learning volume of 80 credits and includes eight learning 
modules which are as under:  
 
 

Module 1: Familiarization with Terminologies & Tools  
Module 2: Develop Design Concepts  
Module 3: Analyse Cost Effective Solution  
Module 4: Editing of Photos and Development of Graphics  
Module 5: Prepare Pre-Press Job  
Module 6: Perform Software/ Hardware Maintenance  
Module 7: Communicate with Others  
Module 8: Duties and rights at the workplace  

 
 
 
This TLM provides support for more effective training and productive learning. Each of the learning modules 
contains learning outcomes and information regarding learning elements in the form of knowledge, skills and 
attitudes. At the end of every learning module are Frequently Asked Questions (FAQs) and Test Yourself which will 
help learners in self-assessment before proceeding to modular or final assessment. 
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Module 1: Familiarization with 
Terminologies and Tools 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Describe the elements of design 

  Understand the principles of design 

  Understand the concept of perspective 

  Explain the color theory, and its relevance in design 

  Describe typography 

  Demonstrate the usage of tools in graphics software starting 

with Adobe Photoshop, Adobe Illustrator, In Design, and Corel 

draw. 
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Learning Unit 1: Elements of Design 

Overview 

In this leaning unit, you will learn the use of basic elements of design. Design elements are the building blocks 

used to create work of art. After the completion of this unit, you will be able to describe the significance of dot, 

line, color, texture, shape, size, value of tone, positive and negative space etc.  

 

1. Dot/ Point 

Dot/ Point is the smallest and the most basic element of 

design. These can be used in different sizes, values, colors, 

alone or in groups making lines or shapes in the design. 

Dots can be used to develop a pattern as if these are placed 

close, it gives a darker look and if placed apart, it gives 

lighter look. Many painters use patches and dots in there 

artwork. 

Dots and points are attention catcher, if you place even a 

single dot on a white surface, it will catch your attention easily. Dots are also important for formulation of other 

design elements as you place two dots and make a connection between them that will make a line. If there are 

three points, your mind will make a connection between them and make a triangle. The mind supplies the 

connections automatically. These are called as grouping, or gestalt.  

 

2. Characteristics and Types of Lines 

A line is a mark between two points. Artists use lines to create edges the outlines of objects. A 

line is created by the movement of the artist's pen. Line can be considered in two ways.  

The linear strokes made with a pen or brush or the edge created when two shapes meet.  

                                 Lines as linear strokes 

Since lines can be straight, curved, or irregularly shaped, you can 

also think of a line as the track of a point in motion. 

Thick lines are more powerful than thin lines. 

Lines act as borders between ideas, concepts and 

steps in sequence. 
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By using basic structure the concepts or ideas 

depicted through line drawing are easy to 

understand thus they are effective in learning. 

 

3. Categories of Shapes  

A shape is a self-contained defined area of geometric or organic form. A shape is created when a lines is 

enclosed. Shapes have two dimensions, length and width, and can be geometric or free-form. In painting the 

design basically a planned arrangement of shapes in a work of art. 

All the shapes are divided into two categories 

 

Geometric Shapes 

Geometric shapes or regular shapes are easy to recognize. Math can be used to find 

information about these shapes and these shapes generally have a specific name 

associated with them. Examples include: circle, triangle, square, and trapezoid. 

Organic Shapes 

Organic or freeform shapes are shapes that seem to follow no rules. Organic shapes generally do not have a 

name associated with them and are typically not man-made. 

 
Positive and Negative Shapes 

A negative shape is an empty shape or space, and is the background or surround of the subject matter. In a 

picture the shapes that an artist places are called positive space and the spaces around the positive space are 

called negative space. A positive shape in a painting automatically creates a negative shape. 

Shapes also 
communicate 
ideas. For 
example, an 
international 
company may use 
a circle in their 
logo that could 
suggest the earth. 

Remember 
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Negative and Positive Space 

 

4. Direction of Lines 

The direction of a line can convey mood or emotion. The different directions of lines used in design work are 

Horizontal, Vertical and Oblique. Each of them develop different effect. 

Horizontal lines 

Horizontal suggests calmness, stability and tranquility. They symbolize rest and 

relaxation.   

 

Vertical Lines 

Vertical gives a feeling of balance, formality and alertness. They also equate to power 

and strength.  

 

Oblique Lines 

Oblique give a feeling of movement and action. Diagonal lines are dynamic and action-

oriented. 

 

5. Size 

Size means how big or how small should an element be in the design. When designing 

a piece, size play an important role to make design functional, attractive and organized. 
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The first factor be considered is function: what should be the size of paper to be printed 

like for a brochure, what size should be appropriate. 

Second factor is to attract, you can use elements of different size in your design to 

attract your audience. 

Third factor is organization: the most important element should be largest and the 

element of the least importance should be smallest. Headings are the largest element 

in a text document and sub-headings and normal text are smallest elements 

 

6. Texture 

Texture gives your design piece a specific look and feel. They help to develop a mood 

in the layout and help to add liveliness and activity to the design. 

There are two types of textures.  

1. Tactile Texture 

The texture that can be felt for example think about the different type of paper you 

handled.  

2. Visual Texture 

Visual texture, is used to create the illusion of texture on a printed piece of design. For 

example, wallpapers etc. Pattern is a type of visual texture which is created by 

repeating a particular design element, shape or line. More dimension can be added to 

the surface using light and dark elements. 

 

7. Value / Tone 

Value means the darkness or the lightness of something. It also refer to the color of 

a design element. Every element of the design has a value. When laying out pages, 

an element's value will be affected by its background and other elements that are 

around it. For example, if you use a lot of text in a small area, it will make the paper 

look like it has turned gray. 

Value is also an important tool for expressing the theme 

or mood of your design. If you use values of black, white 

and gray in a design, you add power or change the mood of the design. 

Value also help to develop contrast by subtly blending shades of color.  

  

8. Positive and Negative Space 

Shapes defined by objects are positive shapes (space). Shapes defined around objects are negative shapes 

(space).The relationships between the positive and negative shapes help the brain of our viewers understand 

what they are seeing. Our brains are even capable of making sense of complex relationships between positive 

and negative shape. 

Size is simply the 

relationship of the 

area occupied by 

one shape to that of 

another. 

Size 

Texture is the 

surface quality of a 

shape - rough, 

smooth, soft hard 

glossy etc. 

Texture 
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Negative and Positive Space 

 

The negative space is defined by the edges of the positive space and the frame or border. So, part of our negative 
space is by the positive space. Sometimes the negative space is completely bounded by the positive space. 
What is important to note to note be that the negative space also defines our subject. 

 

 

Negative and Positive Space 
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Learner’s Activity 
 

Development of a Design using Basic Elements of Design 
 

Description:   This activity requires all the students to project their design ideas using basic 

elements of the design like dots, lines, shapes, etc. 

 

Time Guideline: 30 min 

 

Purpose:  To highlight the importance of design elements and their usage. 

 

Presentation:  

 

1- Ask the learners to select a design and project their ideas on white paper. 

2- Encourage the learners to make maximum use of design elements. 
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Learning Unit 2: Principles of Design 

Overview 

In this learning unit, you will learn principles of design and its implementation. After completion of this learning 

unit you will be able to define balance, recognize symmetric and asymmetric balance, apply gradation, explain 

the importance of repetition, contrast harmony, and describe the use of dominance and unity.  

 

1. Balance 

Balance in design acts just like balance in Physics. If there is a large shape near the 

center than it can be balanced by a small shape near the edge. Balance means the 

weight distributed in your design by the design elements. Balance provides structure 

and support to the design. 

You can have balance in your design by adjusting the graphical weight of your design 

elements in terms of color, size, contrast etc. 

 
Balance in a Design 

 

There can be two types of balance in your design: 

1- Symmetric 

2- Asymmetric 

Balance is a 

psychological sense 

of equilibrium. 

Balance 
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Symmetric Balance: 

Symmetric balance occurs when visual weight of the design element in your design is equally divided either 

horizontally, vertically or radially. This sort of balance acts as same design element on both sides of the central 

point of design.  

 

 Examples of Symmetric 

 

Asymmetric Balance: 

Asymmetric balance occurs when the visual weight of the design elements are not 

equally divided for the central axis of the design. This style depends upon visual weight 

for example it uses scale, contrast and color to achieve balance in the design. In our 

daily life we observe many design containing big images offset (out of the line) with 

small text not at balanced locations but balanced because of visual games. 

 

Symmetrical 

balance is difficult to 

evoke emotion from 

the Visual readers 

because it was 

impressed too 

"planned". 

Remember 

Informal balance is 

more dynamic than 

formal balance and 

normally keeps the 

viewer's attention 

focused on the 

visual message. 

 

Do you know! 
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Examples of Asymmetric Balance 

 

Balance by Value: 

Balance by value is achieved through small dark color element is balanced with wide 

bright area.  

In this example the prominent fire balloon on the top right corner is balance by wide sky 

blue area surrounding it.   

 

Balance by Shape: 

Balance by shape is achieved by complex and detailed area balanced with flat and 

simple area on the opposite side. 

In this example, one corner of the poster is tough with complex shapes and colors but 

it is balanced by the flat area around it. 

 

 

Balance by Texture: 

Small area with texture looks beautiful and balanced with wide area without texture. 

In this example, water ripple texture appears balanced with the wide area without 

texture.  

 

2. Gradation 

Gradation gives different perspectives to objects in your design. Gradation in size 

means a gradual change from small to large. Gradation in direction means a gradual 

change from vertical to horizontal. A gradation of size and direction at the same time 

produces linear perspective.  

For example when we apply gradation to the size and direction, it gives an illusion of 

increase in distance. 

Gradation applies to 

the incremental 

change in the state 

of a design element. 

Gradation 



Module 1: Familiarization with Terminologies and Tools 

12 |                                                           Teaching and Learning Material: Information Technology (Computer Graphics – Print) 

 

Gradation can add interest and movement to a shape in your design. A gradation from dark to light will cause the 

eye to move along a shape. Gradation is one of the most useful principles of design and the one that can be 

applied most easily. 

 

3. Repetition 

Repetition is a common concept in natural scenes from veins on a leaf to trees in the forest. The most important 

factor to be considered is variations in repetition. 

 

In the examples below you can notice the variations in the nature’s repetition designs. 

If there is no variation in a design with repetition, our brain will have just one look at the design and will understand 

that rest of the shapes are identical. That will add a monotone (unchanging) effect to the design. 

Gradation of color 

from warm to cool 

and tone from dark 

to light will produce 

aerial perspective 

Remember 
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When variation is introduced, mental activity is required to absorb the repeating elements. This removes 

monotony and adds interest even when the variation is minor. It causes the viewer to subconsciously engage 

with the art work.  

 
  

         Repetition without Variation              Repetition with Variation 

If you are using repeating elements as an area of relief in a design, variation is not necessary. If the repeating 

elements are to add to the interest of a design or painting, variation is important. 

 

4. Contrast 

Contrast is the juxtaposition of opposing elements. It can be a contrast in color 

(opposite colors on the color wheel), in value ( dark vs light ), in texture (smooth vs 

rough) or in direction ( horizontal vs vertical ). The major contrast should be at the 

center of interest in the design. Too much contrast scattered around in the design 

destroys unity, creates confusion in the design and makes it difficult to look at. 

Contrast simply tells us where to look first. Without contrast the design appears to be 

uninteresting, and hard to access because its not clear for the viewer where to look 

first. 

 
Contrast in Size 

While using contrast in size, small image makes large image to appear large and large image makes small image 

to appear small. 

 

Juxtaposition is the 

fact of things being 

seen or placed close 

to other with 

contrasting effect. 

Do you know! 
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Contrast helps objects in the design to stand out. Lack of proper contrast is the reason of simple camouflage.  

 
 

Improper use of contrast created camouflage making frog almost invisible. 

 

5. Harmony 

Harmony in visual design means all parts of the visual image relate to and 

complement each other. Harmony keeps the pieces of visual elements in your design 

together. Repetition and rhythm develop harmony in your design. Repetition 

reemphasizes visual units. 

connecting parts and creating an area of attention. Rhythm is the flow shown in a 

visual. Rhythm helps direct eye movement.

 

Patterns or shapes can help achieve harmony. By repeating patterns in an interesting arrangement, the overall 

visual image comes together. 

If your composition was using wavy lines and organic shapes you would stay with 

those types of lines and not put in just one geometric shape. 

 

 

 

Camouflage is the 

use of specific 

combination of 

coloration or 

contrast for hiding 

something or 

preventing it from 

being known.  

Do you know! 

Harmony 

Harmony is the 

visually satisfying 

effect of combining 

similar or related 

elements. 
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6. Dominance  

The principle of dominance occurs where you need to emphasize on some design 

element. No dominence between design element creates a comparison between them, 

for example if there are two red circles of equal size in your design, which should I look 

at first?. Every design should have a central and primary point that acts as the way into 

the design. From central point, design flow can be achieved by using elements with 

secondary or tertiary dominence. 

While dominating an element the right positioning is very important so that it may not 

disturb the balance of design. 

For example a dominent element at the center of the design develops symmetry and formal look. On the other 

hand a dominent design element close to the edge develops an out of balance design. 

 

Dominance in Size 

 

In the above example, without dominence, the picture is not that interesting, our brain tries to follow confused 

paths around the photograph. 

Dominance will 

create an entry point 

on the page from 

which you can lead 

the viewer to other 

parts of the page. 

Remember 
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By adding some dominence through a large size boat this picture is now able to direct our attention to the large 

size boat. 

 

By adding warm colors to the boat instead of dominent cool color, the visual impact of the design is increased 

with balanced symmetry. 

You can add more visual weight to elements through; 

 Size – As you would expect larger elements carry more weight. 

 Color – It’s not fully understood why, but some colors are perceived as weighing more than others. Red 

seems to be heaviest while yellow seems to be lightest. 

 Density – Packing more elements into a given space, gives more weight to that space. 

 Value – A darker object will have more weight than a lighter object. 

 Whitespace – Positive space weighs more than negative space or whitespace. 

7. Unity 

Unity means that all the components and design elements in your design support each 

other and all work together towards a common goal. 

All the elements should look like they belong to one another not that they are 

temporarily placed in the design. 

 

In design working 
toward the same 
unified goal is the 
idea of unity. 

Remember 
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You can think of unity in two ways; 

1- Visual Unity where all the shapes or elements are aligned along the same axis and the color and style 

of elements work together to create a meaning. 

 

2- Conceptual Unity where all the images in the design follow the same concept. For example diamond, a 

mansion and a pile of money together give a concept of wealth. 

 

Unity is very important for our design because our design is meant to convey a single meaning. The more the 

elements of your design unified the more will message be clear to the viewers. 

Unit develops completeness and a single idea in the design. Too much unity in the design can develop dullness 

and lifeless effect in the design so variety must be added to create interest and energy to the design. Too much 

variety can lead towards distortion and difficulty to read. There should be a balance between unity and variety in 

the design. 

 

 

We can use the basic concepts of design to achieve unity; 

 Contrast: Helps to add variety to unity. 

 Repetition: Things that look alike are more related to one another. 

 Alignment: Elements that appear to be on the same axis apear more related to each other. 

 Proximity: Object closer to each other appear to be more related. 

Similarly our selection of colors, images, style and contrast all should conceptualy be related to the central idea 

of design. 
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Learner’s Activity 
 

Understanding the Importance of Principle of Design 
 

Description:   This activity consists of an assignment for each student to review the design 

developed in the previous activity keeping design principles of design in mind.  

 

Time Guideline: 30 min 

 

Purpose:  To highlight the importance of design principles. 

 

Presentation:  

 

Ask each student to review his previous design and make improvements according 

to the design principles. 
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Learning Unit 3: Understanding the Concept of 
Perspective 

Overview 

Perspective allows the artist to develop a design that looks realistic. In this learning unit, you will learn about use 

of perspective to arrange elements in the design so that they look realistic, perspective as a learned meaning of 

relationship between objects, use of perspective to draw attention of audience towards a visual so you can 

achieve perspective in your design. 

1. Perspective 

The concept of perspective means use of techniques to draw a three dimensional scene on two dimensional 

surface as close to the real world as possible. It helps to control the illusion of depth in the image from a few 

inches to many miles. 

 

The concept of Perspective 

Perspective is a great way to create realistic or measured designs.  

Perspective can be linear or atmospheric 

Linear Perspective 

Linear perspective is achieved by drawing line that converge toward and look like to meet at some vanishing 

point in the horizon. 

Horizon is also known as eye level if the person is looking straight ahead. It means that 

the perspective drawing of the same object or scene will be different depending upon 

the position of the eye level or horizon. For example a person sitting on a chair looking 

straight will not have the same view of the room as the person standing and looking 

straight.  

The objects that are parallel to each other have same vanishing point.  

Horizon is an 

imaginary line 

across the scene at 

your eye level. 

Horizon 
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   Vanishing point as seen from different horizons 

Atmospheric Perspective 

Atmospheric perspective gives a view of scene or image from top. Atmospheric perspective deals with how the 

appearance of an object is affected by looking at it through a layer of air. Moisture, dust and pollutants in the 

atmosphere act to filter the visual information. 

 

Atmospheric Perspective 

The changes follow the following simple rules.   

Contrast 

The contrast of the close objects is high and that of far object is low. 

Color 

Colors are also more visible on the close objects. Warm colors also appear clearer on close objects. As we get 

farther away colors fade and eventually turn to blue and grey tone. 

Focus 

Close objects have sharper focus than the far objects as our mind sees objects with soft edges as farther away 

than the sharp edged objects. 

 

Vanishing points are 
points on the 
horizon line where 
receding lines 
converge. 

Do you know! 
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Details 

Because of the above reason the details are visible for the closer object. As the distance increases scene become 

fade making details invisible. 

2. Perspective as Relationship between Different Objects 

Perspective is a learned meaning of the relationship between different objects seen in space. For example look 

at the picture below 

 

Visual and Perceptive Reality 

We can look at this picture as a black circle partially hidden by the red circle (a natural way). But in actual may 

be it is a half black circle placed with a red circle as shown on the right.  

We need to be able to differentiate between optical and perceptual reality. Optical reality consists of geometry 

rules and is only visual. Perceptual reality on the other hand combines what we already know about the object 

and what we can see, hear and smell. 

In perception drawing, the concept is very much affected by what we experience in our daily lives that makes the 

design as much related to the real life as possible. 

3. Use of Perception to Draw Audience to a Visual 

Perspective allows the designer to use third dimension to place objects and draw the audience into a visual. It 

adds a realism to the design and makes it less abstract to the audience. 

 



Module 1: Familiarization with Terminologies and Tools 

22 |                                                           Teaching and Learning Material: Information Technology (Computer Graphics – Print) 

This is a very useful tool when introducing a new idea or concept to the audience. The more concrete and less 

abstract a design is, easier it is to relate and understand.  

We can use converging lines to draw the audience vision to the vanishing point representing the main idea or 

concept. 

 

Drawing Audience’s Attention to a Vision 

4. Achieving Perception in the Design 

Perception can be achieved in your document in many ways. 

Through relative size objects 

Perception can be achieved by using objects of relatively different sizes. Large size object make the smaller 

objects to look even smaller and give an effect of being far away. Similarly small object make the large objects 

look larger and give closer effect. 

 

Perception through Relative Sized Objects 
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Through overlapping objects 

Overlapped objects indicate the relative positions of the objects. For example from audience’s point of view, 

objects that appear on top are nearer and close while objects beneath the top object appear to be at a position 

after the top objects and are farther. 

 

Perception through Overlapping Objects 

Blurring or sharpening objects 

As seen from horizon whether in linear or atmospheric perspective, the objects or element that need to appear 

far, are blurred in terms of contrast, color, sharpness and details. They turn to be dull with blue or grey color. 

The closer objects can be sharper to draw audience visual to them. 

 

Perception through Sharpening Objects 
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Learning Unit 4: Color Theory and the Meaning of Colors 
in a Design 
 

Overview 

Colors are very important while giving expression to the design. In this unit, you will learn about the color theory, 

warm colors, cold colors, and neutral colors. After completion of this learning unit, you will be able to define 

different terminologies of color like hue, saturation, tones, shades and tints. 

1. Warm Colors 

 

Warm color makes you think of sunlight and warmth. Warm colors include red, orange, 

yellow and the variations of these three colors. Red and yellow are both primary colors, 

and the orange color comes in the middle, which means warm colors are all truly warm 

and aren’t created by combining a warm color with a cool color. Warm color are used 

to reflect happiness, passion, enthusiasm, and energy in your design. 

 

Red (Primary Color)  

 

Red is a very hot color. It is associated with fire, violence and warfare. It is also associated with importance. 

Red color has physical impact on human, it raises blood pressure and respiratory rate. Red color can also be 

associated with anger and danger as well. 

Red color acts very powerful in a design. It can have an overpowering effect if it’s used too much in designs. It’s 

a great color to use when power or passion want to be shown in the design.  

Orange (Secondary Color) 

 

Orange is a vibrant and energetic color. It is associated with earth and autumn. As 

orange describes change of season, it can be thought of to be a sign of change and 

movement. As orange is also a name of a fruit so it can be associated with health and 

energy. Orange color takes attention without being overpowering like red.  

 

 

Power of Red 

 

Attention Gaining 
Orange 
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Yellow (Primary Color) 

 

Yellow is considered to be the brightest and most energizing of the warm colors. Yellow 

color can be associated with hope and to some extent for danger. 

In your designs, bright yellow can develop a feeling of happiness and cheerfulness.  

Softer yellows are commonly used as a gender-neutral color for babies and young 

children. Dark yellows and gold-hued yellows can sometimes look antique so we can 

use these colors in the designs where we want to give an effect of long life and stability. 

2. Cool Colors 

 

Cool colors are the color which are related to night, water, nature. Cool colors are calming, relaxing and closer 

to nature. 

Cool color include green, blue and purple. Among the cool colors, blue is the only primary color. Other colors are 

created by combining blue color with some warm color. For example blue with yellow for green and with red for 

purple color. 

Cool color develop a feeling of relaxation and clamness in your design. 

Green (Secondary Color) 

 

Green color is the sign of growth, renewal and beginning. Green color can also 

represent lack of experience. Green color is calm like blue but it also have energizing 

effect of yellow. It has a balancing and harmonizing effect. It can used  in the designs 

representing wealth, stability, renewal and nature. 

Blue (Primary Color) 

 

Blue is used to represent calmness and responsibility. Light blues can be refreshing 

and friendly. Dark blues are more strong and reliable. Blue is also associated with 

peace. 

The meaning of blue is affected depending on the shade and hue. In design, the exact 

shade of blue you select will have a huge impact on how your designs are perceived. Light blues are often relaxed 

 

Calm effect with 

Yellow 

 

Nature in Green 

 

Nature in Blue 
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and calming. Bright blues can be energizing and refreshing. Dark blues are excellent for corporate sites or 

designs where strength and reliability are important. 

Purple (Secondary Color) 

Purple is associated with royality. It’s a combination of red and blue, and has the 

attributes of both. It’s associated with creativity and imagination. 

 

In Thailand, purple is the color of mourning for widows. Dark purples are traditionally 

associated with wealth and royalty, while lighter purples are considered more romantic. 

In design, dark purples can give a sense wealth and luxury. Light purples are softer 

and are associated with spring. 

 

3. Neutral Colors 

Neutral colors often serve as the backup colors in design. They’re commonly combined with brighter colors. But 

they can also be used on their own in designs, and can create very sophisticated layouts. The meanings and 

impressions of neutral colors are very much affected by the colors that surround them in the design 

Black 

Black is the strongest neutral color. On the positive side, it’s commonly associated with 

power, elegance, and formality. On the negative side, it is associated with evil, death, 

and mystery. Black is the traditional color of mourning in many countries.  

Black is commonly used in edgier designs, as well as in elegant designs. It can be 

either conservative or modern, traditional or unconventional, depending on the colors 

it’s combined with. In design, black is commonly used for typography and other 

functional parts, because of its neutrality. Black can also be used to add a sense of 

sophistication and mystery in your design. 

White 

White is at the opposite of black, but like black, it can be used successfully with any 

other color. White is associated with purity, cleanliness, and virtue. In the West, white 

is commonly worn by brides on their wedding day. It is also associated with the health 

care industry, especially with doctors, nurses and dentists. White color is associated 

with goodness, and angels are also portrayed in white. 

When white is used with other colors in design, it increases their effect. It gives a feeling 

of cleanliness and simplicity. White can represent winter or summer depending upon 

the color it is used with. 

 

 

 
 

Royal Color Purple 

 

Strong Black 

 

Strong White 
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Gray 

Gray is a neutral color, gives a cool effect. Light grays can be used in place of white in some designs, and dark 

grays can be used in place of black. 

Gray adds a formal effect to design, but can also be modern. It’s commonly used in corporate designs, where 

formality and professionalism are important. It can be a very sophisticated color. Pure grays are shades of black, 

gray shades may also have brown or blue effect in them. In design, gray backgrounds and gray typography are 

very common. 

Brown 

Brown is the color of the earth, wood, and stone. It is a completely natural color and a warm neutral. Brown can 

be associated with dependability and reliability. It can also be considered dull. 

In design, brown is commonly used as a background color. Sometimes used in wood textures and sometimes in 

stone textures. It helps bring a feeling of warmth to designs. Sometimes darkest brown color is used in a design 

as a replacement for black, in backgrounds or typography. 

Beige and Tan 

Beige is a unique color, as it can take on cool or warm tones depending on the colors 

around it. It has both the warmth of brown and the coolness of white. It is mostly used 

for backgrounds and is commonly seen in backgrounds with a paper texture. It will take 

on the characteristics of colors around it, has little effect in itself on the final impression 

a design gives when used with other colors.  

Cream and Ivory 

Ivory and cream are sophisticated colors. They have a little warmth of brown and a lot of the coolness of white. 

These color are normally quiet, and give a sense of history.  

In design, ivory can add a sense of elegance and calmness. It can also be used to lighten darker colors. 

4. Concepts and Terminologies of Colors 

The properties of color help us to define a color. The better you understand these terminologies the better you 

will be able to adjust the colors according to your needs. Following color terminologies are important. 

Hue 

Hues are the family of twelve purest and brightest colors. 

 Three Primary Colors 

 Three Secondary Colors 

 Six Tertiary Colors  

These color make the full spectrum of primary color wheel. From these twelve colors 

you can make infinite number of color schemes by mixing these hues with other colors. 

 

Nature in Colors 

 

Hue 
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They can also be used in their purest form too, making a multicolor exciting and cheerful theme. For example 

children rooms or corners in your advertisement to gain attention 

Tones 

All the colors we see around us in the world are toned a little or more. This makes them 

even more pleasing. Tone is created by adding grey to a color. Any color that is “greyed 

down” is said to be toned. 

Tones are more interesting because they are complex and sophisticated. Painters add 

a little grey to each color to adjust the value and intensity. 

 

Saturation 

Saturation can also be called intensity of a color. It is a measurement of difference from a pure color to pure grey 

color. Saturation is not exactly about light and dark, but it means how pale or strong the color is. The saturation 

of a color is not the same, but it changes depending on the surroundings and what light the color is seen in. 

Shades 

Shades are created by adding black to a color. You can mix hue color together and add 

a little black to it making the shade on the mixture. Shades vary from the darkest even 

black to pure hue color.  

Artists don’t use shades often because black can destroy the main color quickly. 

Shades are deep, powerful and mysterious. Too much use of black can add 

overpowering. 

Chroma 

Chroma is the perceived strength of a color, the degree of visual difference from a neutral grey of the same 

lightness. Chroma is defined as "colorfulness" of an object relative to the brightness of a white object similarly 

illuminated. 

Tints  

Tints are created by adding white to a color. For a complex tint, mix the desired colors 

from hues and then add a little white to it.  

Tints can vary from pure hue colors to extremely pale or nearly white color. Artists use 

tints to give a little body to the colors.  

 

Value 

Value refers to the lightness or darkness of a color. It indicates the light reflected. 

 

 

Tones 

 

Shades 

 

Tints 
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Learning Unit 5: Typography 
 

Overview 

Understanding the rules and principles of typography is the first step of being a typographer. In this module, you 

will learn about concept of typography, the expressions of different fonts, their families and the use of typography 

in design. After completion of this learning unit, you will be able to choose a typeface, make it work with layout, 

color scheme and grid design theme. 

 

1. Definition of Typography Anatomy, Expression of Different Fonts, their Families 
and its Use in Graphics Design 

Typography  

Typography is, quite simply, the art and technique of arranging type in your design. 

Typeface anatomy describes the graphic elements that make up printed letters in a 

typeface. In order to become skilled in typography, you need to learn the basic rules. 

 

Anatomy of Typography 

Counter 

Fully or partially enclosed space within a letter.  

 

Aperture 

Opening at the end of an open counter. 

 

Arm 

A horizontal stroke not connected on one or both ends. 

 

Ascender 

An upward vertical stroke found on lowercase letters that extends above the 

typeface’s x-height.  

 

Baseline 

The invisible line where letters sit. 

The style and 
appearance of 
printed matter. 

Typography 
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Bowl 

A curved stroke that encloses a letter’s counter. 

 

Crossbar 

A horizontal stroke. 

 

Descender 

A downward vertical stroke found on lowercase letters that extends below the 

baseline. 

 

Diagonal Stroke 

An angled stroke. 

 

Ear  

A small stroke projecting from the upper right bowl of some lowercase g’s. 

 

Finial  

A tapered or curved end. 

 

Ligature 

Two or more letters are joined together to form one glyph. 

 

Link  

A stroke that connects the top and bottom bowls of lowercase double-story g’s. 

 

Loop  

The enclosed or partially enclosed counter below the baseline of a double-story 

g. 
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Lowercase  

The smaller form of letters in a typeface. 

 

Serif 

“Feet” or non-structural details at the ends of some strokes. 

 

Shoulder 

A curved stroke originating from a stem. 

 

Small Caps 

Uppercase characters that appear as a smaller size than the capital height of a 

typeface. Short for “small capitals”. 

 

Spine  

The main curved stroke for a capital and lowercase. 

 

Spur 

A small projection from a curved stroke. 

 

Stem 

Primary vertical stroke. 

 

Tail 

A descending stroke, often decorative. 

 

Terminal 

The end of a stroke that lacks a serif. 
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Uppercase 

A letter or group of letters of the size and form generally used to begin sentences 

and proper nouns. Also known as “capital letters”. 

 

x-height 

The height of the main body of a lowercase letter. 

 

Font Families Expressions and their Use in Design  

Below are the most used families in design works. 

 

Helvetica 

Helvetica is the most commonly used font by professionals in graphic design. Mostly it is liked but some of its 

users believe that it is too tightly spaced.  

 

Trajan 

Trajan has also been used in some Hollywood movies posters. It is commonly used in the designs related to 

religion, law, marriage, class or the past.  
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Garamond 

There are many versions of Garamond, the most commonly used version is the Adobe Garamond version. 

Garamond is a great font which can be used for magazines, textbooks, websites and long bodies of text. 

Garamond was recently named the second best font (after Helvetica) by a German publication. 

 

Futura 

Futura is normaly used in large displays, logos, corporate typefaces and in books where small text is needed. 

Futura is based on geometric shapes for example circles, triangles and squares. Futura has an appearance of 

efficiency and forwardness. 

 
Bodoni 

Bodoni is a great font for headlines, decorative (trending to attraction) text and logos. Bodoni has a narrow 

underlying structure with flat, unbracketed serifs. The face has extreme contrast between thick and thin strokes, 

and an overall elegant geometric structure which makes it a very beautiful looking font. 
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Bickham Script Pro 

Bickham Script Pro is used mostly for formal occasions, Bickham Script Pro is a font which does the job well. 

 

Frutiger 

The Frutiger font family is not very much geometric nor humanistic in construction.Its forms are designed so that 

each individual character is quickly and easily recognised. Such distinctness makes it good for display work and 

it is often used in Web 2.0 Logos. It is very good for smaller body of text in magazines and booklets. 

 

2. Choosing Typeface and Integrating it with the Layout, Grid, Color Scheme and 
Design Theme 

Following are the most important typographic considerations that a designer should keep in mind while choosing 

an appropriate font for the design. 

Readability 

The type is to read so try hard not to make is difficult to read by using tiny font sizes, crowded line-height or 

simple plain ugly looking font.   

Using nice and readable font makes your design more appealing and understandable. 
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Size 

All the typefaces are not equally created. Some are fat and wide others are thin and narrow. Different typefaces 

occupy different space in the design. So it is important to choose the right type size that fits perfectly in the design. 

The most common method to measure the size is point. One point is equal to 1/72 inches. Type size may also 

be measured in inches, pixels and millimeter.  

 

Leading 

Leading is the vertical distance between the lines of type. If there is rich text in your 

design, in order to make it comfortable to read, use leading greater than the font size 

used. Normally it is 1.25 to 1.5 times of the font size. 

Tracking and Kerning 

Kerning means adjusting the space between characters to develop a harmonious effect. For example when an 

uppercase A meets uppercase V. Their diagonal strokes are kerned so that the top left of V sits at the bottom 

right of A. 

Tracking deals with the spacing of all the character and is applied evenly. 

Measure 

Measure means the width of the text block. It is important for a good reading experience. 

Hierarchy and scale 

If all the text is of same size then reader will not be able to know which of the text was most important so to guide 

the reader, headings are a bit larger in size, then sub headings are a bit smaller and the regular type is even 

smaller. 

Color Scheme 

While adding type to your design color scheme is very important part. It is not only about the overall look of the 

design but also about the readability of text. For example black text on white background is known to be the most 

readable format. Whatever color scheme you use, make sure the type is readable. 

Grid 

Using grid helps you a lot in formulating the layout of your design. If you use the best font, spacing and colors 

but the layout is not good then your design will be distorted and hard to understand. 

Using a grid when you're designing with type provides a clear balanced and geometric structure to your design.  

Try to design with grid from start, it gives a solid structure to your design. 

Fonts 

When choosing a font for your website, your font should be unique. Not only unique but the font should also work 

well with the design theme and the real feeling of the design. 

 

Leading 
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Learning Unit 6: Study Tools and Software for Graphics 
and Artwork Creation 
 

Overview 

Different graphics software are used to develop computer graphics. In this unit, you will learn about and use tools 

in different graphic software like, Tools in Adobe Photoshop for creating and editing images, graphics, pictures, 

etc., Tools in Adobe Illustrator for creating and editing type, and text, Tools in Adobe InDesign for creating and 

editing type, text, and layout, Tools in Corel Draw. 

 

1. Procedures of Using Tools in Adobe Photoshop 

Adobe Photoshop is the most commonly used photo editing software used in the world. 

When you start Photoshop, the Tools panel appears at the left of the screen. You can 

expand some tools to show hidden tools beneath them. A small triangle at the lower 

right of the tool icon signals the presence of hidden tools. 

 
 

Open an image in Adobe Photoshop as 

Adobe Photoshop is 
a raster graphics 
editor developed 
and published by 
Adobe Systems for 
Macs and Windows 
PCs. 

Adobe Photoshop 
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1- Open Adobe Photoshop and click at File->Open 

 

2- Select the image file to be opened and click at open. The file will be opened in Adobe Photoshop and 

now you can use different tools on it. 

 

Using Selection Tools 

Marquee Tool (make rectangular, elliptical, single row, and single column selections.) 

1- Select the marquee tool by clicking at the icon in the toolbox. 

 
 

2- Clicking and holding on the Marquee icon will give you a small popup menu where you can select the 

variations: Rectangular marquee, Elliptical marquee, for selecting circles and ovals and a single-pixel 

marquee for both horizontal and vertical. 
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3- For now, select the Rectangular marquee, place your cursor somewhere in the upper left of the image, 

then click and drag the mouse. You will see the selection expands with the pixel values to the right of the 

selection. 

 

4- From here, you can copy the selection, move it, and apply filters to it. Almost everything you do in 

Photoshop starts with a selection. 

 

Lasso Tool (make freehand, polygonal (straight-edged), and magnetic (snap-to) selections.) 

1- Select lasso tool from toolbox. Its variants include the Polygonal Lasso tool, and the Magnetic Lasso tool. 

 
 

2- Click and hold the mouse button and then draw around some object on the image. As you reach the last 

point, release the mouse button and the selection will auto-complete. 
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3- Polygon Lasso Tool works in the same way. Click at some point after selecting polygon lasso tool. As 

you move your mouse you will notice that the starting point is pinned and a dashed line extends towards 

cursor. Click again, and that next point becomes pinned. You can continue clicking until your selection is 

complete. At the end double click and the selection will auto complete. 

 

4- Press the Escape key at any time to cancel the selection in progress. 

 

Using the Crop Tool (The Crop tool trims images) 

 

 

1- Select the crop tool from toolbox as 

 

2- To crop an image, either drag the handles to surround the part of the image you wish to keep, or click and 

drag inside the image to draw the area to crop.  

 

3- Then press Enter 
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Using the Text Tool   Select the text tool from toolbox 

1- Click anywhere in the image, a box with a blinking cursor will appear. 

 

2- Adjust the font setting at the top. Containing, font size, family, color, wrap, justification etc. 

 

 

Using the Brush Tool (Paints the brush strokes) 

1- Select the brush tool from toolbox as 

 

2- Pick a color for the brush by clicking at the foreground color chip a color picker window will appear. Select 

a color. 
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3- Select the size and softness of brush from top left corner 

 

4- Draw the strokes on the canvas. 

 

Using the Clone Stamp Tool (paints with a sample of an image.) 

1- Select the clone stamp tool from toolbox. 
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2- Select the brush type from the top left corner. 

 

3- Before you can clone the image, you need to select what you're actually copying. Holding down the 

Option (Alt) key, and click on the image about where you want to set the source as shown by the red 

target. 

 

4- Click and hold the mouse button and paint on the other side of image as shown in the about right 

image. 

 

Using Spot Healing Brush (paints with a sample or pattern to repair imperfections in an image.) 

1- From the toolbar, select the spot healing brush. 

 

2- Alt-click (click holding down [Alt] key) somewhere on your image to define a sampling point. 

3- Paint with the Healing Brush Tool on the damaged area. 

Using Dodge Tool (lightens areas in an image.) 
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1- Select the Dodge tool from toolbox. 

 

2- Adjust the size, hardness and exposure in the brush palette. 

 

3- Drag the dodge tool on the image and it will lighting effect on the image as in the below image a lighting 

effect is added at the white boat. 

 
 

2. Procedures of Using Tools in Adobe Illustrator for Creating and Editing Type, and 
Text  

Type on a Path 

1- Open Adobe Illustrator. 

 

2- Open your image as File->Open->Click at the image->Open. 
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3- Draw a straight line using pen tool from the Tools Panel. 

 

4- Select convert anchor point tool, and drag the handles of one anchor point to a 45 degree angle. This 

will create a small arc. 

 

5- Hold the mouse on the Type Tool (T) in the Tools Panel to view the fly out menu. Select the Type on a 

Path Tool and click on the top of the arc in the image. 

 

6- From the top menu, choose Window > Type > Paragraph. In the Paragraph Menu, select Align Left. Type 

a phrase and the text will begin on the left side of the arc and follow the path. 

 

7- To move the text on the path, select the Direct Selection Tool (A) from the Tools Panel and click on the 

left bracket (near the anchor point). A small perpendicular icon will appear. 
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Text on a shape 

1- Draw a circle using the Ellipse Tool from the Tools Panel. Select the Type on a Path Tool as before in 

above method. 

 

2- Click on the top center of the circle and begin typing. Again, use the brackets and perpendicular icon to 

drag the text along the circle. 

 

 
 

3- Repeat the same steps for text on polygon, square etc. 
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Create a Text Box 

 

1- Select type tool Icon from Toolbar 

 

2- Drag mouse to create the size of your text area. 

 

3- Type the text in text box. 

 
 

Changing Font Color 

1- To change your font color, look at the color icon, you will see a fill and stroke. Click at the part you want 

to change color, for example, if you want to change a fill color, click at fill icon before choose a color. 

Below picture shows a font with fill color and stroke set to none. 
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2- The below picture shows text with stroke only. 

 

3- To change the font color, click on your font and then select which part you want to change (fill or stroke). 

Select the color from Color panel. 

 
Character Panel 

This is a panel in Adobe Illustrator where you can alter the appearance of your type character by character.  

 

1- Open character panel as window->type->character 

 

2- In the character panel, you can make following changes 

 

 Font family (in this case Myriad Pro) 
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 Font style (version of the font such as Regular, Bold, Light, Condensed etc.) 

 Leading (line-height) 

 Kerning (spacing between two characters) 

 Tracking (character spacing across a selection) 

 Horizontal scale (character width) 

 Vertical scale (character height) 

 Baseline shift (height of baseline upon which text sits) 

 Character rotation (rotation in degrees of specified characters) 

 

Paragraph Panel 

 

1- Open paragraph panel as window->type->paragraph 

 

2- You can make following changes to paragraph in this panel 

3- You can change here indentation, alignment, and spacing above and below paragraphs. 

4- You can also put hyphenation On or Off. 

3. Procedures for Using Tools in Adobe InDesign 

Following are the tools in Adobe InDesign 
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In Adobe InDesign, text is not added to a blank page, instead all the text is added in text boxes. 

Typing Text 

1- Select the Type Tool (T) in the toolbox. 

2- Click and drag on the document to create a text frame. 

3- Release the mouse button and begin typing content in the text block. 

Importing Text 

You can import text from some word processing program like MS word into InDesign. 

1- In InDesign, go to File > Place. 

2- In the bottom, right corner select the Show Import Options checkbox. 

3- Select OR deselect the Replace a Selected Item checkbox depending on whether you want the imported 

text to replace a pre-existing highlighted item. 

4- Select the item from the hard-drive (or any other storage device). 

5- Press the Open button. 

6- The Microsoft Word Import Options window appears. 

7- Select OR deselect the Remove Text and Table Formatting checkbox depending on whether you want 

to keep or throw away the formatting. 

8- Press the OK button. 

Flowing Text into Frames 

If you have created a text frame, and a red icon  appears in the bottom, right corner, that you have text that 

exceeds the boundaries of the text frame. 

1- Expand the dimensions of the text frame. 

2- Click once to highlight the text frame using the selection tool (black arrow tool). 

 

Adding Text Frames 

To add a frame to a thread before an existing text frame: 

   

Before an existing text frame   After an existing text frame 

1- Click once to highlight the text frame using the selection tool (black arrow tool). 

2- Click on the white in port in the upper left-hand corner and the mouse cursor will change. 
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3- Click-and-drag to draw another text frame before the existing text frame. 

To add a frame to a thread after an existing text frame: 

1- Click once to highlight the text frame using the selection tool (black arrow tool).  

2- Click on the (red or white) out port in the bottom right hand corner and the mouse cursor will change. 

3- Click-and-drag to draw another text frame after the existing text frame. 

Move Text Frames 

1- Choose the Selection Tool (black arrow tool). 

2- Click once to highlight the text frame. 

3- Click-and-drag anywhere in the center of the text frame to move it to a desired location. 

Resize Text Frames 

1- Click once to highlight the text frame using the selection tool (black arrow tool). 

2- Click-and-drag one of the white squares (on the outer four corners) away from 

the text frame until it enlarges to the desired size. 

 

 

Deleting Text Frames 

Deleting threaded (linked) text frames will not affect the actual content within the frames. 

1- Click once to highlight the text frame using the selection tool (black arrow tool). 

2- Press the Backspace or the Delete key on the keyboard. 

Edit Stories in Story Editor 

1- Select text or text frame. 

2- Choose Edit > Edit in Story Editor. 

3- Edit text and simply close the window after you are finished. 

Spell Check 

1- Go to Edit > Spelling > Check Spelling. 

2- Press the Start button to begin the spell checking process. 

3- Press the Done button to end the spell checking process. 

Text Frame Options 

1- Text Frame Options allow you to change settings in relation to specific text frames.  

2- Click once to highlight the text frame using the selection tool (black arrow tool). 

3- Go to Object > Text Frame Options. 

4- Change number of columns, alignment of text, or change spacing between the text and the frame. 

Formatting Text 

To change the character formatting (i.e. – font, size, etc.): 

Resizing a text 
frame doesn’t 
change the size of 
the type. 

Remember 



Module 1: Familiarization with Terminologies and Tools 

Teaching and Learning Material: Information Technology (Computer Graphics – Print)                                                           | 51 

1- Make sure the A button is selected in the Formatting palette. 

 

2- Highlight the text using the Text tool. 

3- Change the character formatting using the Formatting palette on the top of the screen. 

To change the paragraph formatting (i.e. – justification, line spacing, etc.): 

1- Make sure the ¶ button is selected in the Formatting palette. 

 

2- Highlight the text using the Type tool. 

3- Change the paragraph formatting using the Formatting palette on the top of the screen. 

4. Procedures for Using Tools in Corel Draw 

Pick Tool Selection 

 

1- Click at the pick tool from the toolbox. 

2- Click at the object. 

3- Now you can resize the object by dragging the handles. 

 

 

 

 

 



Module 1: Familiarization with Terminologies and Tools 

52 |                                                           Teaching and Learning Material: Information Technology (Computer Graphics – Print) 

Move Object  

 
 

1- Click at the object. 

2- Click and drag the object to desired location. 

3- Leave the mouse. 

Rotate Object 

 

1- Double click the Object. 

2- The handles will change into double headed arrows.  

3- Click and drag any arrow to rotate from that corner. 

4- Hold Ctrl key to rotate with 15 degree angle increments. 
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Skew Object  

 

1- Double click the rectangle. 

2- Double-ended selection arrows will appear.  

3- Click and drag on one of the side handles to skew the rectangle. 

4- Release mouse button when desired effect is created. 

Shape Tool Selection 

 

1- Draw a rectangle.  

2- Choose the Shape Tool from the Toolbox and click on the rectangle.  

3- Note the selection now appears as four corner handles and dotted lines. This indicates that the object is 

active with the Shape Tool.  

4- Click and drag on one of the corner handles. Note how the corners become round. 
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Create Rectangle 

 

1- Choose Rectangle Tool.  

2- Click and drag to create rectangle of the shape and size you desire. 

Create and Ellipse or Circle 

     

1- Click at ellipse tool from toolbox. 

2- Draw an ellipse or hold down ctrl button and draw a circle. 

Create a Spiral Object 
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1- Choose Spiral tool from toolbox. 

2- Draw a spiral by holding and dragging mouse. 

 

Smudge Brush  

Change the shape of an object by dragging along its outline.  

1- Click at the smudge brush in toolbox.  

2- Click at the inner side of shape to move it inwards 

3- Click at the outside of shape to move it outwards 

 

Roughen Brush Tool 

Distort the edge of an object by dragging along its outline. 

1- Click at roughen brush tool in toolbox.  

2- Point the brush along the outline of object to rough its outline. 

 

Twirl Tool   

Add swirl effects by dragging along the outline of an object. 

1- Click at twirl button in toolbox.  

2- Click at the object’s outline and hold until twirl is of desired size. 

 

Knife Tool 

Slice an object to split it into two separate objects. 
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1- Click at knife tool. 

2- Point the knife at the outline of the object where to want to start cutting. 

3- Click and drag the knife along the path towards the target point. 

4- Release the mouse. 

 

Eraser tool  

Remove unwanted areas in a drawing.  

1- Click at the erase tool.  

2- Drag over the part of object where you want to erase. 

 

Bezier Tool  

Draw curves one segment at a time. 

1- Select the Bezier tool.  

2- Start drawing by clicking at drawing area. 

3- To draw a straight line point to the end point and click. 

4- To draw a curve, drag to define it.  

5- Use shape tool to redefine the shape later. 

Blend Tool 

Blend objects by creating a progression of intermediate objects 

and colors. 

1- Draw to objects in the drawing. 

2- Select the blend tool. 

3- Click at the first object and then drag towards the 

second object. 
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4- A series of blended objects will be created from starting point to ending point. 
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Summary of Module 

  Dot/ Point is the smallest and the most basic element of design. A line is a form with width and length, 

but no depth. A shape is a self-contained defined area of geometric or organic form. 

  Horizontal suggests calmness, Vertical gives a feeling of balance, formality and alertness. Oblique 

give a feeling of movement and action. 

  Size means how big or how small should an element be in the design. Texture gives your design 

piece a specific look and feel. Value means the darkness or the lightness of something. It also refer 

to the color of a design element. 

  You can have balance in your design by adjusting the graphical weight of your design elements in 

terms of color, size, contrast etc. Gradation applies to the incremental change in the state of a design 

element. 

  Contrast simply tells us where to look first. Harmony in visual design means all parts of the visual 

image relate to and complement each other. The principle of dominance occurs where you need to 

emphasize on some design element. 

  Perspective means use of techniques to draw a 3 dimensional scene on 2 dimensional surface. 

  Warm color make you think of sunlight and warmth. Cool colors are calming, relaxing and closer to 

nature. Neutral colors often serve as the backup colors in design. 

  Hues are the family of twelve purest and brightest colors. Tone is created by adding grey to a color. 

Saturation can also be called intensity of a color. Shades are created by adding black to a color. Tints 

are created by adding white to a color. Value refers to the lightness or darkness of a color. 

  Typography is, quite simply, the art and technique of arranging type in your design. While choosing 

a type for your design. you need to keep in mind the readability, size, leading, measure, hierarchy, 

color scheme, grid and font etc. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  Which are the two types of lines? 

Answer: 

1- Solid Continuous line meeting two points. 

2- Dotted or dashed line.  

Both can be drawn using any tools like pen or brush.  

FAQ 2:  What is a geometric shape? 

Answer: 

Geometric shapes or regular shapes are easy to recognize. Math can be used to find 

information about these shapes and these shapes generally have a specific name 

associated with them. 

FAQ 3:  What are positive and negative space? 

Answer: 
Positive spaces are the shapes that the artist places in the design. The space around the 

positive space is called negative space. 

FAQ 4:  What feelings do the direction of lines convey? 

Answer: 
Horizontal lines convey the feeling of relaxation and calmness. Vertical lines give a feeling 

of balance and formality. Oblique lines give a feeling of movement and action. 

FAQ 5:  What are the types of texture? 

Answer: 
There are two types of texture. Tactile texture is a texture that can be felt. Visual texture is 

the illusion of texture printed on paper. 

FAQ 6:  How can we achieve balance in the design? 

Answer: 
Balance can be achieved in design by adjusting the graphical weight of the design elements 

in terms of color, size and contrast. 

FAQ 7:  What are the types of balance? 

Answer: Symmetric Balance and Asymmetric Balance.  

FAQ 8:  How can we achieve asymmetric balance?  

Answer: Asymmetric balance can be achieved by value, by texture and by space. 

FAQ 9:  What is gradation and what happens when we apply gradation by size and direction? 

Answer: 
Gradation means the gradual change. When we apply gradation to the size and direction, it 

gives an illusion of increase in distance. 
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FAQ 10:  Why is variation important in repetition? 

Answer: 

If there is no variation in a design with repetition, our brain will have just one look at the 

design and will understand that rest of the shapes are identical. That will add a monotone 

effect to the design. 

FAQ 11: Where can we apply contrast in design? 

Answer: 
Contrast can be used in color (opposite colors on the color wheel), in value ( dark vs light ), 

in texture (smooth vs rough) or in direction ( horizontal vs vertical ). 

FAQ 12: Define Harmony? 

Answer: 
Harmony in visual design means all parts of the visual image relate to and complement 

each other. 

FAQ 13: What are the types of unity? 

Answer: 

Visual Unity where all the shapes or elements are aligned along the same axis and the 

color and style of elements work together to create a meaning. 

Conceptual Unity where all the images in the design follow the same concept. 

FAQ 14: How to achieve perception in design? 

Answer: 
Perception can be achieved through the use of relative size objects, overlapping objects, 

blurring or sharpening objects. 

FAQ 15: What is the effect of different colors in design? 

Answer: 
Warm color make you think of sunlight and warmth. Cool color. Cool colors are calming, 

relaxing and closer to nature. Neutral colors often serve as the backup colors in design 

FAQ 16: What is typography? 

Answer: Typography is the art and technique of arranging type in your design. 
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Test Yourself! 
 
Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 
 

1.  Which of the following is NOT a design element? 

a.  Line b.  Balance 

c.  Point    d. Shape 

2.  Which of the following is an organic shape? 

a.  Square b.  Triangle 

c.  Tree d.  Circle 

3.  How is the negative space added to the design? 

a.  Artist adds negative space  himself b.  
Positive space automatically creates 
negative space 

c.  Developed by the color around the shape d.  Present inside the positive shape 

4.  Tactile texture is _____________. 

a. The texture that is of bright colors b. The texture that can be seen 

c. The Texture that can be felt d. 
The texture that can be used at many 
places 

5.  ________________ is the illusion of texture printed on paper. 

a. Tactile Texture. b. Natural Texture 

c. Artificial Texture d. Visual Texture 

6.  
In __________________ visual weight of the design element in your design is equally 
divided. 

a. Symmetric Balance b. Asymmetric Balance 

c. Balance by value d. 
Balance by shape 
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7.  Gradation means 

a. Decrease in size of object b. Increase in size of object. 

c. Gradual Increase in distance d.  
Gradual change in the state of objects 
 

8.  Using variations, we can avoid ___________ in repetition. 

a. Distortion  b. Monotone effect 

c. Ambiguity  d.  Balance  

9.  Lack of ___________ is the reason of camouflage. 

a. Repetition b. Balance 

c. Unity d.  Contrast 

10. Conceptual unity means __________________. 

a. 
All the images in design following the 
same concept 

b. 
All the images in design are at the same 
location 

c. All the images have the same color d.  All the images have the same contrast 

11. Unity is important in design to _______________. 

a. Make design Unique b. Change the overall look 

c. Convey a single idea d.  Dominate and element 

12. _____________ are on the horizon line where receding lines converge. 

a. Convergence  b. Atmospheric Perspective 

c. Linear Perspective d.  Vanishing Points 

13 Find the INCORRECT option, Perspective can be achieved through ______________. 

a. Relative Size Objects b. Introducing Vanishing Points 

c. Overlapping Objects  d.  Blurring and Sharpening Objects 
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14. _________________ is created by adding a little black to a color. 

a. Tint   b. Hue 

c. shade  d.  Tone    

15. 
An upward vertical stroke found on lowercase letters that extends above the typeface’s x-
height. 

a. Ascender  b. Descender 

c. Crossbar  d.  Baseline  

16. ________________ means adjusting the space between characters. 

a. Leading  b. Tracking 

c. Measure   d.  Kerning  
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Answer Key 
MCQ Number Correct Answer 

1 b 

2 c 

3 b 

4 c 

5 d 

6 a 

7 d 

8 b 

9 d 

10 a 

11 c 

12 d 

13 b 

14 c 

15 a 

16 d 
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Module 2: Develop Design Concept 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Identify the requirements and needs of target market/ 

audience 

  Identify the unique selling point of product or service 

  Express implement the idea in visual form in the design 

  Design effective brand guidelines  

  Develop color themes based on brand guidelines  

  Use brand guidelines in their design creation  
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Learning Unit 1: Identify Unique Selling Point (USP) of 
Product/ Service 
 

Overview 

In this learning unit, you will learn different concepts involved in understanding the needs of client to identify the 

unique selling point of product. After the completion of this learning unit, you will be able to demonstrate the 

analysis of need of the market and client’s emotional needs to be met. You will be able to understand client’s 

buying decision and design your unique product or service. 

 

1. Extraction of USP 

Unique Selling Point 

When we look around us, very few businesses are found to be unique. For example 

there is a plenty of clothing retailers, hardware stores, air conditioning installers and 

electricians. When your service or product is similar to those around you, you need to 

find out unique factor about your product of service that makes it stand out in 

competition.  

Unique selling point is the key to effective selling. Unless you point out what makes your 

product unique in a world of homogenous products, you cannot target your sales efforts effectively.  

Extraction of USP 

Identifying USP requires a lot of searching and creativity. One way is to start analyzing 

how other companies use their USP for their benefit. You can understand what other 

companies say they sell. In this way you can learn what makes these companies 

different from their competitions.  

USP can be based upon product characteristics, price structure, placement strategy or 

promotional strategy. These are also called the “4 Ps” of Marketing. They are used to 

give your product a market place. For example, Charles Revson, founder of Revlon, 

always used to say he sold hope, not makeup. So they based their USP at product 

characteristics. Some airlines sell friendly, while others sell on-time service. Neiman 

Marcus sells luxury, while Wal-Mart sells bargains referring to price structure 

 
Find Unique Selling Point for your product 

 

Design your unique product

Identify unique aspects of your product

Know what motivates clients purchase behavior

Decide client's emotional need to be met

Analyze the needs of target audience

The factor presented 
by a seller as the 
reason that one 
product or service is 
different from and 
better than that of 
the competition is 
called Unique 
Selling Point. 

USP 
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Sometimes a company focuses on one particular "P," which also drives the strategy in other areas. A classic 

example is Hanes L'Eggs hosiery. At the start when hosiery was sold primarily in department stores, Hanes 

opened a new distribution channel for hosiery sales. That was the idea because hosiery was a consumer staple 

so it should be sold in grocery stores. So placement strategy was their unique selling point. 

 

2. Analyze Needs of Target Market / Audience 

In order to make your product successful, you need to satisfy the needs of your target 

market. For this purpose, step back from your daily operations and carefully inspect 

what your customers really want. Suppose customers purchase your product but you 

should know, is the product only thing they want? What can make your customers to 

come again and again to you? You can improve the quality of product, convenience, 

friendliness, cleanliness, and courtesy or customer service.  

Price is never the only reason people buy. If your competition are ahead of you in 

pricing because they are larger, you have to find another sales feature that addresses 

the customer's needs and then build your sales and promotional efforts around that 

feature.  

 

3. Decide What Emotional Need is Being Specifically Met by your Product or Service 

In order to not get lost in the crowd of competitors, you need to think from client’s 

perspective and decide what emotional need is specifically met by your product. Thinks 

about your offer. What kind of need does it satisfy? Focus on your existing and potential 

customers and think about what they are searching for. 

A need is all about benefits a customer wishes to be in the product or services, it can 

be functional or emotional. The emotional benefit can always be a stronger driver for 

customer because functional benefits can easily be copied by competitors.  

On the other hand, a customer desire is what he wants to be there in the product which 

is not necessary but he wishes it in the product. For example, food is considered as a 

need. However, a dessert is considered as consumer’s desire, as these things are not 

necessary in order to live.  

If you can better assess the emotional need of customer and add it to your product or service it can set you apart 

from competitors. 

 

4. Identify Motivation to your Customer's Behavior and Buying Decisions 

For effective marketing you need to act like a psychologist. You need to know what drives and motivates 

customers. You need to look at their motives for buying your product/services, is it the quality or convenience.   

Cosmetics and liquor companies are great examples of industries that know the value of psychologically oriented 

promotion. People buy these products based on their desires (for pretty women, luxury, glamour and so on), not 

on their needs. 

 

Understanding 

Customer’s needs 

Demand is the 
economic principle 
that describes a 
consumer's desire, 
willingness and 
ability to pay a price 
for a specific good 
or service. 

Remember 
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Factors affecting Clients buying behavior: 

There are four basic factors that affect the customers purchasing behavior:  

1- Cultural Factors 

 

 Cultural factors come from the different cultures or cultural environments 

the consumer belongs to. For a brand, it is important to understand the 

cultural factors fundamental to each market in order to adapt its product 

and its marketing strategy. As these will play a role in understanding the 

habits, behavior or expectations of consumers. 

 The consumer’s buying behavior may also change according to social 

class. 

 A consumer from the lower class will be more focused on price. While a 

person from the upper class will be more attracted to elements such as quality, innovation and 

features, etc. 

 Sometimes customers purchase to follow a new trend in the market or society to be a part of 

innovation. 

 

2- Social Factors 

 

 Family is the most influential factor for an individual which develops an environment where his 

behavior and personality grows. 

 For example if during your childhood, your parents described coke as not good for health, there is a 

little chance that you will develop a habit of drinking coke as adult. So a brand needs to seem as a 

family brand to become consumer’s habit. 

 The social role and status influences the consumer behavior and his purchasing decisions. 

 

3- Personal Factors 

 

 The lifestyle, values, environment, activities, hobbies and consumer habits change throughout his 

life. A consumer does not buy the same products or services at 20 or 70 years.  

 The purchasing power of an individual will have, of course, a great influence on his behavior and 

purchasing decisions based on his income. 

 The lifestyle of a consumer will influence on his behavior and purchasing decisions. 

 

4- Psychological Factors 

 

 To increase sales and encourage consumers to purchase, brands should try to create, make 

conscious or introduce a need in the consumer’s mind so that he develops a purchase motivation. 

 Through the experience the customer had, his learning and his external influences (family, friends, 

etc.), he will develop beliefs that will influence his buying behavior. 

A purchase decision is the result of each and every one of these factors. By identifying and understanding the 

factors that affect their customers, brands have the opportunity to develop a strategy, a marketing message 

(Unique Selling Point) and advertising campaigns more efficient and more in line with the needs and ways of 

thinking of their target consumers. A real asset to better meet the needs of its customers and increase sales. 

 

 

Brands target the 

influence such as 

some celebrity, actor 

or musician to 

spread the use and 

purchase of their 

product in different 

social groups. 

Do you know! 
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5. Identify Unique Aspects of Product 

Differentiating the product or service in a competitive environment develops an element 

in your business that your competitors cannot imitate.  

For this purpose, list the features and benefit that are unique about your product or 

service. There is a difference between feature and benefit. For example having bakery 

in your store is a feature not a benefit but if you see it as having a bakery that can 

deliver sandwiches and other stuff in 2 minutes can definitely be a benefit.    

Identify aspects of your product or service that your competitors cannot imitate. It can 

be the location of your business that is idea to the customers, it can be the quality of product that is matchless or 

it can be the customer service with unique and creative ideas. Whatever it may be, list them. Highlight anything 

that cannot be copied, reproduced or duplicated by your competitor. 

 

6. Create Design About your Unique Product or Service 

Design opens up valuable opportunities for businesses. Its importance is often 

underestimated, but good design can bring some significant business benefits.  

Development of a design for your product can create new product ideas and allow you 

to understand your customer’s needs and preferences. 

A unique design can be a powerful way of retaining customers and positioning your 

business for a move into new markets. 

 

 

Design Process 

The development of design should be managed like any other business process. The key is to co-ordinate those 

people who are involved like designers, managers and employees to have their suggestion about design 

requirements. It will also ensure that your design delivers the outcomes you require at the cost you have 

budgeted. 

Key tips for managing the design process: 

 First of all you should be clear about the goal of the design, such as raising brand awareness or improving 

a product or service offering. 

 Carry out research about market needs and trends both before and during the designing process. Keep 

focused on what your customers want.  

 Set a budget and a timetable with measurable milestones. 

 Create design about your unique product or service that is clear, and concise. Use the ideas from unique 

selling point. Be sure that your design can communicate the exact idea that you want to share with the 

customers. 

 Choose your designer and prepare an outline about the project's aims, budget, schedule and any legal, 

technical or other constraints on developing the design.  

 Make sure that your production, marketing and sales departments are prepared for any new product, 

service or branding you develop. 

A company in the 
same industry or a 
similar industry 
which offers a 
similar product or 
service. 

Competitor 

Design development 
shouldn't only be 
focused on your 
existing customers - 
it can also be used 
to help you target 
new customers and 
move into new 
markets. 

Remember 
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 Monitor the process as it develops - if the project deviates from the brief, investigate and make sure it's 

for a good reason. 

 Remember that your designs will be the unique identification and representation of your USP and 

Product/ Service so it needs to be protected. 

When the process is finished make sure you gather as much feedback as possible from those involved and some 

of your customers so that you know if your design is developed properly. 

 

Measuring the Success of Your Design 

You should set clear targets to measure the success of your design. 

In many instances customer response will be a crucial factor for that purpose. For example, if you design a new 

product or a new website interface, the key point to know its success will be its performance in the market. 

If problems arise, deal with them as quickly as possible. Revise the design brief if important new information or 

priorities emerge – try hard not to develop a design that delivers the wrong message instead of your unique 

selling point. 

 

  



Module 2: Develop Design Concept 

72 |                                                         Teaching and Learning Material: Information Technology (Computer Graphics – Print) 

Learning Unit 2: Define Particular Branding Guidelines 
and Themes 

Overview 

In this learning unit, you will learn about the importance of techniques used to define the branding guidelines. 

After the completion of this unit, you will be able to find out the idea that describes the brands and integrate the 

guidelines into the look and feel of the design. Also, you will be able to demonstrate the development of brand 

guidelines, themes and manual, keeping in mind the elements and principles of design, perspective, typography 

and color theory.  

1. Pick up the Big Idea which Permeates the Brand 

This is the idea that defines your brand and set it apart in the market.  A big idea is the 

powerful, merging force behind marketing efforts of the brand. While picking up big idea 

of your brand, keep these characteristics in mind that should be followed by your brand.  

Transformation 

Can the idea change attitudes, beliefs and behaviors? Open up new ways of thinking? 

Change the course of customers, markets and companies and be a “game changer” 

on a grand scale? If yes, then it’s a big idea and it can affect the market (customers, 

competitors, influencers) through its transformations and also alter your company and 

its people. 

 

Ownability / Uniqueness 

The idea should be tightly bound to your product / Service.  The idea behind ownability 

is unique in the market and only belongs to you. For instance, you can’t own the idea: 

“We have the best people.” Every competitor probably says the same thing. But an idea 

like, “Our aerospace company was founded by the first two human beings to land on 

the moon,” is hard to copy. 

Simplicity 

Big idea should be simple and easy to understand. A lack of simplicity is against human 

nature. Customers always have many options so you can’t take risk to confuse them. 

Idea should be truly creative because truly creative ideas don’t confuse. 

Originality 

Human are hard wired to focus on new, unique and original. We are programed to unconsciously ignore the 

familiar, direct thought to new and unique idea. So your brands big idea should use this universal truth for its 

benefit. 

 

 

 

An attempt to 
communicate a 
brand, product, or 
concept to the 
general public, by 
creating a strong 
message that 
pushes brand 
boundaries and 
resonates with the 
consumers. 

Big Idea 

Big ideas grab you 

to the point where 

you can’t forget. 

Infectious ideas stick 

in our 

consciousness and 

never leave. 

Do you know! 
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Likeability  

In advertising communication, the factor of likeability contributes to the effectiveness 

more than any other factor.  

 Look at the following examples: 

 With Land Rover you can get off the beaten track anywhere in the world. 

 Where families share the magic 

For Land Rover, “off the beaten track” carries the double meaning of,   Land Rover’s world renowned off-road 

capabilities as well as, the mindset of so many of its loyal drivers…who love nothing more than the escape only 

Land Rover can give them. 

And for Disney, No entertainment brand in the world better satisfy parent’s and kid’s desire to share the magic 

of fantasy and reality with each other. 

 

2. Live the Brand; Design the Guidelines 

Live the Brand 

A lot of planning and management is required in marketing a new brand. The first step 

a new brand should take when developing their marketing strategy is making sure that 

they have a strong understanding of their target customer. If you are not aware or the 

target, there are a great chanches that your message will not be conveyed to the actual 

customers. 

Your brand not necessarily what you want it to be but, it is all about what the customers 

experience. And what consumers think of your brand may be very different from the 

message you're putting out there. Simply, your brand isn't the work you do, but it is how 

you do it. 

The design of your office, reception area says something about your brand, similarly your voicemail 

announcement and the way you answer the phone. The way you and your employees dress makes a brand 

statement; the music you play and sometimes even scent can contribute to branding. 

Your brand succeeds when your work matches the promises you make with the customers. 

 

Why to Design Guidelines 

Guidelines are necessary because 

 In the form of guidelines, you will have an easy guide to refer to when handing over the project. 

 Makes you look professional. It shows that you did everything for a reason. 

 You maintain control of the design. When someone does something awful, you can refer them to the 

document. 

 Forces you to define your style, making for a more solid design. 

 

 

 

Land Rover is a 

brand of the British 

car manufacturer 

Jaguar Land Rover 

Do you know! 

When you launch a 

brand, you are 

introducing an 

image, presenting a 

value proposition 

and communicating 

how your products 

are different. 

Do you know! 
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Designing the Guidelines for the brand 
 
Brand Guidelines also called brand standards, style guide or brand book are a set of rules that explain how your 
brand works. These guidelines typically include: 

 An overview of your brand’s history, vision, personality and key values. 

 Brand message or mission statement it will also include examples of ‘tone of 

voice’. 

 Logo usage – where and how to use your logo including minimum sizes, spacing 

and what not to do with it. 

 Colour palette – showing your primary and secondary colour palettes with colour 

breakdowns for print, screen and web. These colors will describe the look and feel of 

your brand. 

 Type style – showing the specific font that you use and details of the font family and default fonts for web 

use. 

 Image style/photography – examples of image style and photographs that work with the brand. 

 Business card and letterhead design – examples of how the logo and font are used for standard company 

literature. 

If you are just starting out and need only a few key elements, then focusing on the above area is enough. But to 

make sure that all the areas are covered, you need to develop detailed brand guidelines that will include: 

 Design layouts and grids 

 Social media profile page applications 

 Brochure/flyer layout options 

 Website layout 

 Signage specifications 

 Advertising treatments 

 Merchandising applications 

 Copywriting style  

 Editorial guidelines 

Brand guidelines should be quite flexible for designers to be creative, but rigid enough to keep your brand easily 

recognizable.  

3. Create Brand Guidelines, Brand Manual and Themes According to Design 
Principles and Color Theory 

Guidelines should be designed keeping all the design element, design principles in mind. Brand Guidelines and 

Manuals should include following details 

Strategic Brand Overview 

This should be short and sweet. In as few words as possible, make the vision clear for this design and if there 

are any keywords, people should keep in mind while designing. Most people will probably move straight to the 

picture pages, but they may read a few sentences here. 

A logo identifies a 
business in its 
simplest form via the 
use of a mark or 
icon. 

Logo 
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In the above picture the photography used, balanced backgroud image, readability of text, color contrast is 

perfect. Text is short and to the point. 

Logos 

For print and Web, most brands revolve around the logo. Make sure you provide logo variations and clarify 

minimum sizes. 

Logo Design and Variation of Logo Sizes 
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The variations of logo sizes should be provided as in the above example because logo could be used at many 

places. 

Correct Usage of Logos  

Correct variations of the logos in different colors should also be provided so that it can 

avoid recreation of logos as in the below example 

       

Variation of Logo Colors 

Spacing 

Many non-designers underestimate the need for white space. Include a spacing detail, especially for the logo. 

Rather than specifying inches or centimeters, use a portion of the logo (a letter or a shape) to explain the spacing 

in the logo. As in the blackberry logo, there is always a clean little space around the logo so they measure it with 

letter “B” from the logo.  

 

Spacing in BlackBerry Logo 

Typography 

You’ll need to define the typefaces to use: sizes, line height, spacing before and after, colors, headline versus body 

font, etc.  While choosing the type face, keep in mind the readability, elegance of text and contrast. 

Variations of logos 

are used at different 

places like black and 

white documents, 

social media, 

packaging, attire etc.  

Do you know! 
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Typography Information  

Typography details in Cunard Brand Guidelines 

 

Color 

Always include color palettes and what the colors should be used for. And include 

formats for both print and Web: CMYK, Pantones (if they exist) and RGB (or HEX).  

For printing 
purposes, always 
provide CMYK and 
RGB replacement of 
pantone colors so 
that if they can’t find 
pantone, they can 
go ahead with 
CMYK or RGB  

Remember 
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Colors in Kerr Recruitment Logo 

Colors should be selected according to overall design theme. The warm colors should be used to attract attention. 

Cool colors to give an effect of calmness, neutral colors as backgrounds. Meaning of different color should be 

considered for example greys and black for professional subject websites, greens, blues for nature and white for 

health etc. 

 

Icons 

Defining size and spacing and where to use icons is another great way to promote consistency. Icon set should 

also work with the theme of Brand.  

 

Icon set in Skype Brand Guideline  

Beside the elements 

defined in 

guidelines, there are 

certain concept 

which are also 

related to brand like, 

tone of voice, music 

associated, smell 

and texture if any.  

Do you know! 
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Learning Unit 3: Visualize the Layout of the Concept 
Following Brand Guidelines 

Overview 

In this learning unit, you will learn about techniques and concepts involved in visualizing the layout of the big idea 

of your brand designed according to the guidelines. After the completion of this learning unit, you will be able to 

understand and demonstrate the designing and organization of the canvas following the brand guidelines and 

the concepts of graphic designing.  

 

1. Develop Thumbnails of Objects and Design 

The first visual forms of an idea are thumbnails which are small sketches or simple 

drawings. When you develop fresh ideas in your mind about the design then it is 

important that you draw them quickly so that you can record those idea before 

forgetting.  

 

 
Thumbnail examples of BioTrekker logo 

Once you draw an image, you will be able to evaluate your design more efficiently. It is not necessary to draw 

each of all of a thumbnail. You can just draw a few samples of the repeated pattern to get the idea. These 

Thumbnail sketches 
(called thumbnails) 
are one of the most 
powerful tools 
available to an artist. 
This is where the 
image is invented. 

Thumbnails  
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thumbnails are not meant to be the final product they only communicate their meaning 

with the designer. Draw as many ideas as you can keeping your project in mind to get 

variations of design. 

Initially a series of thumbnails will be drawn with a lot of unrelated ideas. As you get in 

the process, the sketches will start to center around one or two major ideas. Ideas will 

develop in your mind about the design of different aspects and areas of brand 

designing.  

Evaluate your sketches relative to your concept. Do as much planning as possible using thumbnails. Change the 

concept if it does not match the assignment. 

Decide the sketch that you are most likely to develop. Select the sketch based on the reasons that it fully 

expresses the main idea of your project. It is able to represent your brand with full strength. Put a rectangle 

around it. That will be used as your design book page. It will give you an idea how large should your image be. 

You can experiment with how the image will fit on the design in the thumbnail stage. 

This is the best place to experiment with value, color, perspective, typeface, balance, design elements and design 

principles relationships. It is much faster to color and make changes in a thumbnail than a full size drawing. 

Choose colors for contrast and impact.  

 

2. Design the Page or Canvas Layout Based on Brand Guidelines 

Whether you’re designing a page for print, or a website, there are some common principles you should follow. 

Page layout typically involves a lot of placement, rearranging and formatting of elements. Many designers carry 

out this process naturally, resulting into a desired product. While this can lead to some excellent product, there 

is a risk that it can result in a lack of visual balance on the page.  

A good page composition should be pleasing to the eyes and also communicate key messages clearly to the 

intended audience. 

These approaches will help you to create a balanced layout. 

Use a Grid 

One of the easiest ways to ensure your page or canvas layout is balanced, is to use a 

grid system. Grids used to be preserved for printed pages only, but now idea of using 

grid is also popular in the digital medium.  

By using a grid to define the position of different elements on a page, you'll create a 

connection between the different elements that make up your page. This can help 

provide a sense of order to your layout, providing the reader with a clear structural reference to look at. This is 

important because when all your page elements have a feeling of connectivity with each other, the overall effect 

feels more comfortable to the reader, helping to put them at ease, and facilitating their access to the important 

stuff that is the content. 

When you have 
developed some 
sketches you will 
develop a style that 
works for you. 

Remember 

Using Grids is one 
of the most common 
practices to develop 
a balanced design. 

Remember 
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Choose a Single Focal Point 

One of the most effective ways to provide a sense of balance is to choose a single focal point for your layout. A 

good example of this in practice is the use of a large image as the biggest single element on a page. That can 

be the logo of your brand just like how it is defined in the guidelines. 

A strong visual can provide a powerful way to lead the reader into your page, acts as a structural element around 

which you can arrange the remaining content in your layout. If you have multiple visual elements, you will have 

to group them together, aligning them in the same way. 

 
Use of Focal Point in Design 

Use of Grid in Designing Page Layout 
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Another great idea is to use a main heading or quote at the page. This heading will draw the attention of the 

audience in the same way as does the image. It can also provide a structure to the layout of your page. 

Use the Rule of Thirds 

One of the best ways to provide a sense of balance is to use the Rule of Thirds or Golden Ratio. According to 

the rule of thirds, if you divide your page into three, both vertically and horizontally, the points at which the grid 

lines intersect provide the natural focal points. By aligning your design elements to these four points, you'll 

achieve a more pleasing composition than aligning your elements centrally. 

 
 

Use of a Rule of Thirds 

A common approach is to place the most important elements of your page in the upper third of the page. 

Use white Space 

It is not the right approach to fill in the every single space on the page. Sometimes it is 

more appealing to leave some space around the elements instead of stuffing them 

together tightly.  If too much space is 
used in the layout, it 
can cause a 
disconnection 
between objects. 

Remember 
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Use of Space 

The most common way to make use of white space is by enlarging the page margins and gutters. On the web, 

simply providing plenty of space around elements can help make the layout feel composed and balanced. Using 

negative space works best when you have a clear structure that keeps content together (such as that provided 

by a grid).  

Repeat Design Elements 

 
Repetition of Design Elements 

 

Repetition can provide a strong sense of connected design and balance to a layout. 

The idea is that by identifying and re-using a design element throughout your layout, 

you can provide a reference for the reader so that different areas feel connected and 

part of the same overall composition. 

Repetition can also 
provide a focal point 
in your design. 

Remember 
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Use of Hierarchy 

 
Hierarchy in the Design 

It is also a good approach to make correct use of hierarchy of elements. Heading text should be more visually 

important then the paragraph text. Focus on the most important element in the page and structure your document 

accordingly. 

Use Scale, Contrast and Harmony 

 
Repetition in Design 
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Finally, the use of scale can be a very effective method for achieving a good visual 

balance in your layout. By making some elements larger than others, a sense of order 

and hierarchy will develop. This helps create a comfortable layout because the viewer 

will automatically look at the larger elements within the layout first, progressing to the 

smaller elements as they read.  

Increased contrast to isolate an element in the design makes it more prominent. This 

acts as a way into the design and supports the structure of the design. 

Use the principles of harmony to make the others feel connected and accentuate the 

focal point. 

 

3. Identify the Composition of Elements following the other Concepts 

The primary objective of a design, whether it's for a printed brochure or the latest web app, is to communicate 

information clearly and effectively to the reader.  

Once you have developed the layout of the canvas or design, the next and the most important step is to check if 

it satisfies the needs of the project as we learned earlier. 

Below is the check list of requirements that a layout must full fill: 

1- The design layout should define your Unique Selling Point efficiently through colors, typeface, theme, 

graphics and text. It should cover the complete idea so that your USP can be better comprehend by the 

customers.  

2- Accurate identification of the client’s needs and requirements is also important for the design. It should 

represent the emotional needs of the target audience. For example in the case of cosmetics brand, it 

should capture the psychology of customers for a wish of being pretty or to follow a latest trend in the 

market. 

3- The layout should be effective enough that it can change the purchase behavior of the customer and 

motivate them to come towards your brand. 

4- It should outline all of aspects of your product or service which are unique and can’t be imitated by the 

competitors. The expression of the design should be unique instead of inspired design from some other 

brand. 

5- Accurate description of the appearance of the final layout should be available in the Guidelines developed 

for the brand. 

6- The colors used in the design layout should be according to the guidelines of brand. 

7- Typography, line height, typeface, font size used should also be according to the defined guidelines. 

8- The final layout should be balanced, properly aligned, readable, united, perfectly contrasted, with proper 

harmony, appealing, with clear perspective so that I can lead the audience to the focal point. 

 

4. Collection, Organization and Application of Material in the Layout 

Page layout is the part of graphic design that deals in the arrangement of visual elements on a page. It generally 

involves organizational principles of composition to achieve specific communication objectives. 

The material/information needed to develop a layout includes:  

Both scale and 

contrast work best 

when they apply to 

one element, 

making it stand out 

from the other parts 

of your layout. 

Do you know! 
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Size of the Design Layout 

You should be clear about the size of the layout needed. It depends on the size of idea 

you want to deliver and media where the design layout will be used in future. After 

confirmation of size, organize all the design element into that size area balanced. Size 

specification will also include margins and gutter measurements. 

Typeface 

Typeface used in the layout is of great important. You need to select a typeface that is 

readable, appealing and fits to your subject at the same time. A large number of extra 

ordinary fonts are available to be used free for example Squares Font, Taurus Mono 

Font, Primiterus Font, Garnata Font etc. you can use any of them. Other than these 

fonts, there are a large number of paid fonts available. You can purchase a typeface which is best suited to your 

design. Typography should be used correctly with proper font, font size, font style, line height, balance and 

location. 

Display Type 

Display type is the type that conveys the main message of the layout. It is intended to draw attention. Newspaper 

and magazine headlines are typical examples of display type. The display line is key to the success of a message. 

If the display type creates interest, the reader will proceed to the body. It can be a heading outlining the USP or 

an image like logo representing the identity of Brand and USP. Display type should be collected from guidelines 

of Brand and used at the focal point of layout. 

Illustrations 

The illustrations in a layout include the decorations, photographs, and artwork, such as line art. Illustrations are 

common in most printed materials. Small icon to be used and buttons are taken from the guidelines. The 

photographs to be used should be properly contrasted, original and well cropped. All the illustrations should be 

well suited to the topic and used at balanced locations in the layout. 

Colors 

Colors are one of the most influential elements of layout. Colors to be used should be according to the subject 

represented in the layout and guidelines. Colors chosen should be easily available for printing.  

If each layout 

applies valid 

principles of design, 

it might be 

impossible to say 

one is better than 

another. Layouts 

may be judged 

differently by 

different people. 

Do you know! 
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Intended Meanings of Colors 

The objective describes what the information on the printed page is intended to do. Knowing the purpose helps 

the layout artist determine which text, colors and illustrations will be best for the job. 
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Summary of Module 

  
Unique Selling Point is the key to effective selling. Unless you point out what makes your product 
unique in a world of homogenous products, you cannot target your sales efforts effectively. 

  
In order to make your product successful, you need to satisfy the needs of your target market. So 
you need to inspect carefully what your customers really want. 

  
If you can better assess the emotional need of customer and add that to your product or service it 
can set you apart from competitors. 

  
A purchase decision of a customer is the result of cultural factors, social factors, personal factors and 
psychological factors. 

  
Identify aspects of your product or service that your competitors cannot imitate. It can be the quality 
of product that is matchless or it can be the customer service with unique and creative ideas. 

  
Big idea is the idea that defines your brand and set it apart in the market.  A big idea is the powerful, 
merging force behind a brand’s marketing efforts. 

  

Your brand not necessarily what you want it to be but, it all about what the customers experience. 
And what consumers think of your brand may be very different from the message you're putting out 
there. Simply, your brand isn't the work you do, but it is how you do it. 

  

Brand Guidelines also called brand standards, style guide or brand book are a set of rules that explain 
how your brand works. They incude breif overview of brand, logos, variation of logos, spacing details, 
typeface and color details for brand, icon sets etc. 

  

The first visual forms of an idea are thumbnails which are small sketches or simple drawings. When 
you develop fresh ideas in your mind about the design then it is important that you draw them quickly 
so that you can record those idea before forgetting. 

  
After developing the layout check if it meets the requirements and is according to the guidelines 
defined for the brand. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is Unique Selling Point? 

Answer 
The factor presented by a seller as the reason that one product or service is different from and 
better than that of the competition is called Unique Selling Point. 

FAQ 2:  Why is unique selling point important for a brand? 

Answer 
Unique selling point is the key to effective selling. Unless you point out what makes your product 
unique in a world of homogenous products, you cannot target your sales efforts effectively. 

FAQ 3:  What factor motivate the customers to purchase? 

Answer 
A purchase decision of a customer is the result of cultural factors, social factors, personal factors 
and psychological factors. 

FAQ 4:  What is the difference between feature and benefit? 

Answer Feature is what your brand does. Benefit is how your brand does its job better than others. 

FAQ 5:  How to measure the success of your design? 

Answer 
In many instances customer response will be a crucial factor for that purpose. For example, if 
you design a new product or a new website interface, the key point to know its success will be 
its performance in the market 

FAQ 6:  What is a big idea for an organization? 

Answer 
A captivating expression of the needs & wants a brand best satisfies and that simultaneously 
conveys the brand’s ultimate purpose or commitment. 

FAQ 7:  What is Brand Guidelines? 

Answer 
Brand Guidelines also called brand standards, style guide or brand book are a set of rules that 
explain how your brand works. It includes overview of brand, color details, typography details, 
logo usage etc. 

FAQ 8:  What is thumbnail? 

Answer 
Thumbnail sketches (called thumbnails) are one of the most powerful tools available to an artist. 
This is where the image is invented. 

FAQ 9:  What is the purpose of using Grid in the layout? 

Answer 
By using a grid to define the position of different elements on a page, you'll create a connection 
between the different elements that make up your page. 

FAQ 10:  What does too much use of space do in the layout? 

Answer If too much space is used in the layout, it can cause a disconnection between objects. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  Four Ps of Marketing are______________. 

a.  
Product characteristics, Price structure, 
Placement strategy and Promotional 
strategy 

b.  
Product characteristics, Policy structure, 
Placement strategy and Promotional strategy 

c.  
Product characteristics, Price structure, 
Presentation strategy and Promotional 
strategy 

d. 
Product characteristics, Price structure, 
Placement strategy and Performance 

2.  A customer’s desire is ____________________. 

a.  That’s necessary for the product b.  Related to the product 

c.  
What he wishes to be in product but not 
necessary 

d.  Both a and b 

3.  Lifestyle that affects the customer’s behavior belongs to __________ Factor. 

a.  Psychological  b.  Personal 

c.  Social  d.  Cultural 

4.  Feature and Benefit of a product is ________________. 

a. Same b. Compulsory 

c. Different d.  Optional 

5.  Transformation characteristic of an idea mean that ______________. 

a. Idea can be easily replaced b. New changes can easily be made in the idea 

c. Idea can easily be spread d.  Idea can change attitudes and behaviors 

6.  Choose INCORRECT option, Guidelines are necessary because ______________________. 

a. 
It is an easy guide to refer to when 
handing over the project 

b. 
When something awful happens, you can refer 
them to the guidelines 

c. 
Contains documentation of products in a 
business 

d.  Helps to make the design more solid 
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7.  A logo is __________________ of a Brand. 

a. Identity b. Structure 

c. Need d.  
Backbone 
 

8.  A thumbnail of an object is _____________. 

a. Final design b. Layout of design 

c. Design Prototype d.  
Rough sketch of ideas 
 

9.  Rule of thirds is ____________________. 

a. 
Divide the page into halves and use the 
intersection as focal point 

b. 
Draw two diagonal lines and use the intersection 
as focal point 

c. 
Divide the page in three and use the 
middle section as focal point 

d.  
Divide the page into three both vertically and 
horizontally use the intersection of line as focal 
point 

10.  Choose the INCORRECT option, A design layout should _______________. 

a. Properly printed b. Represent USP 

c. Meet customer needs d.  Balanced 

 

  



Module 2: Develop Design Concept 

92 |                                                         Teaching and Learning Material: Information Technology (Computer Graphics – Print) 

Answer Key 
MCQ Number Correct Answer 

1 a 

2 c 

3 b 

4 c 

5 d 

6 c 

7 a 

8 d 

9 d 

10 a 
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Module 3: Analyze Cost Effective Solution 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Select the suitable document size in terms of medium of 

publication. 

  Select appropriate printing process and orientation of 

document size. 

  Propose cost effective printing process and get familiar 

with local and international names of paper sizes and 

printing machines. 

  Identify the cost efficient solution based on number of 

pages and number of colors. 

  Differentiate between various types of printing material and 

their weight 

  Identify suitable printing textures. 
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Learning Unit 1: Determine Suitable Size of the Document 

Overview 

In this learning unit, you will learn the concepts about papers used for printing. After completion of this learning 

unit, you will learn to select suitable paper size for printing, process for printing, orientation of paper size. You 

can propose a cost effective printing process and know the international names of paper sizes and printing 

machines. 

 

1. Paper Sizes Available for Printing 

In print advertising companies we have to deal with different types and sizes of papers 

for example, newspapers, magazines, advertising and sales material etc. if you want 

to have desired results, you need to do some research on different sizes of papers 

available for printing and deliver a file to the printer that is ready to print.  

If you don’t use the exact paper size then printer need to resize the document to fit, and 

if it is not proportionate it will be either stretched or squished to fit. That will result in 

bigger charge for the client in the end, and poor quality in most cases. There are several 

projects that different sizes can be used for.  

Below are a few basic paper sizes: 

Letter Size - 8.5”x11”:  

This is the most common size used in most commercial communication aids such as fax machines and copy 

machines, as well as being the standard print size for home inkjet printers. 

Legal Size – 8.5”x14”:  

This size is offered on almost every printer, most likely any printer that is built to handle 8.5”x11” paper can handle 

this size because the width is the same. This size is used for larger flyers, brochures and works well with Microsoft 

Excel projects. 

Tabloid Size - 11”x17”:  

Some home printers can handle this size, but you will find these printers are much larger than other at home ink 

jet printers. This size is great for flyers, brochures, signs and 4 pages flyers as well. When you fold the 11”x17” 

paper in half it will create 4 8.5”x11” panels which is great for announcements, programs and small booklets.  

Letter Half Size – 5.5”x8.5”: 

This size is the standard letter size (8.5”x11”) cut in half. This is a common size for direct mail pieces and inserts 

for magazines and booklets. There are several sizes for direct mail pieces, so you will need to check with your 

printer to find out the sizes that they offer.  

A4 – 8.27”x11.69”: 

This paper size is most commonly used to create magazines catalogues, letters and forms etc. 

Paper sizes always 
bring confusion and 
exact 
measurements 
make a difference, 
even half of an inch 
does matter a lot. 

Do you know! 
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A3 – 11.69”x16.53”: 

It is most commonly used for printing drawings, diagrams and large tables. It is also used to print two A4 

documents on same spreadsheet.  

The paper sizes of A4-A1 in mm is as 

 A1     594mm X 841mm 

 A2     420mm X 594mm 

 A3     297mm X 420mm 

 A4     210mm X 297mm 

Compact Disc – 4.72”x4.75”: 

This size is specific for CD covers and inserts. 

Postcards: 

 Standard: 5.47”x4.21” 

 Oversized: 8.5”x5.47” 

Business Cards: 

 No Bleed Horizontal: 3.43” x 1.93” 

 No Bleed Vertical: 1.93”x3.43” 

 Bleed Horizontal: 3.54” x 2.05” 

 Bleed Vertical: 2.05” x 3.54” 

Banners: 

There are several standard banners size. That can be customized according to the client’s need. 

 

2. Procedures of Creating Custom Paper Sizes in Graphic Software 

For scrapbook 12x12 sheets, panorama printing, and other special projects, you need 

to define a custom paper size in printer properties. 

Creating custom paper size in Adobe Photoshop 

1- Open your image in Adobe Photoshop. 

2- Click at file->Print. 

3- Select the printer from the dropdown menu and click at print settings 

 

Panorama printing 
represents any wide 
angle painting, 
drawing, 
photography and 3-
D models.  

Panorama  
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4- Click at paper size drop down menu.  

 

5- Under "Paper Size" choose "Manage Custom Sizes". 

 

The paper size 
which is not already 
defined in the 
software. 

Custom Paper Size 
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6- Set page height, width and margins. 

 

 

7- Click Ok. 

Creating custom paper size in Corel Draw: 

1- Open your file in Corel Draw.  

2- Click at Layout->Page Setup 
After you create a 
custom paper size, it 
will be saved in the 
graphic software for 
future use. 

Remember 
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3- Choose size from options list, enter the height and width of the page. We can also set page orientation 

here to Portrait or Landscape 

 
 

4- Click Ok to save your settings. 

 

3. Page Orientation 

The two most common types of orientation are portrait and landscape. All software 

allow the page orientation to be selected.  

Select an orientation according to your requirement and design of your page. Following 

are the procedures to change orientation.  

 

Changing page orientation in Adobe Illustration 

Page orientation can be changed either at the time of creating a new document or later on. 

1. When creating a new document, change the orientation by clicking the portrait or landscape icon. 

Page orientation is 
the way in which a 
rectangular page is 
oriented for normal 
viewing. 

Page Orientation 
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To change the orientation of an existing document, 

1- Click the Art board tool on the left side.  

 

2- Page orientation icons will appear at the top. Click the mode that is required.  

 

3- To change the orientation of the objects for printing purposes, go to File -> Print. 

4- When the Print window pops up, make sure that you are in the general section. 

 

5- Check the Auto-Rotate option, and choose the orientation from the set. Available options are as 

follows: Portrait Up, Portrait Down, Landscape Left, and Landscape Right. 

It is better to choose 
a page orientation at 
the start of new 
document and 
composed the 
document in that 
orientation. 

Remember 
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6- After configuration, click Print or Done at the bottom. 

 

 

Selecting Page Orientation in Adobe InDesign: 

1. When creating a new document, you can change the orientation by clicking the portrait or landscape 

icon. 

 

To change page orientation while printing 

1- Click at File->Print. 

2- Select setup from options in the print dialogue box. 

 

3- Choose the orientation from the section and click print button. 
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4. Offset Printing Process 

Offset printing is the most widely used printing technique for a wide range of products 

such as books, newspapers, post cards, envelops, stationery and posters etc.  

In offset printing, a printing plate, which is mostly made from aluminum, contains an 

image of the content that needs to be printed. When the plate is inked, only this image 

part holds ink. That inked image is then transferred (or offset) from the plate to a rubber 

blanket and then to the printing surface. There are two types of offset printing machines. 

1- Sheet-Fed offset printing  

In this printing machine the printing is carried out on a single sheet of paper. As they 

are fed to the press one at a time.  

2- Web-Fed offset printing 

The process can be used to print on paper, cardboard, plastic or other materials but these have to have a 

flat surface. 

 

A Four Color Sheet-Fed Printing Press 

Above is a picture of a four color sheet-fed printing press.  

 At the far end is the intake where individual sheets of paper are automatically fed into the press.  

 The 4 towers or printing units each print one color, typically black get printed first, followed by cyan, 

magenta and yellow.  

 The stack of printed sheets is visible on the front of the machine, underneath is the press console & 

monitor which controls the press.  

The picture below shows such a larger web press. It is so fast that the printed paper 

needs to be force dried. The black unit at the end of the press is an oven. Offset printing 

this process is considered the most cost-effective that is why many in the industry prefer 

this process. This also allows publishers to print. High quantity of prints in faster time 

because the printing machine is very quick and easy top set up as long as plates are 

already available. 

Offset printing is a 
commonly used 
printing technique in 
which the inked 
image is transferred 
(or “offset”) from a 
plate to a rubber 
blanket, then to the 
printing surface. 

Offset Printing 

For higher volume 
work offset presses 
use rolls of paper. 

Remember 
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A Larger and Faster Web Press 

Roland  

Ronald range of offset presses includes single edge, single width printing machines. The basic unit of web offset 

printing press consists of a body of high grade, stress-relieved cast iron which is machined on sophisticated 

Computer Numerical Control (CNC) machines to ensure interchangeability.  

 
 

Ronald Offset Printing Machine 

Rota 

The Rota consists of a rotary table with automatic pad printing machines for a more-color print up to maximum 6 

colors. 

The output is from 800 up to 1200 cycles per hour. 

 From 8 up to 16 positions according to the model 

One of the major 
drawbacks of this 
printing process is 
the plate. Once a 
layout is already 
made into a plate, it 
cannot be easily 
changed. 

Remember 
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 Ink cup diameter: 90 mm up to 220 mm 

 Depending on the model it is possible to mount 1 up to max. 6 pad printing machines 

 The number of pad printing machines on the rotary table determines the number of colors without output 

decrease 

 All jigs are quickly changeable on the rotary table and easily accessible 

 The patented ink cartridge allows easy and fast changing of printing plate and ink on all pad printing 

machines 

 The pad is quickly changeable on each pad printing machine. We provide a magnetic fastening with 

accurate positioning by means of dowel pins. 

 

 
Rota Offset Printing Machine 

 

Solna Offset Printing Machine:  

Solna offers a wide variety of single-width web presses-in both horizontal and vertical formats. Historically, web 

printers were either horizontal or vertical, but Solna offers both types of presses to match the production needs. 

It is commonly used for newspaper and commercial printing.  

 
Solna Vertical Press   Solna Horizontal Press 
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Heidelberg  

With the Speedmaster machines, Heidelberg offers the most comprehensive product series within the sheet-fed 

segment. The performance of all the SpeedMaster models of heidelberg is very high. Both small and large format 

machines Speedmaster machines deliver very good productivity. They provide a performance solution which is 

flexible, cost-effective and innovative. 

 

Heidelberg Sheet-fed Press 

 

5. Digital Printing Process 

Modern printing methods such as laser and ink-jet printing are known as digital printing. 

In digital printing, an image is sent directly to the printer in the form of digital files such 

as PDFs and other files from graphics software such as Illustrator and InDesign. This 

eliminates the need for a printing plate, which is used in offset printing that saves money 

and time. 

Setup  

The setup for digital printing is very easy 

 Install the printer driver in the computer. 

 Prepare the design in the graphics software. 

 Insert paper sheet to be printed on. 

 Send the design to the printer directly 

 Print it out… 

PROS 

 Incredibly fast! If you are working within a tight deadline and just have to get it done, digital printing could 

be your best option. 

 Less Expensive. If you have a low quantity (less than 1000 pieces), digital printing is far more cost 

effective than traditional offset printing. 

 Greater Flexibility. Allows for frequent changes to your printed material if needed. 

 The Printer Proof helps you to get the output just as you want. 

CONS 

 Unable to Color Match. Despite digital printing constantly improving, they still can’t match the color quality 

of traditional offset printer. Digital printers use a four color process while traditional offset printers use the 

PMS and inks to deliver color accuracy. 

We don’t need 
plates for digital 
printing, so faster 
printing is possible 
with the help of 
laser/inkjet printers. 

Remember 
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 Cracking in the Folds. Digital printer inks are not fully absorbed into the paper which means that cracks 

can appear in the color along the edges when the piece is folded. This typically isn’t a problem in 

traditional offset printing. 

 Fewer Material Options. Digital printing presses don’t have a wide range of choices for the materials to 

print on. Traditional offset presses still offer a wider range of paper, ink and finish options. 

 More expensive in higher quantity print runs. While you may need a project fast, if you have a higher 

quantity (more than 2500 pieces), traditional offset pricing normally becomes more cost effective. 

 

6. Screen Printing Processes 

Screen printing is a printing technique where a mesh is used to transfer ink on a 

substrate, except in areas made waterproof to the ink by a blocking stencil. A blade is 

moved across the screen to fill the open mesh openings with ink, and in reverse stroke 

the screen touches the substrate for some time along a line of contact. This causes the 

ink to wet the substrate and be pulled out of the mesh openings as the screen springs 

back after the blade has passed. 

 

 
 

Screen Printing Press 

It is also known as screen, silk-screen, serigraphy, and serigraph printing. One color is printed at a time, so 

several screens can be used to produce a multicolored image or design. 

 

Setup  

The print station is the point at which the printer will stand. This is where the printer will operate the press. 

The shirts are loaded onto the pallets here and then after all the colors have been printed, the shirts are unloaded 

and put onto the belt dryer from this position. 

Screen Printing is 
the process of using 
a mesh-based 
stencil to apply ink 
onto a substrate, 
whether it be T-
shirts, posters, 
stickers, vinyl, wood, 
or other material. 

Screen Printing 
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Pros: 

 Perfect for larger designs consisting of one or two colors. 

 Ideal for printing on to cotton and poly cotton clothing items. 

 The ink is heat dried, therefore the garments can sustain the roughness of machine washing. 

 

Cons: 

 Each color is applied separately, making the cost higher per additional color. 

 Separate screens are required for each individual design. So, for each additional color, a new screen will 

need to be used. 

 Not the best option if your design consists of several colors. 

 Coated fabrics cannot be screen printed. 

 Longer processing time if many colors are used. 

 Time consuming to set up and clean. 
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Learning Unit 2: Determine the Number of Pages and 
Colors for Printing 

Overview 

In this learning unit, you will learn about color modes like RGB, CMYK, and lab etc. After completion of this 

learning unit, you will be able to know the difference between spot printing and offset printing and identify the 

cost efficient solution based on number of pages and number of colors 

 

1. Selection of Appropriate Color Mode 

When you are working with your design there are several color models to select, but three of them are more 

important than others. They are RGB, CYMK and LAB.  

RGB 

RGB stands for Red Green and Blue. RGB is a convenient color model for computer 

graphics because the human visual system works in a way that is similar to an RGB 

color space. This model represents how the computer sees colors. As we know that 

each pixel in our screen can be 'switched on' like a little 'light-bulb' by means of a 'light-

ray' produced by an electronic gun inside the monitor.  

 

 
 

RGB Color Modes 

 

This ray can be a shade of Red, a shade of Green or a shade of Blue. For this reason the pixel shot by the ray 

can assume a shade of red, a shade of green or a shade of blue. According to the RGB model, each shade of 

each of the 3 colors (Red, Green and Blue) is represented by a number ranging from 0 to 255. For example, the 

black color is represented by the '0 0 0' RGB value (R=0, G=0 and B=0) while the white color is represented by 

the '255 255 255' RGB value (R=255 G=255 and B=255).  

RGB model can represent more than 16 million of colors. RGB is an additive model, because Red Green and 

Blue are additive colors. RGB color mode can be used in Digital Presses, color copiers, computer displays. 

When red green and 
blue are combined, 
they create white. 
Red + Green + Blue 
= White. 

Do you know! 
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CMYK  

CMYK stands for Cyan Yellow Magenta and blacK. This model is used for printing. 

These are the 4 colored inks used inside of color printers. CMYK is a subtractive model. 

In theory, Cyan, yellow and magenta should combine among themselves to absorb all 

colors. Another reason is that colored inks are more expensive than black ink. Besides, 

3 inks means 3 ink layers during printing. And 3 ink layers cause the printed paper to 

become quite wet, so the paper will dry more slowly and the press can be slower.  

 

CMYK Color Mode 

In other words more expensive. Poor quality paper such as newsprint may break if it becomes too wet. 

Text is typically printed in black and includes fine detail (such as serifs), so to reproduce text using three inks 

without slight blurring would require impractically accurate registration. This use of the letter K to represent black 

also helps to avoid confusion with the letter B as used in the acronym RGB for black. CMYK is normally used for 

Offset litho printing.  

 

LAB 

In LAB, L stands for Luminance (or lightness) and A and B. According to this model A 

ranges from green to red, and B ranges from blue to yellow. This model was designed 

to be device independent. In other words by using this model you can handle colors 

regardless of specific devices (such as monitors, printers, or computers).  

Lab color is designed to estimate human vision. It aims to closely match human 

perception of lightness. The Luminance ranges from 0 to 100, the A component ranges 

from -120 to +120 (from green to red) and the B component ranges from -120 to +120 

(from blue to yellow). To adjust the lightness contrast of the color shade using the L 

component.  

Because Lab space is much larger than the range of computer displays, printers, or 

even human vision, a bitmap image represented with Lab color model requires more 

data per pixel to obtain the same precision as an RGB or CMYK bitmap. 

LAB color model is used in Photoshop - mainly for color corrections or using the 

lightness channel for color to grayscale conversion. 

 

CMYK works 
through light 
absorption. The 
colors that are seen 
are from the part of 
light that is not 
absorbed. 

Remember 

Many of the colors 
within Lab space fall 
outside the range of 
human vision, and 
are therefore purely 
imaginary; these 
colors cannot be 
reproduced in the 
physical world. 

Do you know! 
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2. Difference between Spot and Offset Printing 

Offset printing is a commonly used printing technique in which the inked image is transferred (or “offset”) from a 

plate to a rubber blanket, then to the printing surface. On the other hand, spot color refers to color generated in 

offset printing by a single ink. That ink could be a “pure” color or mixed according to a formula. 

 

 
 

Four Color Process and Spot Printing 

The commonly used printing process are two.Process. 4-color printing, uses four spot colors to generate a full-

color gamut: Cyan, Magenta, Yellow and Black (CMYK). 

More advanced processes use six spot colors, adding Orange and Green to provide an even larger gamut. This 

is called hexachromatic process printing, or CMYKOG. 

At times, however, you may want to print using just one or two colors – for example let’s say blue and black. This 

is a classic example of two color printing.  

Spot color printing is used for jobs which require no full color imagery, such as for business cards and other 

stationery, or in monotone literature such as black and white newspaper print. Below is an illustartion showing 

how spots are visible on zooming a 4 color print. 

 

 
 

Color Spots in Four Color Process 
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3. Number of Pages Verses Cost Effective Solution 

For an organization or an individual at business, rising costs for toner, paper and other 

printer consumables can be a real challenge but creating a great “Cutomer experience” 

is also important. So, there is a need to address the printing concerns and identify 

several opportunities for reducing costs and boosting service. “With rules based 

printing, specialty print jobs are routed automatically to more cost effective printing 

devices.” 

You can reduce the number of pages in order to have a cost effective solution for print 

by using following techniques. 

Editing 

Editing is your first line of attack. Eliminate the repetitions out of your document, combining two adjacent 

paragraphs into one by deleting a paragraph mark can often make all the difference. 

Margins 

Your second priority may be to reduce the top and bottom margins. For example if top and bottom margins are 

set at 1.0, you can reduce that to 0.9. But reducing the left and right margins, you'll find that reducing the side 

margins by 0.1" will accomplish much more than doing the same to the top margins. 

Fonts 

Sometimes reducing the size of the text is the easiest and best thing to do. Often the text is larger than it needs 

to be. Although there is a certain irreducible minimum type size for readability, this size depends on the length of 

the line; text in narrower columns can be smaller. 

Paragraph Spacing 

Sometimes you can reduce the space between paragraphs (if any). For example, if a heading has 12 points 

Spacing Before, and you have several headings, it may be great reducing the space to 11 points (which will be 

undetectable) will be all that is required. The space between the paragraphs in the body can also be reduced. 

Line Spacing 

Line spacing depends upon the size of the text used. The font with a greater x-height are designed with larger 

line spacings. You can reduce this space to save some page. 

 

4. Number of Colors Sufficient for Print Job Verses Cost Effective Solution 

While seeking out cost effective solution for printing costs, an important and significant point to consider is the 

number of colors required for a print job keeping in mind that the quality of the print should not be affected. There 

are many tecniques for identifying the number of colors for a print job and reduce them to an optimal level. Some 

of them are explained below. 

 Any natural scene or color photograph can be optically divided into three primary colors red, green and 

blue. Roughly equal amount of these colors give white. Other proportions of any two colors give many 

different shades of colors. so for a full colored and expressive print 3 colors are used. 

 Sometimes giving a mono chromatic look to an image makes it even more expressive and makes it a 

cost effective too. 

Anything effective 
and productive in 
relation to its cost is 
reffered to as a cost 
effective solution for 
the organization. 

Cost Effective 

Solution 
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 To reduce stop/start cycles use the Printer Properties | Advanced tab and tell the computer to start 

printing after the last page is spooled.  Typically this setting is set to start printing immediately to improve 

user experience and reduce the perceived wait.  When you change this setting, your document will start 

printing when the computer is done generating the entire document, so there will be an initial delay 

between the time you start your print job and the time the print job starts printing on the printer. 

 Try to restrict some jobs to monochrome (B&W) printers only. 

 You can use 2 color printing for lower end marketing materials and 4 color printing for commercially 

printed pieces. 

 You can also use four color process with 2 spot colors only. That will allow you to print rich and accurate 

photos within your requirements. 
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Learning Unit 3: Understand the Usage of Appropriate 
Printing Material and Texture 

Overview 

In this learning unit, you will learn different types of materials used for printing and their characteristics. After 

completion of this learning unit, you will learn about glossy, matte paper, vinyl, cloth for printing, paper weights, 

textures and the types of lamination.  

 

1. Printing Material 

There are many types of materials available for printing. You need to know the difference between these materials 

as well as the pros and cons of each in order to select a suitable printing material for your print job. 

Glossy Paper 

Glossy papers generally offer the widest color range and best resolution, but they are 

coated with glare which can be a problem under certain lighting conditions. As pointed 

out above, glossy paper is excellent for photos that will be handled without glare. They 

may show fingerprints, but you can easily wipe off smudges or fingerprints without 

harming the prints. Glossy paper have high quality that truly brings out the best color 

and resolution from your printer. 

They are often not the best choice for scrapbooks or glass mounting as they can sometimes stick to the surface 

that is mounted against the printed side of the paper. For mounting behind glass or plastic sleeves, semi-gloss 

may be the best compromise. Glossy paper need to be compatible with your printer. That is, it is possible that 

the paper have gas/light fade problems with certain inks. 

Matte Paper 

Matte paper is excellent for displaying photos that must be displayed "naked" (not 

behind plastic/glass) in an environment where light reflections can be an issue. Matte 

papers are generally not as durable as semi-gloss paper or glossy paper as handling 

of matte prints can sometimes cause marks similar to running your fingers across a 

microfiber material. As a result, matte paper is not generally suited for prints that are to 

be handled in their naked state. 

One real issue with matte papers is that they have less dynamic range (contrast) and a smaller color gamut than 

semi-gloss or glossy papers. Regardless of the semantics, matte papers will generally have greyer colors and 

less contrast than semi-gloss or glossy papers. This fact even more prominent when profiling different paper 

types as it has a smaller color gamut and less dynamic range for matte papers and will therefore you will have to 

make more compromises when creating the print. 

Semi Glossy Paper 

Semi-gloss or "luster" papers offer a good compromise between glare, color range, and durability. It has a color 

range close to that of glossy paper, and at the same time you can be sure you are getting the full power of your 

printer along with reducing glare and smudges. Semi-gloss papers may not completely eliminate glare but most 

Gloss coating is a 
coating that provides 
a lot of shine, which 
results in a higher 
contrast and color 
gamut than other 
papers. 

Gloss Coating 

Matte coating is a 
light coating that 
provides a boost to 
the contrast of your 
photos, but results in 
very little glare 

Matte Coating 
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of them reduce glare to a point where it is not an issue except under the most extreme lighting conditions and 

viewing angles. 

 
 

Matte and Glossy Papers 

Vinyl Material 

Vinyl is not a natural substance but is a synthetic man-made material. It is a type of plastic that is made of ethylene 

(found in crude oil) and chlorine (found in regular salt). When processed, both the substances are combined to 

form Polyvinyl Chloride (PVC) resin, or as is commonly referred to – Vinyl. Vinyl is resistant to moisture and 

humidity. It is a very strong and durable plastic material. Vinyl can be manufactured in a variety of colors, both 

transparent and solid. Vinyl is a very low cost material to produce. 

 Vinyl printing has top quality result and idea for low quantity runs. 

 Multicolored results can be achieved by applying each color separately. 

 Vinyl can be easily removed and changed. 

Cloth 

Fabric or cloth can also be used for printing, it can be referred to as textile printing. 

Textile printing is the process of applying color to fabric in definite patterns or designs. 

In properly printed fabrics the color is bonded with the fiber, so as to resist washing and 

friction.  

For cotton printing vat and reactive dyes are generally used. Silk is usually printed with 

acid colors. Wool is printed with acid or chrome dyes but before printing it is treated 

with chlorine to make it more receptive to colors. Manmade fibers are generally printed 

with disperse and cationic dyes. 

 

2. Paper Weights  

Paper weight is an important component to consider when printing. Heavier media often produce quality and 

provides durability. There are three most famous scales to use for weighing paper. 

 

Various methods 
like block printing, 
stencil printing, 
screen printing, 
digital printing can 
be used to print on 
cloth. 

Do you know! 
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Basis Weight 

The basis weight of a paper is the fixed weight of 500 sheets, measured in pounds, in paper's basic sheet size. 

It is important to note that the "basic sheet size" is not the same for all types of paper. 

 

Caliper 

Caliper refers to the thickness of a sheet of paper expressed in 1000 of an inch. This measurement is taken with 

a micro meter.  

GSM (Metric System) 

This system describes paper weight as mass per unit of area. It is measured in grams 

per square meter, or GSM. 

Below is list of paper weights and their common usage:  

 40 gsm:  tracing paper 

 45-50 gsm :  newsprint 

 75-90 gsm:  sketching or practice paper — thick enough to work on with pencils, charcoal, or pastels, 

but usually too thin for ink or most markers, which may bleed through. 

 100-130 gsm: drawing paper suitable for finished artwork in most media.  Paper any lighter than 70lb will 

usually be thin enough to see through to drawings or materials underneath. 

 180-260 gsm:  heavy-weight drawing paper, Bristol, multi-media papers. Weight in this range is similar 

to card stock or light poster board. 

 Heavier papers approx. 300 gsm or more, are most often used for painting rather than drawing.  When 

found in sketchbooks, they are usually rougher papers intended as watercolor journals or to remove for 

painting on individual sheets. 

 

3. Paper Textures 

Smoothness can also be a factor when deciding which paper to use for printing. Laser 

printers for example use heat and toner to produce text and images, and therefore need 

a smooth paper to give good results, whereas many other printers use water based 

inks, and therefore, need textured paper to absorb the ink.  

Below is a list of paper textures commonly used by commercial printers  

1- Wove or Smooth – A smooth uncoated surface.  

2- Laid – A paper that is manufactured with finish lines on its surface. This texture 

is used mostly for business stationery elements, like letterhead, envelopes and 

business cards. 

3- Linen – Similar to a laid finish, this paper has textured lines on the surface of 

the sheet, but they are finer and more regular than those that appear on a laid 

finish. This paper is also used frequently for business stationery. 

4- Laser – A paper that is guaranteed to be compatible with laser printers. 

5- Coated – A paper with a waxy texture (shiny or matte). 

6- Uncoated – A paper with an untreated surface that is dull and unreflective. 

7- Coated One Side (C1S) – A cover stock that has a coating on one side and is dull on the back side. 

8- Coated Two Sides (C2S) – A cover stock that has a coating on both sides. 

9- Column – Also has a ribbed texture.  

Papers with different 
weights are used for 
different purpose 
according to their 
weight.  

Remember 

The smoothness of 
the paper can be 
determined by 
whether or not the 
paper is coated as 
well as the material 
it is made out of. 

Remember 

Paper Textures 
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10- Felt – Has a textured finish to it and is great texture for holding ink 

 

Different types of Paper Textures 

If you want paper that is smooth you could choose an uncoated paper or a coated paper that has either a matte 

or high gloss finish. 

4. Understand Laminations 

Finding the perfect lamination and mounting product for photography normally comes with two choices.  

1- Gloss (clear and shiny). 

2- Matt (textured and smooth).  

Gloss Lamination 

Gloss lamination will provide photography with a reflective finish, furthermore this finish is good for dark rooms 

with little light as it will reflect any light coming off the image, drawing your eyes to the picture. 

 

Glossy and Shiny Lamination 

Using a Gloss lamination mounting in very light areas can make the image look distorted or sometimes you won’t 

be able to see the image at all with too much light reflection. 

 

 

 

 

Column Felt Laid Linen 
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Matte and Textured Lamination 

In very light areas such as the outdoors or rooms with larger windows it is normally recommended that you use 

a Matte lamination finish. This will add a slight grain to your image and will absorb the light making the viewer 

able to see the image clearly. 

 

Matte and Textured Lamination 

The Gloss or Matte lamination choice can also be used depending on the quality and the feel of the final image. 

Gloss lamination tends to work better with very vivid images such as a glossy vehicle shot or a close up image 

of a colorful butterfly. Matt lamination should work better with flat images such as graphics, signs or buildings. 

Other advantages of using lamination will help keep your images: 

 Clean from dirt and dust. 

 Scratch proof. 

 Protection from fading and color changes through UV damage. 

 Waterproof. 

 Adds a professional quality look and feel. 

Lamination using Glass or Matt is really up to the end user. What you think looks better is the correct choice, it 

really is down to personal preference. 
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Summary of Module 
 

 If you want to have desired printing results, you need to do some research on different sizes of papers 

available for printing and deliver a file to the printer that is ready to print. 

 

 In offset printing an aluminum plate contains image of content. When the plate is inked, only this image 

part holds ink. That inked image is then transferred (or offset) from the plate to a rubber blanket and then 

to the printing surface. 

 

 In digital printing, an image is sent directly to the printer in the form of digital files such as PDFs and other 

files from graphics software such as Illustrator and InDesign. 

 

 Screen printing is the process of using a mesh-based stencil to apply ink onto a substrate, whether it is 

T-shirts, posters, stickers, vinyl, wood, or other material. 

 

 When you are working with your design there are several color models to select from but three of them 

are more important than others. They are, RGB, CYMK and LAB. 

 

 Offset printing is a printing process and spot color refers to color generated in offset printing by a single 

ink 

 

 Anything effective and productive in relation to its cost is reffered to as a cost effective solution for the 

organization. It can be cost effective solution to reduce the number of pages and colors required for 

printing. 

 

 While printing, things that need to be considered include, type of paper used (Glossy, Matte etc.), weight 

of paper, texture of the paper (smooth, linen, column etc.) and type of lamination to be used (Glossy, 

Matte and textured). 
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Frequently Asked Questions (FAQs) 

FAQ 1:  What are different paper sizes used in printing? 

Answer 
There are different sizes of paper used for printing for example, letter, legal, tabloid, A4, A3, 

A2, A1, Posters, Banners, and Cards etc. 

FAQ 2:  What is page orientation? 

Answer 
Page orientation is the way in which a rectangular page is oriented for normal viewing. The 

two most common types of orientation are portrait and landscape.  

FAQ 3:  What is the drawback of offset printing? 

Answer 
The major drawbacks of offset printing process is the plate. Once a layout is already made 

into a plate, it cannot be easily changed 

FAQ 4:  Name the famous offset printing machines? 

Answer The famous offset printing press are Ronald, Rota, Solna and Heidelberg. 

FAQ 5:  What is digital printing? 

Answer 
In digital printing, the image is directly transferred from computer to printer to be printer on 

paper. 

FAQ 6:  What is screen printing? 

Answer 
Screen Printing is the process of using a mesh-based stencil to apply ink onto a substrate, 

whether it be T-shirts, posters, stickers, vinyl, wood, or other material. 

FAQ 7:  What is goal or objective? 

Answer 
A specific result that a person or system aims to achieve within a time frame and with 

available resources.  

FAQ 8:  Write one of the disadvantages of screen printing? 

Answer Each color is applied separately, making the cost higher per additional color 

FAQ 9:  CMYK stands for? 

Answer Cyan, Magenta, Yellow and blacK 

FAQ 10:  What is color spot? 

Answer Spot color refers to color generated in offset printing by a single ink. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the 

end of this module. 

1.  RGB Stands for_______________. 

a.  Red, Green, Brown b.  Red, Green, Black 

c.  Red, Green, Blue d.  Rusty, Green, Blue 

2.  Select INCORRECT option, Offset printing machines are_______________. 

a.  Rota b.  Spot Color 

c.  Ronald d.  Heidelberg 

3.  Screen Printing is also called_______________. 

a.  Offset Printing b.  Silk Screen 

c.  Digital Screen d.  Ronald Printing 

4.  RGB colors combine in equal proportion to create_______________. 

a. Magenta  b. Black 

c. Yellow d.  White 

5.  Cyan, Magenta and Yellow colors combine to make_______________. 

a. Pure Black b. Light Black 

c. Pure Brown d.  Muddy Brown 

6.  Which of the following is not a paper texture 

a. Vinyl b. Linen 

c. Felt d.  Wove 
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7.  Which one of the following is not a paper weight scale 

a. Basis Weight b. Caliper 

c. KMS d.  GSM 

8.  Matte Paper Provides_______________. 

a. High Quality b. Large gamut of colors 

c. High contrast d.  Durable Product 

 

9.  Vinyl is a ______________________ material. 

a. Natural b. Man-made 

c. Low quality d.  High quality 

10.  Glossy lamination is used in _________________. 

a. Low light areas b. Indoor 

c. Outdoor d.  Very light areas 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 b 

3 b 

4 d 

5 d 

6 a 

7 c 

8 c 

9 b 

10 a 
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Module 4: Photo Editing and Graphic 
Development 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Edit photos through different editing software, tools and 
techniques available. 

  Apply visual effects such as filters to a photo to enhance it. 

  Merge different photos to create one single photo. 

  Identify the cost efficient solution based on number of pages 
and number of colors. 

  Scan and use photos. 

  Identify sense of balance and alignment of objects in a layout 
on canvas. 
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Learning Unit 1: Photo Editing and Scanning 

Overview 

In this leaning unit, you will learn the tools and techniques used in image editing software to make adjustments 

to the image. After the completion of this learning unit, you will be able to demonstrate the color correction 

techniques, adjust brightness, contrast, color tint, color saturation of the image as a whole, retouching, and 

removing dust. Also, you will be able to define transformation, correct lens aberrations, adjust the geometry by 

crop, rotate, use of filter, merging two photos into one and importing photos.  

 

1. Color Correction Techniques 

Color correction is the removal of unwanted color casts by neutralizing blacks, grays 

and/or whites. An adobe Photoshop, color correction can be done using two 

techniques. Using levels and using curves. Both techniques are explained below by 

correcting the same image. 

Color correction using Levels:  

 

Below are the steps for color correction: 

 

1- Open the image in Adobe Photoshop.  

 

 

A color cast is an 
unwanted tint in the 
image due to the 
lighting, the white 
balance of the video 
camera, or the type 
of film stock used 
given the lighting 
conditions during the 
shoot. 

Color Cast 

Adobe Photoshop 
can remove the color 
cast created by fog, 
dusty environment of 
light effects. 

Do you know! 
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2- Create a new level layer as: 

Layer->New adjustment Layer ->Levels 

 

3- Double click at the black eyedropper on the left 

 

4- Color picker will appear, type 5 in the B text box as shown, press ok. 

 

 

5- Double click at white eyedropper.  
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6- Type 95 in the B text box in the color picker and click OK. 

 

7- Add Threshold layer as Layer-> New Adjustment Layer->Threshold. 

 

8- Move the slider towards right until the whole image becomes black. Now move the slider towards left a 

little bit. When a small white area appears Shift+click in the white area as shown below. Then move the 

slider towards left and slowly move towards right when a bit black appears Shift+Click in the black area. 

 

9- Now click at Cancel.  
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10-  Click at New Layer button -> Levels.  

 

11-  Click at white eyedropper and then click at marked point 1. 

12-  Click at black eyedropper and then click at marked point 2. 

       

Threshold layer 
helps you to mark 
the lightest and 
darkest points in 
your image. 

Do you know! 
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13-  Click Ok. 

 
Before      After 

Color Correction Using Curves: 

1- Open the image in Adobe Photoshop. 

2- Add a curves layer as: 

Layer ->New Adjustment Layer ->Curves. 

 

3- In the curves, click at the midpoint, one grid above midpoint and one grid below the midpoint.  

 

4- Move the lower point a bit low and the upper point a bit more up. 

With Curves you can 
adjust any point 
along a 0-255 scale 
unlike making 
adjustments using 
only three variables 
(highlights, 
shadows, midtones). 

Curves 
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5- Click ok. 

 

 

Before      After 

 

2. Adjustment of Brightness, Contrast, Color Tint, Color Saturation 

Changing Brightness, Contrast and color tint and saturation in Adobe Photoshop 

You can change brightness, contrast and color as. 

1- Open the image in Adobe Photoshop. 

2- Click at Image ->Adjustment ->Brightness/Contrast 



 Module 4: Photo Editing and Graphic Development 

Teaching and Learning Material: Information Technology (Computer Graphics – Print)                                                         | 131 

 

3- You can adjust the brightness and contrast by moving the sliders. 

 

To change color tint and saturation, 

1- Click at image->adjustment->Hue/Saturation. 

 

2- You can change the color tint (lightness), saturation (intensity) and hue using the sliders. 
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Changing Brightness, Contrast and color tint and saturation in Adobe Illustrator 

1-     Select all the artwork that you want to make less bright 

2-     Go to Edit -> Edit Colors -> Saturate... 

3-     Check the Preview check mark to see the results immediately 

4-     Decrease the intensity until the objects are less bright. 

 

3. Sharpening and Retouching for Removing Dust Specks and Scratches  

Retouching  

Retouching is the process of getting an image ready for final presentation. This can take a variety of techniques 

and process. It can be very simple or dramatic but every image that you see used in advertising will be subjected 

to some form of enhancement. 

Sharpening  

Sharpening enhances the definition of edges in an image. Whether your images come from a digital camera or 

a scanner, most images can benefit from sharpening.  

 

Sharpening image in Adobe Photoshop 

You can sharp the image in Adobe Photoshop as 

1. Open your image in Adobe Photoshop. 

2. Click at Filter->Sharpen. 

 

3. Now you can sharpen the image by using different options available in the menu. 

           Before             After 

Tints are created by 
adding white to a 
color. It refers to the 
lightness of a color. 

Tint 
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Removing Dust Specks and Scratches 

When you scan image from film, slides, or prints, you will face the problem of dust and 

scratches. You can use spot healing brush to remove dust and scratches as 

1- Open the image in Adobe Photoshop. 

2- Click the healing brush tool in the toolbox and then click at spot healing brush 

tool in the fly-out. 

   . 

3- Make sure to have following settings for healing brush tool. 

 

a. Set the radius of the brush according to the spot size. 

b. Set Content Aware option. 

 

 

4- Now click at the spots one by one to have all the scratches removed. 

 

 

The Healing Brush 
tool lets you correct 
imperfections, 
causing them to 
disappear into the 
surrounding image 

Healing Brush 
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Remove Dust specks and scratches using Clone Stamp.  

1- Select the clone stamp tool from toolbox. 

    

 

2- Select a clear point in the image as a source point. Alt+Click at that point. 

 

3- Click at the dust or scratch spot one by one like distorted number 2 in the above picture. 

 

4. Understand and Practice the Use of Visual Effects 

Visual effects includes filters which are used to enhance the image. Filters are used to change the appearance 

of an image, layer or selection in Photoshop. Below is the detail of the use of some common filters.  

Now we will apply different filters on the image below 

 

Before Filter effect 

To remove dust 
specks and 
scratches in tight 
spaces like face or 
designs, use clone 
stamp. 

Remember 



 Module 4: Photo Editing and Graphic Development 

Teaching and Learning Material: Information Technology (Computer Graphics – Print)                                                         | 135 

Colored Pencil Filter 

1- Open image in Adobe Photoshop. 

 

2- Click at Filters->Artistic->Colored Pencil. 

3- The output image will be like. 

 

After Filter Effect 

As in the above example you can apply a number of artistic filter in the same way clicking at Filter->Artistic… 

Result of some of the filters is as shown below 

Cutout… 
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Dry Brush 

 
Film Grain 

 
Fresco 

 
Neon Glow 
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Paint Daubs 

 
Plastic Wrap 

 
 

5. Transformation and Styles 

Transformation 

In Photoshop, Transform is used to scale, rotate, skew, and just distort the perspective 

of any graphic. You can also apply transformations to a path, a vector shape, a vector 

mask, a selection border, or an alpha channel. Transforming affects image quality when 

you manipulate the pixels. The different types of transformation used in Photoshop are 

 Scaling Graphics 

One of the most basic transformations Photoshop is capable of is scaling a graphic. Scaling allows you 

to enlarge or shrink a graphic around a reference point. 

 

Scaling Graphics 

 Rotating Objects  

You can rotate an image at any angle in Photoshop. 

 Skew, Distort, and Perspective Transformation 

Images or objects can be skewed, distort, and their perspective can be corrected using transformation. 

You can apply 
transformations to a 
selection, an entire 
layer, multiple 
layers, or a layer 
mask. 

Do you know! 



Module 4: Photo Editing and Graphic Development 

138 |                                                         Teaching and Learning Material: Information Technology (Computer Graphics – Print) 

 Warping an Object  

The Warp Transformation is quite a bit different compared to the other transformations. The entire shape 

of the object can be modified, making this transformation useful for several different effects. 

 

Wrapping Objects 

Styles 

Photoshop provides a variety of effects, such as shadows, glows, and bevels that 

change the appearance of a layer’s contents. When you move or edit the contents of 

the layer, the same styles are applied to the modified contents. For example, if you 

apply a drop shadow to a text layer and then add new text, the shadow is added 

automatically to the new text. 

You can also create custom styles for your layer and can apply more than one styles to the layers.  

 

Layer with Multiple Styles 

Double click at the layer and layer style dialogue box will appear. 

Layer styles are 
linked to the layer 
contents. 

Remember 
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Layer Style Dialogue Box 

You can apply any style you want from the list in the dialogue box like drop shadow, inner shadow, outer glow 

etc. 

 

6. Procedure of Correcting Lens Aberrations 

Aberrations 

In an ideal optical system, all rays of light from a point in the object plane would 

converge to the same point in the image plane, forming a clear image. The reasons 

which cause different rays to converge to different points are called aberrations. 

Lens Distortion/Aberrations  

Barrel distortion is a lens defect that causes straight lines to bow out toward the edges 

of the image.  

Pincushion distortion is the opposite effect, where straight lines bend inward. 

 

Barrel and Pincushion 

 

 

Barrel distortion 
refers to the shape 
of a barrel and 
pincushion distortion 
refers to the shape 
of a cushion. 

Do you know! 
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Chromatic Aberrations 

Chromatic Aberration, also known as “color fringing” or “purple fringing”, is a common 

optical problem that occurs when a lens is either unable to bring all wavelengths of 

color to the same focal plane, and/or when wavelengths of color are focused at different 

positions in the focal plane. 

 

Chromatic Aberration 

Correcting Lens Aberration 

 

You can correct lens aberration in Adobe Photoshop as 

1- Open image in Adobe Photoshop. 

2- Click at Filter > Lens Correction. 

 

3- Move the slider, drag it until it looks correct and then release. 

 

Chromatic 
aberration appears 
as a color fringe 
along the edges of 
objects caused by 
the lens focusing on 
different colors of 
light in different 
planes. 

Chromatic 

Aberration 
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4- Feel free to fine tune as you see fit. 

             Most lenses only need values between +5 and -3, so go easy here. 

Correcting Chromatic Aberration 

1- Open the image in Adobe Photoshop. 

2- Click at Filter->Distort->Len Correction. Which gives you a new window with a preview and control 

sliders. 

 

3- In the Chromatic Aberration box (towards the top) just move the two sliders until your image looks 

great. 

 

 

Correcting Light falloff  

Vignette is a defect that darkens the corners of an image due to light falloff around the perimeter of the lens. 

1- Open the image in Adobe Photoshop. 

2- Click at Filter->Distort->Len Correction. Which gives you a new window with a preview and control 

sliders. 

 

3- Move the lens Vignetting slider until the edges of image are lightened up. 
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7. Procedures for the Adjustment of the Geometry by Crop, Rotate, Correct 
Perspective and Distortion 

Rotating an Image 

To Rotate an Object at any angel in Photoshop, 

1- Open the image in Adobe Photoshop. 

2- Click at Edit > Transform > Rotate.  

 

3- Handles will appear but instead of dragging one of these, go just outside of the object until you see a 

curved arrow rotate icon.  

4- At this point, simple drag left or right to rotate the selected object. 

 

5- Press Enter to finish application of rotation. 

 

To rotate the image 
in increments of 15o, 
Press and hold Ctrl 
and rotate. 

Do you know! 
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Cropping an Image 

To crop extra area from the image, 

1- Open the image in Adobe Photoshop. 

2- Select the crop tool from the tool box on the left. 

 

3- Click and drag over the desired area in the image. 

 

4- Press Enter. 
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Correcting Perspective 

The Perspective transformation allows you to add perspective to an object. To correct perspective in Adobe 

Photoshop. 

1- Open the image in Adobe Photoshop. 

2- Click at Edit->Transform->Perspective. 

 

3- Click and drag the handles that appear on the edges on image to add perspective to the image. 

 

4- Press Enter to make the changes permanent. 

 

Correcting Distortion 

To correct distortion, 

1- Open the image in Adobe Photoshop. 

2- Click at Edit->Transform->Distort. 

 

3- Click and drag the handles that appear on the edges of the image to distort it in the desired direction. 
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4- Press Enter to make the changes permanent. 

8. Photo Enhancement or Manipulation through the Use of Filters  

Filters in Adobe Photoshop 

You can use filters to clean up or retouch your photos, apply special art effects that give 

your image the appearance of a sketch or Blurred painting, or create unique 

transformations using distortions and lighting effects. The filters provided by Adobe 

appear in the Filter menu. These filter are formed in following groups. 

 Artistic 

 Blur 

 Brush Strokes 

 Distort 

 Noise 

 Pixelate 

 Render 

 Sharpen 

 Sketch 

 Stylize 

 Texture 

 

Artistic Filter 

Filters from the Artistic submenu help you achieve painterly and artistic effects for a fine arts or commercial 

project. 

You can apply a 
filter to an individual 
channel, apply a 
different effect to 
each color channel, 
or apply the same 
filter but with 
different settings. 

Do you know! 
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Bursh Strokes 

Like the Artistic filters, the Brush Stroke filters give a painterly or fine-arts look using different brush and ink stroke 

effects. 
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Distort Filter 

The Distort filters geometrically distort an image, creating 3D or other reshaping effects.  

 

Sketch Filter 

Filters in the Sketch submenu add texture to images, often for a 3D effect. The filters 

also are useful for creating a fine-arts or hand-drawn look 
Distort filters can be 
very memory 
intensive so these 
may occupy much 
space and make the 
design very heavy. 

Remember 
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Stylize Filter 

The Stylize filters produce a painted or impressionistic effect on a selection by displacing pixels and by finding 

and heightening contrast in an image. It includes many filters like, diffuse, glowing edge, embose, extrude etc. 

 
Texture Filter 

Texture filters is used to simulate the appearance of depth or substance, or to add an organic look. 
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9. Procedure of  Merging Two or More Photos into One 

Merging two or more different pictures allows you to create beautiful graphics in many fields. Photoshop lets you 

create special effects with merging photos. 

1- Open Adobe Photoshop. 

2- Open the two photos that you want to merge in photoshop. 

3- Create a new file by clicking at File-> New and enter the dimentions for the new file. 

 

4- Drag the other two photos in the new image file. 

5- Now remove the unwanted parts of image by selecting the eraser and and set up the size to 145px and 

the Hardness to 15%. Set the Opacity to 30% so the Eraser tool will be less effective and easier to use. 
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6- Erase the unwanted parts and use smaller sized eraser for narrow areas.  

 

 
 

7- Select the Brush tool from the toolbox, set up the size to 100px, hardness 20% and Opacity to 30% using 

color which best matches with your images. 

 

8- Use smaller size areas for fine details. 

9- Refine the results. 

 

 

To correctly erase 
the parts, you can 
also set up the level 
in mode to Multiply. 
This way the layer 
becomes semi-
transparent and 
allows you to see 
what you have done 
in the level behind. 

Remember 
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10. Importing Photos through Scanning them in a Layout 

To import scanned images, either open TIFF files saved from separate scanning software, or use a TWAIN or 

WIA interface directly in Photoshop. In either case, make sure to install the software necessary for your scanner. 

Import Images from a Separate Scanning Application 

Most of the scanners come with softwares that you can run outside of the Adobe Photoshop. To import images 

in photoshop using these software, 

1- Place the image in the scanner. 

2- Start the scanning software, and set options as desired. 

3- Save the scanned image as .TIFF file. 

4- In Photoshop, open the saved TIFF files. 

Import images using a WIA interface 

1- Choose File > Import > WIA Support. 

 

 
 

2- Choose a destination on your computer for saving your image files. 

3- Click Start. 

4- Select Open Acquired Images In Photoshop (unless you have a large number of images to import, or if 

you want to edit the images at a later time). 

5- Select Unique Subfolder if you want to save imported images in a folder named with the current date. 

6- Select the scanner that you want to use. 

7- Choose the kind of image you want to scan: Color Picture, Grayscale Picture, or Black And White Picture 

or Text. 

8- To specify custom settings, select Adjust The Quality Of The Scanned Picture. 

9- Click Preview. If necessary, drag the handles of the bounding box to adjust the size of the crop. 

10- Click Scan. 

The scanned image is saved in BMP format. 
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Learner’s Activities 

Removal of Color Tint from an Image 

Description:  This activity consists of a practical session in which all students select image with a 

color tint for them and try o remove the tint using threshold layer and curves. 

Time Guideline: 30 min 

Purpose:  To practice the use of threshold layer and curves for removing color tint in an image 

Presentation: 

 

1- Browse Internet and collect some images having color tint.  

2- Give an image to each student and ask them to remove the tint in Adobe 

Photoshop. 

3- Check the performance of each student 

4- Encourage the learners for their try. 

 

Application of Filters to Image 

Description:  This activity consists of practical session in which students will learn about the effect 

of different filters on an image. 

 

Time Guideline: 30 min 

 

Purpose:  To differentiate between different filters in Adobe Photoshop. 

 

Presentation: 

 

1- Ask the students to select an image for them and apply different filters to 

those images in Adobe Photoshop. 

2- Ask them to label each filter effect. 

3- Assess the student’s performance. 

4- Encourage each students for his try. 

 

 

  



 Module 4: Photo Editing and Graphic Development 

Teaching and Learning Material: Information Technology (Computer Graphics – Print)                                                         | 153 

Learning Unit 2: Create Layout 

Overview 

In this learning unit, you will learn how to develop a layout on canvas. After completion of this learning unit, you 

will be able to create media elements, graphs, tables, text and diagrams using the techniques and also applying 

colors to the developed objects. 

 

1. Create Objects (Media Elements, Graphics, Graphs, Tables, Diagrams etc.) on 
Canvas 

A layout is the starting point for a design. It may include media elements, graphics, tables, diagrams etc. it is 

important to keep in mind that all the elements in the design layout should be in balance with correct harmony. 

We can develop a layout in Corel Draw For example let’s develop a simple notepad as shown below. 

 

You can develop a simple notepad graphics on the canvas as. 

1- Open Corel Draw. 

2- Create a new file by clicking at File->New. 

3- Enter the dimensions for the new file. 
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4- Select the "Rectangle Tool ", from the left toolbar, make a new box shape and then make the box shape 

resized into 885 x 635 pixel. 

 

5- Select Shape Tool from toolbox and go to the upper toolbar there you will find corner shape option, set 

the type into Rounded Corner, and set the Corner Radius to 107 px, apply it on all corners. 

 

6- Select the box go to the "Fountain Fill Tool ", choose custom fill on the color blend and make the type 

Linear, fill the color with Gray on the left and white on the right. 
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7- Now create a tiny Circle Shape using “Ellipse Tool “in the left toolbar. 

8- Arrange the Circles on top of the Gray Box Shape, give it Orange color and copy it as picture below. 

 

9- Create a line using “Bezier Tool “by left click and point. 
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10- Shape it using “Shape Tool ", click on the middle of the line and find "convert to curves” in the top toolbar, 

drag the arrow on the corner in order to shape. 

 

 
11- Make it outline strong arrange the shaped line on top of the Orange Circle.  

 

Develop all the 
elements of the 
layout in the same 
way and then 
integrate them with 
balance in the form 
of a layout. 

Remember 
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12- Create horizontal line and place them on top of notepad. 

 
Creating Graphs in Adobe Illustrator 

1- Open Adobe Illustrator. 

2- Create a new document and click at Graph Tool, Left click and drag, you will see a graph dimensions 

box, this is primarily how big your graph will be. 

 

3- You will see a table to put your data, enter all your data in the table. 

4- You will see a chart like in the picture (this illustrate is a Column Graph Tool). 

 

5- You can change the default graph by click on the graph (currently a bar chart), press the right click and 

select Type, let’s change its type to area graph. 
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6- You can change your graph color or elements by use Direct Selection Tool. 

 

Creating table in Adobe Illustrator 

1- Open Adobe illustrator. 

2- Create a rectangle of desired size using rectangle tool. 

 

3- Click at your rectangle and choose Object at the main menu, scroll down to Path and select Split into 

Grid. 

You can select the 
indivisual 
components of the 
graph and apply 
different formating. 

Remember 
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4- Set the number in Gutter box to 0px, type the number of row and column in the boxes and click OK. 

 

 

5- You will get a table and can change the color, stroke or type a text in each box. 
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Creating table in Corel Draw 

1- Open Corel Draw. 

2- Create a new file as file->New. 

3- Click at graph paper tool in the flyout next to the polygon tool. 

 

4- Enter the number of rows and columns in the graph paper tool property bar. 

 

5- Click and drag to create the table of desired size. 

 

6- Just Ctrl+Click on cells to select and then specify the color or any other formatting.  
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7- Fill in the data into the table and you are done.  

 

Creating diagram in Adobe Illustrator 

Adobe Illustrator contains many tools which are helpful for creating professional diagrams. In the following steps 

we will draw a diagram in Adobe Illustrator. 

1- Open Adobe Illustrator. 

2- Create a new file as File->New and specify the height and width of the document. 

You can apply 
formatting to any 
group of or 
individual rectangle 
cell of the table 

Do you know! 
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3- In our example we choose sketch of a hamburger. 

4- Now create a new layer, use the "Ellipse Tool" on the toolbar. set the fill on toolbar to "none" and set the 

stroke color to "black" and the stroke weight to 1. Place the shape on the sketch following the sketch. 

 

5- Create the other shapes for your sketch. Use "Pen Tool" to create a tomato slice, cheese and bread. Use 

"Pencil Tool" to create the meat and vegetable fillings.  

  

 

 

 

Draw a sketch by 
hand or you can 
draw sketch in 
adobe Photoshop 
and open that 
sketch in Adobe 
Illustrator. 

Do you know! 
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6- Draw all the shapes for ingredients on Hamburger. 

 

7- A dd color to the ingredients. Use the "Gradient Tool" to add color to two all the layers. 

 

8- Add sesame seed on the top of burger using pen tool and you are done with the diagram. 
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2. Apply Colors to Objects 

While applying colors to the layout, keep in mind the purpose and target audience of the layout design. As all the 

colors have special meaning so in order to have better communication of the complex information to the viewer, 

selection of right color scheme is vital. 

Colors scheme involves colors applied on various objects like, background, shapes, buttons, icons, typography, 

logo giving an overall sense of unity to the design 

 

Different color used for objects 

Appying colors in Corel Draw 

In Corel Draw, you can apply two types of color fills to the objects. 

1- Solid Color Fill 

2- Fountain Color Fill 

Solid Color Fill 

Solid color fill is a single color fill with a large number of 

shades available in corel draw. You can apply solid color fill 

as 

1- Click at the object you want to color, to select it. 

2- Click at the color in the color pallette to change the fill 

color and right click at the color to change the outline of object. 

 

           
 

You can also use 
the texture, pattern, 
bitmap of different 
color to apply color 
to the objects. 

Do you know! 
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Fountain Color Fill 

1- Click at the object to select it. 

 

2- Choose the Interactive Fill tool from the Interactive Fill flyout in the toolbox. 

 

3- Using the default settings you can get a gradient fill from black to white. From the toolbar you can choose 

what type of fill as shown below 

 
 

4- Drag and drop colors onto the handles of the fill to change the colors.  

5- Move the drag handle on the fill to alter the gradients of the fill.  
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Click at the dotted 
line to add more 
color handles. That 
will give a multicolor 
gradient. 

Remember 
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Summary of Module 

  Color correction is the removal of unwanted color casts by neutralizing blacks, grays and/or whites. 

An adobe Photoshop, color correction can be done using two techniques, Using levels and using 

curves. 

  
Retouching is the process of getting an image ready for final presentation. Sharpening enhances the 

definition of edges in an image. 

  
When you scan image from film, slides, or prints, you will face the problem of dust and scratches. 

You can use spot healing brush and clone stamp to remove dust and scratches. 

  
Visual effects includes filters which are used to enhance the image. Filters are used to change the 

appearance of an image, layer or selection in Photoshop. 

  
In Photoshop, Transform is used to scale, rotate, skew, and just distort the perspective of any 

graphic. You can also apply transformations to a path, a vector shape, a vector mask, a selection 

border, or an alpha channel. 

  
Photoshop provides a variety of effects, such as shadows, glows, and bevels that change the 

appearance of a layer’s contents. When you move or edit the contents of the layer, the same styles 

are applied to the modified contents. 

  
In an ideal optical system, all rays of light from a point in the object plane would converge to the 

same point in the image plane, forming a clear image. The reasons which cause different rays to 

converge to different points are called aberrations. 

  
You can use filters to clean up or retouch your photos, apply special art effects that give your image 

the appearance of a sketch or Blurred painting, or create unique transformations using distortions 

and lighting effects. 

  
To import scanned images in Adobe Photoshop, either open TIFF files saved from separate scanning 

software, or use a TWAIN or WIA interface directly in Photoshop. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is color cast? 

Answer 
A color cast is an unwanted tint in the image due to the lighting, the white balance of the video 

camera, or the type of film stock used given the lighting conditions during the shoot. 

FAQ 2:  Why do we use threshold to remove color cast? 

Answer Threshold helps you to point the lightest and darkest area in your image.  

FAQ 3:  What are visual effects? 

Answer Visual effects are used to enhance and give special effects to an image. 

FAQ 4:  Why do we use transformation? 

Answer 
Transformation is used to change the geometry of the objects. It rotates, skews, distort and adds 

perspective to the image. 

FAQ 5:  What barrel distortion? 

Answer 
Barrel distortion is a lens defect that causes straight lines to bow out toward the edges of the 

image. 

FAQ 6:  What is pincushion distortion? 

Answer Pincushion distortion is the opposite effect, where straight lines bend inward. 

FAQ 7:  What is chromatic aberration? 

Answer 

Chromatic Aberration is a common optical problem that occurs when a lens is either unable to 

bring all wavelengths of color to the same focal plane, and/or when wavelengths of color are 

focused at different positions in the focal plane. 

FAQ 8:  Describe Vignetting? 

Answer 
Vignetting is a defect that darkens the corners of an image due to light falloff around the 

perimeter of the lens. 

FAQ 9:  What are two ways to import scanned images in Photoshop? 

Answer 
1- Import images from a separate scanning application. 

2- Import images using a WIA interface 

FAQ 10:  Where to use clone stamp for removing dust specks and scratches? 

Answer 
In the tight spaces like face or design, dust specks and scratches should be removed using clone 

stamp. 
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Test Yourself! 
 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the end 

of this module. 

 

1.  Color cast is caused by ______________. 

a.  Lens flaw b.  Software Mistake 

c.  Photographer Mistake d. Lighting, fog etc. 

2.  Tints are created by adding _______________ to a color. 

a.  White b.  Grey 

c.  Black d.  Red 

3.  Saturation means ___________ of a color. 

a.  Hue b.  Tint 

c.  Intensity d.  Shade 

 

4.  Sharpening __________. 

a. Makes an image brighter  b. Enhances definition of edges in image 

c. Makes image colors more intense d.  Develops tints of colors in image 

 

5.  The tools used to remove dust and scratches are _________. 

a. Healing Brush and Patch tool b. Color Brush and Patch tool 

c. Clone Stamp and Patch tool d.  Clone Stamp and Healing Brush 

 

6.  Which of the following is not a Filter group. 
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a. Adjustment b. Texture 

c. Artistic d.  Sketch 

7.  Select the incorrect option, Transformation is used to _________. 

a. Skew b. Rotate 

c. Scale d.  Sharp 

8.  Chromatic Aberration is also called___________. 

a. Red Fringing b. Purple Fringing 

c. Blue Fringing d.  Green Fringing 

9.  The option for removing Aberration is present in _________. 

a. Filter->Distort->Lens correction b. Edit->Distort->Lens correction 

c. Filter->Sharpen->Lens correction d.  File->Sharpen->Lens correction 

10.  _________________ Filters are memory intensive. 

a. Artistic b. Brush Strokes 

c. Distort d.  Stylize 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 a 

3 c 

4 b 

5 d 

6 a 

7 d 

8 b 

9 a 

10 c 
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Module 5: Preparing Pre-Press Job 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Understand the printing process  

  Use crop and registration marks  

  Understand the relation of printing plates and document size.  

  Understand the formats used for publishing artwork  

  Use appropriate storage medium for storing and publish the 

artwork  

  Prepare CD or DVD  
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Learning Unit 1: Setting Bleed, Margins, Gutter and Slug 
for Cropping (Printing) 

Overview 

This unit describes the specification and elements to be included in a document before printing so the printer will 

provide your final project as intended. After the completion of this learning unit, you will be able to demonstrate 

the process of applying bleeding, standard margins, gutter settings and slug on the image to be printed. 

 

1. Bleeding and Documents that Require Bleeding 

Introduction to Bleed 

Bleed is a printing term that is used to describe a document which has images or 

elements that touch the edge of the page, extending beyond the trim edge and leaving 

no white margin. When a document has bleed, it must be printed on a larger sheet of 

paper and then trimmed down. 

The example below shows how a document should be set up with bleed.  

 

The Dotted Line Shows where the Card is Cut 

 

Documents that Require Bleed 

Common documents and their measurement of bleed in inches: 

 3.5” x 2“ business card  --->        3.75” x 2.25” 

 4” x 6” postcard             --->        4.25” x 6.25” 

 5” x 7” invitation             --->        5.25” x 7.25” 

 8.5” x 11” sheet             --->         8.75” x 11.25” 

 11” x 17” sheet              --->         11.25” x 17.25” 

 

 Un mounted posters do not require bleed  

 Mounted posters require 0.25” bleed on each side 

Bleeds are images 
that extend beyond 
the live area of the 
page (and beyond 
the trim marks) to 
guarantee clean 
edges. 

Bleed 
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2. Procedure of Applying Bleed to Extend the Image Background Color 

Applying Bleed in Adobe Photoshop has Following Steps 

1- Launch Adobe Photoshop as  

Start Button -> All Programs ->Adobe Photoshop 

  

 
 

2- Choose file->New. New dialogue box will appear. 

 

3- Set the new document's size and resolution. Remember to add the size of the bleed to the document 

size. For example, if final document size will be 5 by 7 inches, and the required bleed is 0.25 inch, set 

the document width to “5.25 inches” and the height to “7.25 inches and click OK. 

 

Applying Bleed in Corel Draw 

1- Open the Image in Corel Draw 

2- Click Layout > Page Setup...  

The best way to 
apply bleed is to 
apply bleed at the 
start of creating 
image. 

Remember 
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3- In the Bleed: box, type in 0.125 and check "Show bleed area" 

4- Click Ok 

 

 

3. Procedure of Applying Margins to the Document  

Applying Margins in Corel Draw 

1- Open the Image in Corel Draw 

2- Click Layout > Page Setup...  

If in your image you 
have a solid color 
background, you will 
have to apply bleed 
on all the four sides. 
If there is just some 
artwork in your 
image that touches 
just one side then 
you will have the 
bleed just that one 
side. 

Do you know! 

If in your image you 
have a solid color 
background, you will 
have to apply bleed 
on all the four sides. 
If there is just some 
artwork in your 
image that touches 
just one side then 
you will have the 
bleed just that one 
side. 

Do you know! 
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3- Do the following step: 

 

a. Click the + to expand Guidelines 

b. Click Presets 

c. Click the User Defined Presets round button 

d. Check "Margins" 

e. Type in 0.125 into the Top and Left boxes (if mirror margins is checked it will fill in the rest) 

 

4- Click Ok 

Applying Margins in InDesign 

1- Launch InDesign 

2- Click File -> New -> Document  

Visually margins 
cage the content 
and support the 
structure of a layout. 

Remember 

Default page margin 
is 1 inch in all four 
sides. 

Remember 
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3- Go to the Margins section. 

4- Enter the margin for top, bottom inside and outside. 

5- Click Ok 

To Redefine Margins in InDesign 

1- Open the document in InDesign 

2- Select the pages to be edited as: 

 

a. Go to window -> pages 

b. Hold down Shift button and click at the pages you need. 

 



Module 5: Preparing Pre-Press Job 

180 |                                                         Teaching and Learning Material: Information Technology (Computer Graphics – Print) 

 

3- Go to Layout->Margins and Columns. 

4- Set new values for Margins. 

 

4. Procedure of Gutter Setting for the Document to be Printed 

Setting Gutter in InDesign 

1- Launch InDesign 

2- Click File -> New -> Document 

 

3- Go to the Columns section 

4- Enter the gutter value 

5- Click Ok 

 

 

 

The gutter margin 
refers to the 
additional margin 
added to a page 
layout for binding 
process. 

Gutter 
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To Redefine Gutter in InDesign 

1- Open the document in InDesign 

2- Select the pages to be edited as 

 

a. Go to window -> pages 

b. Hold down Shift button and click at the desired pages. 

 

3- Go to Layout->Margins and Columns 

 

4- Set new value for gutter 

5. Procedure of Setting Slug 

Setting Gutter in InDesign 

1- Launch InDesign 

2- Click File -> New -> Document 

While printing a 
book, gutter at both 
pages is at the inner 
sides of papers. 

Remember 
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3- Go to the Bleed and Slug section 

4- Enter the Slug value in top, bottom, Inside [right] and Outside [left] 

5- Click Ok 

 

 

  

Slug area is an area 
outside the margin 
and bleed that 
contains printing 
information, 
customized color bar 
information, or 
displays other 
instructions. 

Slug 

Slug is normally 
used to identify a 
document. It is used 
to write notes to the 
printer and/or other 
people working on 
the document 

Remember 
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Learning Unit 2: Apply Cropping and Registration Marks 

Overview 

This unit describes the concepts of crop marks or trim marks. After the completion of this learning unit, you will 

be able to use of crop marks, in a way to make it easy to trim the document and set the final intended size of the 

document.  

1. Use of Crop Marks or Trim Marks 

When a document is prepared for printing, a number of marks are needed to help the 

printer to perform a number of jobs to be executed before printing. For example the 

marks to determine where to trim the paper after printing. Selecting any page-mark 

option expands the page boundaries to accommodate printer’s marks, bleed (the parts 

of text or objects that extend past the page boundary to account for slight inaccuracy 

when trimming).  

One of these marks is the crop marks. Crop marks which are also known as trim marks, 

are the lines printed in the corners of your publication’s sheet or design sheet to show 

the printer where to trim the paper after the printing process is complete. Crop marks or trim marks are used by 

commercial printers for creating bleeds where an image or color on the page needs to be extended all the way 

to the edge of the paper. 

 

Crop Marks or Trim Marks 

 

The reason why these marks are used is that printers generally can’t actually print to the very edge of the paper, 

so instead of printing on a larger sheet of paper and then trim it down to the correct size, and crop marks are 

used to define where to trim. So, to print crop marks, you must print on a paper size that is larger than the page 

size you have set for your publication. 

Crop marks are the 
lines printed on the 
corners of the print 
representing where 
the paper will be 
trimmed after 
printing. 

Crop Marks 
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Crop Marks, Bleed, Trim Area, Margin Marks 

 

2. Benefit of Using Crop Marks 

When to Apply Crop Marks?  

For example while creating a banner and printing it on desktop printer using letter-size 

or legal-size paper, publisher will print the banner across several sheets of paper that 

you need to cut and paste or tape together. Crop marks make this process much easier, 

if you want to create bleeds in your publication. Printing the crop marks makes it much 

easier for trimming the sheet back to create the bleed.  

Basically, whether there is a bleed or not, any piece that will be trimmed after printing 

needs Crop Marks. Crop Marks are generally added with the same software that was 

used to create the original design. When your printer receives the artwork, it is printed 

on the paper that is larger than the actual document size desired. Then, using the Crop 

Marks as a guide, printer trims the paper down to its final size. 

Crop Marks are extremely important to ensure the project is trimmed in the proper place and to the proper size. 

As a commercial printer, we see a lot of artwork submitted with the crop marks omitted and/or bleeds improperly 

set up, which unfortunately delays the printing process. 

3. Using Trim Marks to Set the Final Intended Size of the Document or Design 

Trim marks can also be defined as the sets of two right angle dashes in the four corners of image which allows 

the printer to cut stacks of the finished job accurately, trimming away anything not desired on the finished print 

but which was useful while going through the print process, including the printer's marks. This also includes 

bleeds. 

As the trim marks define where the document will be trimmed after printing, the actual size of the document 

before trimming should be kept larger. So the trim marks also shows how large will the page or document look in 

the final stage. 

While using crop 
marks, the paper 
size used for printing 
should be larger 
than the intended 
page size so that 
after trimming the 
page size does not 
get shorter. 

Remember 
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Crop Marks, Bleed and final size of the page 
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Learning Unit 3: Apply USP Guidance  

Overview 

This unit describes the concepts of Unique Selling Point guidance. After the completion of this learning unit, you 

will learn the relation of printing plates, document size, rulers and the process of changing ruler settings and 

document size or paper size for USP. 

 

1. Understand the Use of Rulers 

Rulers 

Rulers are widely used in graphic software to position images or elements precisely in 

an artwork or design. When you make the rulers visible, they appear along the top and 

left side of the active window. When you move the rulers, the markers show its location. 

You can change the origin of rulers to measure from a specific point in the image. 

You can show rulers in Adobe Photoshop as 

1- Open your image in Adobe Photoshop. 

 

2- Click at View->Rulers. 

Change Ruler’s 0 Origin in Adobe Photoshop 

The ruler is a 
measurement tool 
found with some 
software programs 
that allow the 
program's user to 
align graphics, text, 
tables, or other 
elements on a page. 

Ruler 
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1- Position the mouse on the intersection of horizontal and vertical rulers on the top left corner. 

2- Drag diagonally to the image, a set of cross hairs appears, marking the new origin on the rulers. 

 

3- To reset the origin of the ruler, double click the upper left corner of the ruler. 

Change ruler’s unit of measurement in Adobe Photoshop 

1- Open the image in Adobe Photoshop 

2- Show the rulers 

3- Double click at one of the rulers, preferences dialogue box will appear 

 

4- Change the unit and click OK. 

 

2. Define Document Size and Paper Size for USP 

As one of the main purpose of design is to convey the Unique Selling Point effectively, the design aspects should 

also be planned according to USP guidelines. One of the aspects that matters is the document size or paper size 

for the design containing USP. The document size should not be too large so that it makes design element too 

far away from each other leaving white space between them and in effect, breaking their connectivity. Document 

size should neither be too small that the design area becomes too congested or you would have to omit some 

important details in order to accommodate design elements in the available space. 

Document size used should be large enough to hold all the necessary details leaving any extra detail. It should 

be able to convey Unique Selling Point to the target audience effectively. Document size or paper size should be 

cost effective and be appealing at the same time. Whatever paper size you use, make your design something 

that your customers will want to pick up or want to read and comprehend. 

Another factor that affects the paper size is that the size of the artwork determines the size of the press. The size 

of the press determines the length of the run. Presses only earn money when they run. 
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Learning Unit 4: Prepare and Publish Artwork 

Overview 

This unit describes the concepts and practices involved in preparing the artwork for publishing. After the 

completion of this unit, you will be able to demonstrate the storing of artwork on CD or DVD. Also you will learn 

the guidelines for the submission of artwork and the formats that can be used for preparing artwork for publishing. 

1. Procedure of Storing Data on CD/DVD or Other Storage Devices 

 
 

After your artwork is complete, in order to submit the data for publishing, you need to store it on some storage 

device like CD/DVD or USB flash drive. 

Saving Artwork on CD/DVD 

You can save your data on CD/DVD as 

1- Place an empty disc into your CD/DVD writable drive tray, face up 

Before send your 
artwork for 
publishing, always 
save a backup of 
your work at your 
place. 

Remember 
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2- Go to computer and double click at CD/DVD drive or wait for the dialogue box that appears automatically 

after inserting CD/DVD 

3- In the Disc Name field, type a name for the disc and click at Next 

4- Your disc will be formatted for burning. When finished formatting, an empty disc folder will open 

5- Drag or copy the desired files into the empty disc folder. The files are copied as you drag them 

 

 

6- Click at close session that will make the CD/DVD ready for use on other computers. 

You can save your data on the USB flash drive as: 

1- Insert USB flash drive into the port at your computer 
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2- Right click at the file to be copied and click at Send to 

 

3- Click at your removable device from the list of devices and a copy of the file will be saved in the removable 

disk drive 

 

4- When finished, click on the icon with a small flash drive with a check mark in the system tray to eject your 

hardware 

You can also use 
some specific 
software for burning 
data at CD/DVD that 
will give you even 
more control over 
the burning speed. 

Do you know! 
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5- Remove the USB flash drive from the USB port 

 

2. Submission Guidelines for Artwork 

When preparing your files for printing be sure to check your files for color, fonts and file resolution. There are a 

few more things to be checked before sending them for print. 

1. Provide crop marks. 

2. Allow for bleeds; 1/8 inch beyond the borders. 

3. Provide all fonts or convert fonts to outlines. 

4. Make all colors Spot or CMYK (each color equals a plate). 

5. Supply all linked files (scans, photos, and artwork). 

6. Provide a High Resolution PDF or hard copy proof. 

7. Make sure the size is correct. 

8. Eliminate all unnecessary files. 

9. Give your contact information: (e-mail, phone, fax, and contact name). So that they can contact you if 

there is a need. 

10. Tell them what kind of a proof you want (pdf or printed) 
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11. Spell check all files 

12. Check the quality of the pictures included in your document or design, a 72 dpi file resaved to 300 dpi 

will still print badly. It needs to be created at 300 dpi to start with. 

13. Before submitting your files please check to be sure it folds correctly and holes/die cuts do not interfere 

with artwork. 

3. Formats Used for Preparing Artwork for Publishing 

It is recommended that electronic artwork files be submitted in one of our following preferred formats for 

publishing. 

TIFF (Tagged Image File Format)  

This format breaks an image down into pixels. The more pixels there are the sharper 

the final image will be. This is what is meant by higher resolution. This is the most 

widely supported format across Windows and Mac platforms. This format is 

recommended for photographic images. 

 

 

PS and EPS (PostScript and Encapsulated PostScript) 

These formats are generally resolution independent. This means there are virtually no limits to scaling for line art 

as long as the line weights are not defined as "hairline". They can also contain TIFF images. These should be 

high resolution (as above). All fonts should be embedded. Minimum line weight is 0.3pt for black lines on a white 

background. This format is recommended for line art and combinations of photographs and labeling. 

 

PDF 

This format is very similar to EPS. Before saving an image as a PDF it is important to make sure that the fonts 

are embedded and that the original images are at the correct size and resolution. To check this visually you can 

zoom in on the PDF. As PDF is a non-editable format, you may need to provide an editable version if any changes 

are required. 

 

JPEG 

JPEG is a good format for images intended only for online publication. It is a compressed format which means it 

discards some color information. This may not be noticeable on a monitor but is more apparent in print, although 

it is still adequate for print in most cases. 

 

GIF 

GIF is a format that can be used for images containing few colors. This is a format that should only be used for 

images intended for online publication. 

 

A file format is a 
standard way that 
information is 
encoded for storage 
in a computer file. 

Format 
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Summary of Module 

  Bleeds are images that extend beyond the live area of the page (and beyond the trim marks) to 

guarantee clean edges. 

  Margins are the guides in your document around the text or artwork that make and support the 

structure of the document. 

  The gutter margin refers to the additional margin added to a page layout to compensate for the part 

of the paper made useless by the binding process. 

  Slug is normally used to identify a document. It is used to write notes to the printer and/or other 

people working on the document. 

  Crop marks are the lines printed on the corners of the print representing where the paper will be 

trimmed after printing. 

  The ruler is a measurement tool found with some software programs that allow the program's user to 

align graphics, text, tables, or other elements on a page. 

  After your artwork is complete, in order to submit the data for publishing, you need to store it on some 

storage device like CD/DVD or USB flash drive. 

  You can send your artwork for publishing in TIFF, EPS, PDF, JPEG, GIF etc. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What will happen if we don’t use Bleeds? 

Answer If you don’t use Bleed, there will be a risk of leaving a white space edge after printing. 

FAQ 2:  What will happen if Bleed is always applied on all four sides? 

Answer If in your image you have a solid color background, you will have to apply bleed on all the 

four sides. If there is just some artwork in your image that touches just one side then you 

will have the bleed just that one side. 

FAQ 3:  What is Margin? 

Answer Margins cage the content and support the structure of a layout. 

FAQ 4:  What is Gutter setting? 

Answer The gutter margin refers to the additional margin added to a page layout to compensate for 

the part of the paper made useless by the binding process. 

FAQ 5:  What is Slug? 

Answer Slug is an area outside the margin and bleed that contains printing Information, customized 

color bar information, or displays other instructions. 

FAQ 6: Why are crop marks helpful? 

Answer: Crop marks are helpful because they help printer know where the page will be trimmed after 

printing. 

FAQ 7: What is the purpose of using ruler? 

Answer: Rulers help in graphic software to position text and images at precise location. 

FAQ 8: What is EPS file format? 

Answer: These formats are generally resolution independent. This means there are virtually no limits 

to scaling for line art as long as the line weights are not defined as "hairline". 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  Bleed is used for _____________. 

a.  High Quality Printing b.  Clean Edges after print 

c.  Posters Printing d.  Tough Printing 

2.  Best time to apply Bleed is __________. 

a.  At the time of printing b.  During Image editing 

c.  At the start d.  No Limitation 

3.  While Printing book, Gutter of both pages is  at __________. 

a.  Top Side b.  Bottom Side 

c.  Inner Side d.  Outer Side 

4.  Slug area _______________. 

a. Arrange the document b. Contain margin Information 

c. Supports structure d. Contains notes for printer 

5.  Arrangement of bleed, slug and margin is __________. 

a. Bleed, Margin, Slug b. Slug, Bleed, Margin 

c. Margin, Slug, Bleed d. Slug, Margin Bleed 

6.  Crop marks are used by commercial printer for creating __________. 

a. Bleed b. Slug 

c. Margin d. Slug and Margin  

7.  The origin of the ruler is changed to __________. 

a. Resize design elements b. Measure from a specific point 

c. 
Move design elements from one point to 
other 

d. Resize document 

8.  Which of the following is not a recommended format for artwork  __________. 

a. TIFF b. JPEG 

c. Zipped d. PDF 
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Answer Key 
MCQ Number Correct Answer 

1 b 

2 c 

3 c 

4 b 

5 a 

6 a 

7 b 

8 c 
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Module 6: Perform Software and Hardware 
Maintenance 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Install relevant graphics software 

  Uninstall relevant graphics software 

  Install relevant Operating System 

  Install and configure required driver 

  Install and configure input/output devices 

  Connect various devices using appropriate ports and cables  
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 Module 6: Perform Software and Hardware Maintenance 

Teaching and Learning Material: Information Technology (Computer Graphics – Print)                                                         | 199 

 Learning Unit 1: Install Graphics Software  

Overview 

In this leaning unit, you will learn the installation steps for various graphic software. After the completion of this 

learning unit, you will be able to demonstrate and practice the installation of Adobe Photoshop, Corel Draw, 

Adobe Illustrator and Adobe InDesign. Also you will be able to configure these software and get familiar with the 

work environment.  

1. Procedure of Installation of Graphic Software 

System Configuration Required for Adobe Photoshop CS 6 

Following system configurations are recommended for Adobe Photoshop 

 Intel® Core 2 or AMD Athlon® 64 processor; 2 GHz or faster processor 

 

 Microsoft Windows 7 with Service Pack 1, Windows 8.1, or Windows 10 

 

 2 GB of RAM (8 GB recommended) 

 

 2 GB of available hard-disk space for 32-bit installation; 2.1 GB of available hard-disk space for 64-bit 

installation; additional free space required during installation (cannot install on removable flash storage 

devices) 

 

 1024x768 display (1280x800 recommended) with 16-bit color and 512 MB of VRAM (1 GB 

recommended)* 

 

 Internet connection and registration are necessary for required software activation, validation of 

subscriptions, and access to online services. 

 

Installation of Adobe Photoshop CS 6 

1- Insert the Adobe Photoshop CD and open the folder containing the file. 

 

Adobe Photoshop is 
a raster graphics 
editor developed 
and published by 
Adobe Systems for 
Windows and OS X. 

Adobe Photoshop 
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2- Right click at setup and then click at Run as administrator.  

 

3- Wait for the initializing of files. 

 

4- We have 3 options: Install with serial number, start my subscription, install a trial. You can install a trial 

to use 30 days free. After that you can buy license and add key to active product. If you have a key, you 

should choose Install with serial number. 

 

5- After choosing option setup, you will see a new window. You have to accept the adobe license 

agreement. 

Installer of software 
is a software 
component which is 
responsible for the 
installation, 
maintenance and 
removal of software. 

Do you know! 
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6- Select the Language. 

 

7- Wait for several minutes for the installation.  

 

8- Click at close after installation is complete. 
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9- To open Adobe Photoshop, click the Start menu button, point to All Programs (or Programs), and click 

Adobe Photoshop. 

Adobe Photoshop Work Environment 

 

1- Tool Box 

Tool box contains the tools that we use for our activity in Photoshop, we can see tools like brush, move 

tool, rectangular marquee, quick selection tools, magic erase tools and others. 

 

2- Menu Bar  

Menu bar contains the different menus like you can see file, edit, image, and other menus. 

 

3- Option Bar 

The options in the option bar change when you select a tool from the tool box. It contains the options and 

settings for the selected tool. 

 

4- Palettes 

Palettes show you the information about a particular part of your image and helps you to modify that part. 

 

5- Image Window 

Image window contains your actual image. You can create and make changes to your image in this 

window. 
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System Configuration Required by CorelDraw X6  

 Microsoft Windows 8/8.1 (32-bit or 64-bit editions), Windows 7 (32-bit or 64-bit editions), all with latest 

service packs installed. 

 Intel Core 2 Duo or AMD Athlon 64. 

 2 GB RAM. 

 1 GB hard disk space (for installation without content). 

 Mouse, tablet or multi-touch screen. 

 1280 x 768 screen resolution. 

 DVD drive (required for box installation). 

 Microsoft Internet Explorer 8 or higher. 

 Internet connection required for Membership and Subscription services, installing updates and access 

to some features, including the Content Exchange, QR code tools and Concept Share. 

 

Installation of CorelDraw X6 

1- Insert the installation disc in your DVD drive. 

2- The AutoPlay window should prompt you on what action to perform. 

 

 

3- Open the folder and double click at Setup file. 
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4- Setup will initialize the installation.  

 

5- Accept the license terms and click at Next. 

 

6- Enter the user name and enter the serial key. 

CorelDraw is a 
vector graphics 
editor developed 
and marketed by 
Corel Corporation of 
Ottawa, Canada. 

CorelDraw  
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7- Click at Typical Installation.  

 

8- Wait for the installation to complete.  

 

Custom installation 
allows you to 
choose among the 
components of 
installation you want 
to install. 

Remember 
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9- Click at Finish after the installation is complete.  

 

10- To open CorelDraw, click the Start menu button, point to All Programs (or Programs), and click 

CorelDraw X6. 

 

Introduction to CorelDraw 

CorelDraw is a vector based drawing program or software that makes it easy to develop professional artwork 

from simple logos to complex technical illustrations. 

Drawings in Corel Draw are vector based because objects drawn are defined mathematically as a series of points 

(dots) joined by lines. Graphical elements in a vector file called objects. Each object is a self-contained entity, 

with properties such as color, shape, outline, size and position on the screen included in its definition. 

CorelDraw Interface 

 

1- Title Bar  

It shows you title (name of document if saved) otherwise it will automatically title as "Graphic1". 

Drawings in Corel 
Draw are vector 
based because 
objects drawn are 
defined 
mathematically as a 
series of points 
joined by lines. 
Graphical elements 
in a vector file called 
objects. 

Do you know! 
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2- Menus 

Menus contain pull-down options. 

3- Standard Toolbar 

Contains shortcut to menus and other commands. 

4- Property bar 

A context sensitive toolbar that shows commands relating the active tool or object. 

5- Toolbox  

Contains tools for creating, filling and modifying objects in a drawing. 

6- Rulers 

Horizontal and vertical borders that are used to determine the size and position of objects in a drawing. 

7- Document Navigator 

Contains controls for moving between and adding pages. 

8- Color Palettes 

Contains color swatches. 

9- Status bar 

Contains information about object properties such as type, size, color, fill and resolution. It also shows 

the current mouse position. 

10- Docker 

Contains available commands and settings relating to a specific tool, effect or task. 

11- Navigator Button 

Open a smaller display to help pan around a drawing page. 

12- Drawing Page 

The printable area of the workspace. 

13- Drawing Window 

The area outside the drawing window bordered by the scroll bar. 
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System Configuration Required by Adobe Illustrator CS 6  

 Intel Pentium 4 or AMD Athlon 64 processor 

 Microsoft Windows 7 with Service Pack 1, Windows 8, or Windows 8.1 

 1 GB of RAM (3 GB recommended) for 32 bit; 2 GB of RAM (8 GB recommended) for 64 bit 

 2 GB of available hard-disk space for installation; additional free space required during installation 

(cannot install on removable flash storage devices) 

 1024 x 768 display (1280 x 800 recommended) 

 To view Illustrator in HiDPI mode, your monitor must support a resolution of 1920 x 1080 or more.  

 To use the new Touch workspace in Illustrator, you must have a touch screen enabled tablet/monitor 

running Windows 8.1. (Microsoft Surface Pro 3 recommended). 

 Optional: To use GPU Performance: 1 GB of VRAM (2 GB recommended); and latest drivers for 

optimal performance 

 

Installation of Adobe Illustrator CS6  

1- Insert Adobe Illustrator CD/DVD. 

2- Open the CD/DVD drive Adobe folder and find the setup file. 

3- Double click the setup file and click at Run if prompted. 

 

4- In the Welcome window click Install 
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5- Read the adobe license agreement and click Accept. 

 

6- Enter the serial number and click Next. 

 

7- Click at Sign in Later in the Sign in Box.  
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8- Click at Install in options window. 

 

9- Click at close when the installation is complete. 

 

10- To open Adobe Illustrator, click the Start menu button, point to All Programs (or Programs), and click 

Adobe Illustrator. 

 

 

Click at Sign in now 
if you have some 
Adobe ID otherwise 
click at Sign in later 

Remember 
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Adobe Illustrator Work Environment 

 

1- Toolbox 

Toolbox contains different tool to be applied at the image like brush, move tool, pen, quick selection tools, 

magic erase tools and others. 

2- Menu Bar  

Menu bar contains the different menus like you can see file, edit, image, and other menus. 

3- Control Palette 

Control palette controls the performance of a tool selected from the toolbox. 

4- Palettes 

Palettes in Illustrator tell you what is going on with specific parts of artwork you have created and help 

you to make changes to that artwork.  

5- Art Board 

Art board is your work space in Adobe illustrator, it contains your image or the illustration you can work 

upon. 

6- Status bar 

Status bar shows information and statistics about your document for example 

saving status, pages etc. 

 

System Configuration Required by Adobe InDesign CS6 

 Intel Pentium 4 or AMD Athlon 64 processor 

 Microsoft Windows 7 with Service Pack 1, Windows 8, or Windows 8.1 

 2 GB of RAM (8 GB recommended) 

Floating palettes are 
small windows that 
"float" above an 
application's 
windows. Usually 
they contain buttons 
and tools for 
executing commonly 
used functions or 
changing editing 
modes. 

Do you know! 

Adobe Indesign is a 
desktop publishing 
software that can be 
used to create works 
such as posters, 
flyers, brochures, 
magazines, 
newspapers, and 
books. 

Adobe InDesign 
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 2.6 GB of available hard-disk space for installation; additional free space required during installation 

(cannot install on removable flash storage devices) 

 1024 x 768 display (1280 x 800 recommended) with 32-bit video card; supports HiDPI display 

 Adobe® Flash® Player 10 software required to export SWF files 

 Internet connection and registration are necessary for required software activation, validation of 

subscriptions, and access to online services. 

 

Installation of Adobe InDesign CS6 

1- Insert Adobe InDesign CD/DVD. 

2- Open the folder containing the installation files and double click at setup.exe.  

3- Click at Run if some security warning arises. 

 

4- At the welcome screen, click at Install. 
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5- In the Adobe InDesign License Agreement window, click at Accept.  

 

6- In the serial number window, enter the serial number. 

 

7- In the sign in window, click at Sign in Later and if you already have email address and password, click at 

Sign in Now. 
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8- In the options window, select the components to be installed, select the language and click at Install. 

 

9- If you get a prompt for User Account Control, Click at Yes. 

 

10- Wait for the installation to complete and after the installation is complete, click at Close. 

 

11- To open Adobe InDesign, click the Start menu button, point to All Programs (or Programs), and click 

Adobe InDesign CS6. 
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Adobe InDesign Work Environment 

 

 Menu Bar  

You can access any of the menu list options by clicking any of the word headings in the menu bar for 

example file, edit, layout etc. 

 

 Application Bar 

View options, zoom percentage, screen mode, and arrange options are all available from the Application 

Bar drop-down lists. 

 

 Control Panel  

Options for the tool you currently have selected in the Tools panel always appear here. 

 

 Tools Panel 

You can access any of the InDesign tools by clicking one of the icons shown in the Tools panel. 

 

 Panels 

Panels can be accessed from the window menu in the menu bar. When you click at some panel it appears 

in the docked on the right side of your screen. 

 

 Welcome Screen 

This dialog box appears only when you first launch InDesign. It contains links for opening recent 

documents, creating new documents, and accessing the InDesign community via the Internet 
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Learning Unit 2: Install/ Uninstall Operating System 

Overview 

This unit describes the procedure of the installation and uninstallation of operating 

system. After the completion of this learning unit, you will be able to install operating 

system on the computer using DVD of operating system. And also you will come to 

know about the upgrade of operating system. 

1. Procedure of Installing Operating System 

Below are the installation steps for the installation of Window 8 

1. Insert the Window 8 DVD in the DVD ROM. 

2. Restart the computer. 

3. Press F12 or the key shown on the first screen on computer for boot menu.   

 

4. Select CD/DVD ROM option in the boot menu. 

 

Format will erase all 
the data on your 
partition. 

Remember 

Boot Menu allows 
you to choose from 
the list of booting 
devices like 
CD/DVD, USB, 
Ethernet etc. 

Boot Menu 

While installing 
using DVD, 
computer will ask 
you to press any key 
to boot from 
CD/DVD. Don’t 
press any key and 
let the computer 
start by itself. 

Remember 
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5. Wait for setup to initialize. 

 

6. Select language, time and currency format and keyboard layout. 

 

7. Click at Install  
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8. Enter the product key and click Next.  

 

9. Accept the license terms and click Next. 

 

10. Click at Custom Install for a clean installation.  

    

Custom installation 
allows you to 
perform clean 
installation where 
you overwrite the 
previous operating 
system. 

Remember 
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11.  Click at the desired partition.  

     

12. Click at drive options and format. 

 

13. Click at Ok and then click at yes 

      

You can choose 
other options like 
delete in the drive 
options to recreate 
partition 

Remember 
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14. Wait for the files to be copied.  

 

15. Click at restart Now.  

 

16. Wait for the devices to get ready. 

 

17. After restart, personalize window will appear. Select a color, enter a PC name and click at Next. 
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18. Click at Use Express Settings button. 

 

19. Enter your Hotmail ID and click at Sign in.  

 

20. Wait for a few minutes to get the PC ready. 

Click at Sign in 
without a Microsoft 
account if you don’t 
have a Hotmail ID. 
And enter a local 
username and 
password for your 
PC. 

Remember 
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21. After completing installation your PC will look like. 

 

2. Procedure of Un-installing Operating System 

You may want to uninstall an operating system when you have a dual boot on the hard 

drive or when you want to remove the only operating system on the hard drive and 

reuse it in future.  

Uninstalling an operating system is very simple. 

1- Insert the window CD/DVD. 

2- Boot from the CD/DVD as shown above. 

3- Carry out the steps 5 to 10 as described in the above procedure. 

4- When it shows the list of partitions to select the desired partition for window installation, click at the 

partition that contains the operating system you want to uninstall. 

5- Click at drive options.  

Dual boot means 
having different 
operating systems 
installed on different 
partitions on the 
hard drive 

Dual Boot 
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6- Click at format and then click at yes when the warning comes up. 

 

7- Close the setup and now you can reuse your partition for any other operating system. 

3. Upgrade and Configuration of Operating Systems 

One of the most common methods to move from one version of Windows to another is 

by doing an upgrade. The major advantage of doing an in-place upgrade is that you 

don't have to reformat your hard drive. The new operating system will simply replace 

your previous installation, and you'll be able to keep all of your files and programs. This 

process takes the least amount of time. Also, you're not prompted to enter a product 

key, at least for those users upgrading from previous version of windows.  

Upgrading from window 7 to window 8 

1- Insert the installation disc. 

2- Boot from window 8 DVD as described in above method. 

3- Repeat the steps 1 to 9 just as described above. 

4- When it asks for upgrade or custom install, click at upgrade. 

Upgrade Assistant is 
a free download that 
scans your PC, 
desktop apps, and 
connected devices 
to see if they'll work 
with a later version 
of Windows, and 
then provides a free 
compatibility report 

Do you know! 

You will have to 
install another 
operating system to 
use that computer. 

Remember 
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5- Now it will check for the compatibility of the programs and devices and ask you what to keep. Select your 

option. 

 

6- Click at Install. When you click Install, Windows 8 begins installing itself, restarting your PC several times 

during the process. 

7- Now repeat the steps from 17 to 20 in the above method (installation of operating system) until you get 

upgraded operating system. 

 

All the compatible programs and personal files will remain intact in the upgrade process. 
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Learning Unit 3: Install/ Configure Drivers, Input/ Output 
Devices 

Overview 

In this leaning unit, you will learn about device drivers, installation and configuration of device drivers and input 

output devices. After the completion of this learning unit, you will be able to demonstrate and practice the 

installation and configuration of device drivers. Also, you will understand plug n play devices.  

1. Explain Installation and Configuration of Drivers 

To install hardware devices on Windows, you must install the appropriate device drivers first. Here are some 

guidelines for installing and configuring device drivers. 

Installation of Device Drivers 

You can install device drivers in four ways. 

1- During the Windows Installation Setup 

Most of the Drivers are automatically installed for all detected devices during installation of Windows on 

your computer. 

 

2- Starting the Computer 

Whenever the computer is started, new devices are detected and their device drivers are automatically 

installed. 

 

3- Scanning for New Hardware 

 

a. Go to Control Panel. 

 

b. Click at Add a Device in the Control panel. 
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c. Let the computer search for the new devices through add device wizard and then click at the 

desired device and click at the desired device. 

d. As you click at Next, computer will automatically install the device driver.  

 

 

4- Manual Installation 

 

a. Insert the CD/DVD containing the device driver or USB flash drive or open folder containing 

driver setup. 

b. Double click at the Driver setup file and install the driver. 

Note: You must have administrative permissions on the computer to install device drivers 

Configuring devices using Device Manager 

Device Manager displays information about all devices installed on your server. It displays a list of devices that 

were either detected or for which drivers are installed. The icon for the device indicates whether the device is 

working properly or not. 

Normal icon indicates that the device driver has initialized successfully while an Exclamation point  on icon 

would mean that device is incorrectly configured and a Stop sign  on icon means that device could not be 

initialized due to hardware conflicts. 
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To resolve hardware conflicts and to override the resources or the device driver that were assigned to a device, 

follow these steps: 

1- Start Device manager by typing 'Devmgmt.msc' in the Run dialog box. 

 

 

2- Right-click the desired device and select Properties. 

 

3- Click the Resources tab on the Properties dialog box. 
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4- Click the resource to be changed and then clear the "Use automatic settings" checkbox. 

 

5- Click Change Setting and then change the value of the setting to the desired value. 

Updating and Removing Device Drivers in Device Manager 

You often have to update the existing device drivers or remove them from your computer.  

To update a device driver: 

1- Start Device Manager by typing 'Devmgmt.msc' in the Run dialog box. 

2- Right-click the desired device and select Properties. 

3- Click the 'Driver' tab and then click the Update Driver button.  

 

If your driver update 
fails, you can roll 
back your driver to 
discard to the 
changes made. 

Remember 



 Module 6: Perform Software and Hardware Maintenance 

Teaching and Learning Material: Information Technology (Computer Graphics – Print)                                                         | 229 

To Remove a Device 

1- Start Device Manager by typing 'Devmgmt.msc' in the Run dialog box. 

2- Right-click the desired device and select Properties. 

3- Click the 'Driver' tab and then click Uninstall button. 

 

2. Explain Installation and Configuration of Input / Output Devices 

It is necessary to be able to implement, manage and troubleshoot I/O devices such as 

printers, cameras, scanners, multimedia devices, mouse, keyboard and smart card 

reader and install, configure and manage modems, handheld devices and network 

adapters.  

Installation of Input Devices 

Input devices like keyboard, mouse are automatically installed when you connect these 

devices to your computer.  

Installing a Scanner 

Most scanners today connect to your computer with a universal serial bus (USB) cable. But don't plug it in yet! 

Some scanners require you to install driver software before connecting the USB cable, so always follow the setup 

instructions that came with your device. 

If your USB scanner didn't come with specific setup instructions, plug it in to your computer and Windows should 

automatically install it. If it's an older model, you might have to install it manually as 

1- Connect the scanner to power supply and the computer 

2- Insert the CD/DVD containing the scanner driver that comes from manufacturer. Or open download the 

driver from manufacturer website and open the folder. 

3- Double click at the setup file. 

4- Follow the instruction while installing. 

Input devices are 
the devices that you 
use to feed 
information to the 
computer system. 
For example, 
Keyboard, Mouse 

Input Devices 
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5- Now you will be able to use the scanner. 

Installation of Output Devices 

Output devices like monitor, speakers etc. are automatically detected and installed by 

the operating system. If your output device is not automatically detected you need to 

install that manually. 

Installing Printer 

The most common way to install a printer is to connect it directly to your computer. This 

is known as a local printer. If your printer is a universal serial bus (USB) model, 

Windows should automatically detect it and begin installation when you plug it in. 

If it's an older model that connects using the serial or parallel port, you might have to install it manually as 

1- Connect the printer to power supply and computer 

2- Open control panel from start menu. 

3- Click at devices and printer in the control panel. 

 

4- Click Add a printer. 

 

5- In the Add Printer wizard, click Add a local printer.  

Output devices are 
components that 
retrieve information 
from the computer. 
For example, 
Monitor, Printer etc. 

Output Devices 



 Module 6: Perform Software and Hardware Maintenance 

Teaching and Learning Material: Information Technology (Computer Graphics – Print)                                                         | 231 

 

6- On the Choose a printer port page, make sure that the Use an existing port button and the 

recommended printer port are selected, and then click Next. 

 

7- On the Install the printer driver page, select the printer manufacturer and model, and then click Next.  

 

8- If your printer isn't listed, click Windows Update, and then wait while Windows checks for additional 

drivers. 

9- If none are available and you have the installation CD, click Have Disk, and then browse to the folder 

where the printer driver is located.  

10- Complete the additional steps in the wizard, and then click Finish. 

You can get the 
device driver either 
in the CD/DVD 
came from 
manufacturer, 
download from 
manufacturer 
website. 

Remember 
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Configuration of Input/output Devices 

Input/ Output Devices can be Configured in the Device Manager as. 

1- Start Device manager by typing 'Devmgmt.msc' in the Run dialog box. 

 

2- Right-click the desired device and select Properties. 

 

3- Click the Resources tab on the Properties 
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Learning Unit 4: Connect Devices to Ports Using 
Appropriate Cables 

Overview 

In this leaning unit, you will be introduced to various types of ports and cables used to connect 

different devices to the computer. After the completion of this unit, you will come to know about 

different types of connectors, differentiate between cables and port which connect the devices 

to the computer.   

1. Understand the Different Types of Connectors 

Connectors generally have a male end with pins projecting from it. This plug is inserted 

into a female part also called a socket, which includes holes for accommodating the 

pins. However, there are "hermaphroditic" plugs which can act as either male or female 

plugs, and can be inserted into either one.  

Monitor Connectors 

15 pins in three rows, pins are skinnier than a 

usual "DB" connector, thus it's got an "H" for High 

Density. Used for PC's SVGA video cards and 

monitor cables.  

 

 

15 pins in two rows, pins are just like a DB9 or 

DB25. Used for Mac monitors. 

 

 

9 pins in two rows, used on older monitors, and 

VGA's. PS/2 style Serial ports also use DB9 

connectors. 

 

 

 

 

 

DB15 

HD15 

DB9 

Installation of a 
computer program 
(including device 
drivers and 
software), is the act 
of making the 
program ready for 
execution. 

Installation 

Connectors, 
normally called 
"input-output 
connectors are 
interfaces for 
connecting devices 
by using cables. 

Connectors 

A device driver is a 
program that 
controls a particular 
type of device that is 
attached to your 
computer. 

Device Driver 
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Parallel/Printer Connectors 

This is the connector used by most printer cables. 

 

 

This is used for parallel printers (and other parallel port devices) as well as 

SCSI and serial ports. If you see a male on the back of your computer, it 

is usually your COM2 serial port. 

 

 

Firewire Connectors 

 

This is basically a 4-pin Firewire/i.link/ connector.  

 

This is a 6-pin Firewire/IEEE-1394 connector. 

 

 

 

USB Connectors 

USB type "A" connector connects to computer or USB Hub. 

 

 

 

USB type "B" connector connects to peripheral or to USB Hub. 

 

 

 

 

DB25 (male) 

USB type "A" connector 

CN36 (male) 

USB type "B" connector 
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Mini USB 2.0 connector used on many new USB digital cameras. 

 

 

 

 

Audio/Video Connectors 

S-Video connector, sometimes called S-VHS or Y/C video. There're 4 little pins in there, it's called 

a DIN4.  

 

RCA (above) connector. Standard stereo connector.  

 

Fiber Optics Connectors 

SC connector, fiber optic network connector.  

 

 

ST connector, fiber optic network connector. 

 

 

MTRJ fiber optic network connector  

2. Differentiate Between Different Types of Cables  

It is important for you to know about the different kind of cables used in computer in 

order to make right decisions when choosing a cable for your computer. 

Following is the list of most commonly used computer cables. 

 

VGA (Video Graphics Array) 

VGA connection cable was the standard cable used to connect a 

computer to a monitor. VGA cable has 15 pins arranged in 3 row having 

5 pins each. Each row represents one of three basic colors used in 

display: red. Blue, green. 

 

Mini USB 2.0 connector 

VGA Cable 
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DVI ( Digital Visual Interface) 

The DVI connections have replaced VGA as technology moved away 

from analog towards digital. Digital displays, like LCD, proved to be 

higher quality, which soon became the market standard for home 

pictures. 

 

HDMI (High Definition Multimedia Interface) 

Unlike VGA and DVI, HDMI sends both video and audio signals 

together. The signals are digital only thus, HDMI is only compatible with 

newer devices. 

 

 

Universal Serial Bus 

USB cable is most commonly used cable today.  

there are multiple versions of USB available: 

1. USB 1.0/1.1 can transmit data at speeds up to 12 Mbps. 

2. USB 2.0 can transmit data at speeds up to 480 Mbps and is compatible with 

older versions of USB. At the time of this article, USB 2.0 is the most common type 

found in the market. 

3. USB 3.0 can transmit data at speeds up to 4.8 Gbps. It is compatible with 

previous versions of USB. 

 

 

From left to right: micro USB, mini USB, type B standard USB, and type A standard USB (both female and 

male) 

 

DVI Cable 

HDMI Cable 

Nearly every form of 
computer peripheral 
devices like 
keyboards, mice, 
headsets, flash 
drives, wireless 
adapters, etc. can 
be connected to 
your computer 
through a USB port. 

Do you know! 
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IDE (Integrated Drive Electronics) 

IDE cables were used to connect storage devices to a 

motherboard. The connectors on an IDE cable have 40 pins; 

the smaller 2.5” drive variety uses a form-factor version of the 

IDE that has 44 pins. 

 

 

 

SATA (Serial Advanced Technology Attachment) 

Newer hard drives will likely use SATA ports over IDE ports. Compared 

to IDE, SATA provides higher data transfer speeds. A standard SATA 

cable can be identified by two connectors, each having 7 pins and an 

empty notch. It looks like a subtle L-shape. 

 

 

FireWire 

The purpose of FireWire is similar to that of USB: high speed data 

transfer for computer peripherals.  

 

 

 

Ethernet 

Ethernet cables are used to set up local area networks. In most 

cases, they’re used to connect routers to modems and computers. 

 

 

 

 

 

3. Explain Different Ports Used for Connection of Various Devices 

Port 

Port is computer is a physical docking point using which an external device can be connected to the computer. 

SATA Cable 

IDE Cable 

FireWire Cable 

Ethernet Cable 
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Characteristics of Port 

A port has the following characteristics: 

1. External devices are connected to a computer using cables and ports. 

2. Ports are slots on the motherboard into which a cable of external device is plugged in. 

3. Examples of external devices attached via ports are mouse, keyboard, monitor, microphone, speakers 

etc. 

Following are few important types of ports: 

 

Ports in Computer 

Serial Port 

 Used for external modems and older computer mouse 

 Two versions : 9 pin, 25 pin model 

 Data travels at 115 kilobits per second 

Parallel Port 

 Used for scanners and printers 

 Also called printer port 

 25 pin model 

PS/2 Port 

 Used for old computer keyboard and mouse 

 Also called mouse port 

 Most of the old computers provide two PS/2 port, each for mouse and keyboard 
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Universal Serial Bus (or USB) Port 

 It can connect all kinds of external USB devices such as external hard disk, printer, scanner, mouse, 

keyboard etc. 

 It was introduced in 1997. 

 Most of the computers provide two USB ports as minimum. 

 Data travels at 12 megabits per seconds 

 USB compliant devices can get power from a USB port 

VGA Port 

 Connects monitor to a computer's video card. 

 Have 15 holes. 

 Similar to serial port connector but serial port connector has pins, it has holes. 

Power Connector 

 Three-pronged plug 

 Connects to the computer's power cable that plugs into a power bar or wall socket 

Firewire Port 

 Transfers large amount of data at very fast speed. 

 Connects camcorders and video equipment to the computer 

 Data travels at 400 to 800 megabits per seconds 

 Invented by Apple 

 Three variants : 4-Pin FireWire 400 connector, 6-Pin FireWire 400 connector and 9-Pin FireWire 800 

connector 

Modem Port 

 Connects a PC's modem to the telephone network 

Ethernet Port 

 Connects to a network and high speed Internet. 

 Connect network cable to a computer. 

 This port resides on an Ethernet Card. 

 Data travels at 10 megabits to 1000 megabits per seconds depending upon the network bandwidth. 

Game Port 

 Connect a joystick to a PC 

 Now replaced by USB. 

Digital Video Interface, DVI port 

 Connects Flat panel LCD monitor to the computer's high end video graphic cards. 

 Very popular among video card manufacturers. 
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Sockets 

 Connect microphone, speakers to sound card of the computer. 

HDMI (High Definition Multimedia Interface) 

 Used to connect LED monitors and Multimedia projectors.  

 Transfer audio and video through single line (Cable).  

4. Define Plug and Play Devices 

The user does not have to manually install drivers for the plug n play device or even 

tell the computer that a new device has been added. Instead the computer 

automatically recognizes the device, loads new drivers for the hardware if needed, and 

begins to work with the newly connected device.  

For example, if you connect a Plug-and-Play mouse to the USB port on your computer, 

it will begin to work within a few seconds of being plugged in. A non-plug and play 

device would require you to go through several steps of installing drivers and setting 

up the device before it would work. 

Plug and Play usually refers to computer peripheral devices, such as keyboards and 

mice, but it can also be used to describe internal hardware. For example, a video card or hard drive may be a 

Plug and Play device, meaning the computer will recognize it as soon as it is installed. The only difference is that 

internal components usually require the computer to be turned off when they are installed, while external devices 

can typically be installed while the computer is running. 

 

  

The term Plug and 
Play is used to 
describe devices 
that start working 
with a computer 
system as soon as 
they are connected. 

Plug & Play 

Devices 
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Summary of Module 

  In order to have good system configuration for graphics software like Adobe Photoshop, Adobe 

Illustrator, Adobe InDesign and CorelDraw, you can extend RAM, use GPU (Graphics Processing 

Unit) performance using 1 GB of VRAM and higher resolution for monitor.  

  Palettes in Adobe Photoshop and Adobe illustrator, show you the information about a particular part 

of your image and helps you to modify that part. 

  Art board, Work space or image window is the space where you can create, edit and modify your 

image in graphic software. 

  CorelDraw is a vector based drawing program or software that makes it easy to develop professional 

artwork from simple logos to complex technical illustrations. 

  You can install operating system in the computer by using Bootable CD/DVD, Bootable USB Flash 

Drive or Ethernet. 

  You may want to uninstall an operating system when you have a dual boot on the hard drive or when 

you want to remove the only operating system on the hard drive and reuse it in future. 

  Upgrading your operating system is useful when you want keep your application software and 

personal files and upgrade only the operating system. 

  A device driver is a program that controls a particular type of device that is attached to your computer. 

Device drivers can be configured, updated and removed in device manager. 

  The term Plug and Play, sometimes abbreviated as PnP is used to describe devices that start working 

with a computer system as soon as they are connected. 

  Connectors, normally called "input-output connectors are interfaces for connecting devices by using 

cables. Port is computer is a physical docking point using which an external device can be connected 

to the computer. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is the processor requirement for most of the graphic software? 

Answer Intel® Core 2 or AMD Athlon® 64 processor; 2 GHz or faster processor 

FAQ 2:  What is Tool Box in graphic software? 

Answer 
Tool box contains the tools that we use for our activity in graphic software, we can see tools 
like brush, move tool, rectangular marquee, quick selection tools, magic erase tools and 
others. 

FAQ 3:  What is status bar? 

Answer 
Status bar shows information and statistics about your document for example saving status, 
pages etc. 

FAQ 4:  Why are drawings in CorelDraw called vector based? 

Answer 
Drawings in Corel Draw are vector based because objects drawn are defined 
mathematically as a series of points (dots) joined by lines. Graphical elements in a vector 
file called objects. 

FAQ 5:  What are useful skills for exact requirement gathering? 

Answer 
Involve the customer form start, clarify the doubts, confirm gathered material by playing 
them back, and create a prototype to confirm the requirements. 

FAQ 6:  What is dual boot? 

Answer Dual boot means having different operating systems installed on different partitions. 

FAQ 7:  What is operating system upgrade? 

Answer 
Upgrading means the new operating system will simply replace your previous installation, 
and you'll be able to keep all of your files and programs. 

FAQ 8:  What are Plug n Play devices? 

Answer 
These are the devices that start working with a computer system as soon as they are 
connected. The user does not have to manually install drivers for the device 

FAQ 9:  What are connectors? 

Answer 
Connectors, normally called "input-output connectors are interfaces for connecting devices 
by using cables. They generally have a male end with pins projecting from it. 

FAQ 10:  What is the use of DVI (Digital Visual Interface)? 

Answer 
The DVI connections have replaced VGA as technology moved away from analog towards 
digital. Digital displays, like LCD, proved to be higher quality, which soon became the 
market standard for home pictures 
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Test Yourself! 
 
Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 
 

1.  Select INCORRECT option. You can use installation media for window installation. 

a.  CD/DVD b.  VGA Cable 

c.  USB Drive d.  Ethernet 

2.  Option bar in Adobe Photoshop contains _____________. 

a.  Different Menus b.  Tools used for image creation 

c.  Options for a tool selected d.  Information about document 

3.  Status bar contains _________________. 

a.  
information and statistics about your 
document 

b.  Tools for editing the image 

c.  Options for a selected tool d.  
All the menu options 
 

4.  Operating system upgrade means _________________. 

a. Installing a new operating system b. Having more than one operating system 

c. 
Having new operating system keeping 
personal data 

d.  
Uninstalling operating system 
 

5.  Software which is used to make a device ready to use is called __________________. 

a. Device support b. Configuration 

c. Installer d.  Device driver 
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6.  Hermaphroditic plugs are______________________. 

a. That can be inserted into each other b. Male connectors 

c. Female Connectors d.  
Multi-purpose connector used for 
connections  

7.  VGA cable is used __________________. 

a. Computer Network b. Power Supply 

c. Connect Printers d.  To connect a computer to a monitor  

8.  HDMI cable sends _________________________. 

a. Audio Signal b. Video Signal 

c. Both Audio and Video Signal d.  
None of above 
 

9.  USB 3.0 can transmit data at the speed ____________. 

a. 4.8 Gbps b. 4 Gbps 

c. 3.8 Gbps d.  4.8 Mbps 

10.  FireWire cable is used for ________________. 

a. Firewall connections b. High speed data transfer 

c. Connect internet d.  Both a and b 
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Answer Key 
MCQ Number Correct Answer 

1 b 

2 c 

3 a 

4 c 

5 d 

6 a 

7 d 

8 c 

9 a 

10 b 
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Module 7: Communicating with Others 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Communicate with client, business owner and supervisor, and 

synthesize relevant information about all problems and 

understanding of their product/ service required. 

  Develop a strategy for using communication skills. 

  Interact with other professionals involved in design 

development through effective teamwork.  
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Learning Unit 1: Understanding the Concept of 
Perspective 

Overview 

In this learning unit, you will learn different concepts involved in communicating with clients, business owners 

and other stakeholders. After completion of this learning unit, you will be able to demonstrate effective dealings 

with clients, business owner or supervisor and synthesize relevant information about all problems and 

understanding of their product/ service required. 

 

1. Communication and Interpersonal Communication 

Communication 

The process of conveying your idea or thought to the audience in such a way; that is 

comprehensive is called communication. It can be one way process where information 

flows in one direction only for example lecture in the class, or a two way process of 

mutual understanding in which the participants share information, ideas, and new 

thoughts etc. with each other. Communication is the key element for a business. 

 

 
 

Illustration Showing Flow of Communication Process 

 

Interpersonal Communication 

Interpersonal communication is the communication we do every day to communicate 

and interact with other people, both individually and in groups.  People who have strong 

interpersonal skills are usually more successful in both their professional and personal 

lives. It also refers to maintain a professional level of understanding of the situations 

your subordinates may be experiencing, and to interact with people on a personal level.  

 

 

 

 

Message

Reciever

Feedback

Sender

A stakeholder is an 
individual or group 
who has an interest 
in the outcome of 
body of work. 

Remember 

Interpersonal 
communication 
refers to the 
communication we 
do in our daily life at 
personal levels. 

Interpersonal 

Communication 

It is the process of 
exchanging 
information or news 
etc. 

Communication 
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Importance of Communication 

Communication plays a vital role in everyday life whether it is personal or business. In the business world, good 

communication is important for the daily operation of the company, but can also affect sales and profitability. 

Without good business communication, there will be no mutual exchange of thoughts, ideas, news and the 

internal and external structure of a business can face numerous challenges that can ultimately lead to its demise. 

 

2. Skills Needed to Interact in a Social Environment 

These are the skills we use to communicate and interact with each other and in the social environment, both 

verbally and non-verbally, through gestures, body language and our personal appearance.  

 

Illustration Showing Skills Used for Interacting with Society 

 

Here is how you learn these skills to communicate with society. 

1. Listening 

In order for you to be a good communicator, you need to be a good listener first. Active listening means paying 

close attention to what the other person is saying, ask question to clarification, and rephrase what the person 

says to ensure understanding. Active listening helps you to better understand what the other person was saying 

thus help you to act appropriately. 

2. Non-verbal Communication 

Your body language, eye contact, hand gestures, and tone all convey a clear message. A relaxed and a friendly 

tone will make you appear approachable, and will encourage others to speak openly with you. Eye contact is also 

important; it tells the other person that you are focused on him and attentively listening to what he says. Also pay 

attention to other people's nonverbal signals. Sometimes these give a clear idea of what are they actually feeling. 

Communication 
Skills

Listening

Non-Verbal 
Communication

Clarity and 
Concision

Friendliness

Confidence

Empathy

Feedback

Right medium  
Selection

Socialism is a 
process in which 
human infants 
begins to learn the 
skills and attitudes 
which make them an 
active member of 
their society. This is 
the most effective 
learning process 
known. 

Do you know! 
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3. Clarity and Concision 

Try to convey your message in as few words as possible. Say what you want to say clearly and directly, whether 

you are talking to someone face to face, on the phone, or via email. If you ramble on, your listener will not be 

able to understand what you are trying to say. 

4. Friendliness 

By keeping a friendly tone while you talk, you can encourage the other people to talk to you openly and share 

their thoughts thus helping you to improve your communication. 

5. Confidence 

You should be confident in all of your interactions so that colleagues know that you believe in and will carry out 

what you are saying. It also makes your communication credible. 

6. Empathy 

Always respect other people’s point of view even when you disagree with an employer, co-worker, or employee.  

7. Feedback 

Being able to appropriately give and receive feedback is an important communication skill. Managers and 

supervisors should continuously look for ways to provide employees with constructive feedback, they can do that 

through email, phone calls, or weekly status updates.  

 

8. Picking the Right Medium 

Selection of a right medium to communicate is very important. Important conversations are appropriate to conduct 

as face to face communication. If you need to communicate with a busy person such as your boss, you can email 

him. You can use telephone for usual conversations. 

3. Gathering Requirements 

Gathering requirements is an essential part of any business provides offering a product 

or service to customers. A poor requirement gathering results in a situation that doesn’t 

meet customer’s requirements.  

In order to communicate attentively, you need to follow these rules. 

 Don't assume you know what the customer wants, always ask him about 

his requirement. 

 Get user involved from the start. 

 Define the scope of project and ensure customer is agreed. 

 Clarify if there is any doubt. 

 Create a document that describes all the requirements clearly, concisely and thoroughly as acquired 

from the client. Share that document with the customer.  

After finalizing the 
required documents, 
get it signed by the 
customer that will 
save you and your 
company from many 
troubles. 

Remember 
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 Confirm your gathered requirement from the customer by playing them back to him. 

 Don’t move ahead in the project until requirements are fully understood. 

 Create a prototype if necessary to confirm or refine the customers' requirements. 

4. Applying of Communication Skills to Facilitate Understanding of Stakeholders  

The department/organization comes into daily contact with external stakeholders. It is vital to use your 

communication skills to have stakeholders a better understandability and enable them to take decision as partner.  

The following rules should help you in understanding the difference and mutual benefits of yours and the 

stakeholders.  

 Significance: Deal with issues of significance to stakeholders and the agency. 

 Completeness: Understand the concerns, views, needs and expectations. 

 Responsiveness: Respond coherently and appropriately 

 Communication: open and effective communication means listening and talking. 

 Transparency: Clear and agreed information and feedback processes. 

 Collaboration: Work to seek mutually beneficial outcomes where feasible. 

 Inclusiveness: Recognize, understand and involve stakeholders in the process. 

 Integrity: Conduct engagement in a manner that develops mutual respect and trust. 

In that way stakeholders will develop a sense of trust in organization that will enable him to make decision as 

partner with you. 

5. Oral and Written Communication 

Communication can be done in two ways, these have been described below: 

1. Oral Communication 

Oral communication is the process of verbally transmitting information and ideas from 

one individual or group to another. Oral communication can be either Formal or 

Informal. Example of Formal oral communication include: 

 Presentations at business meetings  

 Classroom lectures 

 Commencement speech given at a graduation ceremony 

Examples of informal oral communication include: 

 Face-to-face conversations 

Oral communication 
is the process of 
expressing 
information or ideas 
by word of mouth. 

Oral 

Communication 
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 Telephone conversations 

 Discussions that take place at business meetings 

For an effective oral communication, you need to follow following rules: 

 Words should be selected and framed properly and are delivered in the right pitch and tone.  

 Clarity, and right perception on the other hand are mandatory features of an effective oral 

communication system. Sentences used in communication should be clear in meaning and easy to 

understand. 

 It is important to establish an eye contact and to modulate body language based on the message. For example, 

a strict order can be conveyed better when communicated with a formal and stern body language as opposed to 

a casual and Friendly one. 

Ask for acknowledgment after delivering your message in order to know what is actually perceived at the other 

side. 

2. Written Communication 

Any communication that involves written or documented material from sender to 

receiver is called written communication. For example, letters, memos, research 

papers, reports, etc. 

It is a very concrete form of documentary evidence and can also be used for future 

reference purposes. As the information is written, it can be easily distributed to many 

people thus making it a bulk communication method. As the information does not 

change from person to person, the accuracy of the information conveyed is same 

across the entire audience. 

For effective written communication you need to keep the  following rules in mind: 

 There must be completeness, clarity and correctness in your writing.  

 As there is no immediate feedback that can be received, it is important that written communication 

is detailed and accurate to ensure that the write message is communicated. 

 Also remember to keep the communication simple and without any errors.  

 Replace Negative Words with Neutral or Positive Words. For example replace “Your argument 

that…” with “in your email you mentioned that …” etc. 

Using an active voice will strengthen your writing. Sentences that are written in the active voice will flow better 

and are easier to understand. Long, complicated sentences will slow the reader down. 

 

6. Synthesis and Presentation of Information 

Once all the information is gathered from client, it is then arranged in such a way that it can be presented and 

process further. Following steps help to leads gathered information towards the final product specifications: 

A communication in 
which some written 
or documented text 
is exchanged 
between sender and 
receiver is called 
written 
communication. 

Written 

Communication 
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1. Verification of Information 

All the information gathered from customer is rephrased and rechecked by the customer if it matches his needs. 

All the confusions are made clear. Corrections are made in case of any tweaks. This verification is very important 

because any loose end in the requirement gathering can lead to a product that doesn’t match customer’s need. 

2. User Requirement Document 

After customer verifies all the requirements and makes corrections where necessary, the gathered information is 

documented into user requirement document (URD) which is meant to spell out exactly what specification the 

product will have and becomes part of the contractual agreement. A customer cannot demand features not in the 

URD, while the developer cannot claim the product is ready if it does not meet an item of the URD. 

3. Setting Goals and Objectives 

From user requirement document, the objectives/goals are defined. Goals are the aims 

that need to be achieved for the completion of your project. The objectives defined 

should be clear and contain all the necessary details for what needs to be done within 

the available time and resources. 

 

A goal should be SMART:  

 Specific 

 Measureable 

 Achievable 

 Relevant 

 Time bound 

 

4. Feasibility Study 

After defining goals and objectives, feasibility study of objectives is done to know if 

objectives have ability to compete successfully taking into account, legal, economic, 

technological, scheduling and other factors. 

5. Final Product or Service 

As all the objective/ goals are finalized along with the details about resources used to 

complete the objectives and the time frame available to get it done. You will now be 

able to present the specification and final outcome of the product or services. This 

product will meet the customer requirements in all aspects.  

 

  

A specific result that 
a person or system 
aims to achieve 
within a time frame 
and with available 
resources.  

Goals/Objectives 

Sometimes people 
set a range of 
values as successful 
performance instead 
of a specific target. 
This is a wrong 
approach. An object 
should always be an 
exact and discrete 
target. 

Remember 

Feasibility study is 
an analysis of the 
viability of an idea. 

Feasibility Study 
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Learner’s Activities 

Understanding the Concept of Communication 

Description:  This activity consists of an interactive session in the class about the importance of 

communication and encouraging the learner to communicate in his own way. 

 

Time Guideline: 30 min 

 

Purpose:  To highlight the importance of communication in personal life and business 

environment. 

 

Presentation: 

 

1- Ask learners if they agree or disagree to the statement (purpose). 

2- Ask learners why they agree that communication is important. 

3- Ask learners to select a topic from daily life and try to communicate their 

ideas to the class. 

4- Encourage the learners for their try. 

 

Requirement Gathering through Communication 

Description:  This activity consists of an interactive session in the class about how to interview a 

customer with effective communication to gather all the requirements. 

 

Time Guideline: 30 min 

 

Purpose:  To highlight the importance of communication for gathering requirements in a project. 

 

Presentation: 

 

1- Select a volunteer in the class who can act as customer. 

2- Brief the volunteer about the requirement of the project 

3- Interview the customer utilizing all the communication skills. 

4- Present to the class all the collected information that can be used in future 

activities. 
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Learning Unit 2: Communicating with Seniors, Peers and 
Subordinates 

Overview 

In this learning you will learn importance and different skills and techniques used to communicate with colleagues, 

seniors, junior, peers etc. After the completion of this unit, you will be able to demonstrate effective 

communication with your colleagues and Interact with other professionals involved in design development 

through effective teamwork. 

1. Communicating Effectively with Colleagues, Peers and the Community 

Communicating effectively with your colleagues decreases misunderstandings and increases work efficiency as 

much as possible. Effective communication also produces healthy working relationships, and allows you and your 

colleagues to resolve issues in a collaborative manner.  

Here are some ways to communicate better with your colleagues at work: 

Listen Actively 

Listening actively shows that you’re interested in what your colleague has to say and 

that you respect them. Listen to them closely, orienting your body towards them, and 

look at them directly as they speak. While they’re talking, don’t interrupt them. You’ll 

only be able to understand what they’re trying to say if you listen to them closely and 

wait for them to finish speaking before you reply. Then ask questions to clarify any 

issues you may have. Most importantly, don’t email or text while someone’s talking to 

you. 

Speak with Discretion and Talk Face to Face 

Face to face communication helps through building trust and openness, and it enables 

you to sense and understand someone’s viewpoint and feelings. Also talk face to face 

to resolve disagreements or fix complex problems, and use clear, friendly and polite 

language. 

 

Offer Constructive Criticism 

When giving feedback, leave your personal feelings out of it and make sure your 

workmate fully understands what you’re telling them. If someone did a great job, offer 

positive reinforcement and also give them improvement tips without being mean or bossy. 

Build and Earn Trust 

For effective communication, everyone must trust and respect each other. To build trust 

with your colleagues, it’s important that you act consistently and with integrity. To earn 

their trust, communicate clearly, collaboratively and confidentially with them while 

showing them respect. Clear and concise communication will allow your colleagues to 

understand and then trust you. As a result, there will be more cooperation and less 

Arms crossed and 
shoulders hunched, 
on the other hand, 
suggest disinterest 
in conversation or 
unwillingness to 
communicate. 

Do you know! 

People will judge 
your competency 
through your 
vocabulary. If you 
aren’t sure of how to 
say a word, don’t 
use it. 

Remember 

People will perceive 
you as nervous and 
unsure of yourself if 
you talk fast. 

Remember 
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conflict in the workplace. Your main objective for communicating with colleagues is to lay the foundations for 

trust. 

Get Personal but Don’t be too Casual 

Get to know your colleagues better by talking about your personal lives during breaks or after work. This is also 

a good way to build trust. However, it’s important that you don’t get too casual in your conversations, especially 

in the office, as it might make the other person uncomfortable. Make sure that all communications, including your 

work emails, phone calls and meetings are professional and avoid using offensive language in the office. 

Consider Communication Preference and Technology Etiquette 

Some people like communicating via email while others prefer talking on the phone, texting, or using social media 

or instant messaging. Use the method of contact that the other person prefers. If someone doesn’t answer a call 

but responds quickly to an email, then use email to contact them. However, using email and social media makes 

it hard to determine the tone of a message. To avoid misunderstandings, it can sometimes be better to speak 

face to face. 

Tell them how what you’re Communicating is Relevant to them 

Your communication is only relevant if it’s related to what the other person wants, needs, fears or desires. Figure 

out how what you’ll say or write is relevant to your colleague and then tell them about it. If what you’re 

communicating is indeed relevant to them, then it will keep them listening to or reading what you’re trying to say. 

Keep Spoken and Written Communications Short, Simple and Direct 

Don’t expect your colleague to listen and read everything that you’re trying to tell them because there’s just not 

enough hours in the day. Try to avoid giving them complex explanations and recommendations with the 

expectation they will understand everything straight away. It’s best to keep your communications short, simple 

and direct. 

Overall, when communicating with your colleagues you should maintain confidentiality, and treat them as you’d 

like to be treated. It’s also important to have open lines of communication between colleagues to better serve 

each other. 

2. Monitoring and Critically Reflecting your Communication Skills 

Monitoring Progress 

 Evaluate information obtained from discussions with others by collected  material, identifying opinion 

and possible bias. 

 Organize information by identifying the various arguments and presenting your comprehension in a 

way that brings together information coherently. 

 Communicate relevant information about a subject in a form that suits your purpose. For that;  

 

 Take a leading role in group discussions, clearly presenting your statement and using 

appropriate vocabulary and emphasis to make your points. 
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 Write properly formatted documents, structuring the material and presenting arguments and 

information in a logical sequence, and ensure that spelling, punctuation and grammar are 

accurate. 

 Respond intelligently to contributions from others.  

 

 Monitor and critically reflect on your use of communication skills including: 

 

 Obtaining feedback from others 

 Keeping choices in mind and note down their impact. 

 Adapt your strategy to overcome difficulties and produce the quality of 

outcomes required. 

Evaluating Strategy and Presenting Quality of Outcomes 

 Organise and clearly present relevant information, including your outcomes, illustrating what you say 

by making comparisons, providing examples that relate to the interests of the audience and using a 

range of methods to illustrate complex points. 

 Vary use of vocabulary and grammatical expression to convey particular effects, enable fine 

distinctions to be made and engage your audience. 

 Assess the effectiveness of your strategy, identifying factors that had an impact on the outcomes. 

 Identify ways of further developing your communication skills. 

 

  

Observe and check 
the progress or 
quality of 
(something) over a 
period of time. 

Monitoring 
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Learner’s Activity 

Understanding the Importance of Communication with 
Team Members and Colleagues 

Description:  This activity consists of a group assignment where class is divided into groups and 

groups are assigned some problems. The group members work together as a team 

and solve the problem.  

 

Time Guideline: 30 min 

 

Purpose:  To highlight the importance of team collaboration. 

 

Presentation: 

 

1- Divide the class into groups of five. 

2- Assign each group some graphic work like logo for institute on paper etc. 

and some time limitation. 

3- Ask learners to share ideas with group members and utilize your combined 

ideas to solve the problem. 
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Summary of Module 

  The process of exchanging information, thoughts and ideas is called communication. Interpersonal 

communication means interacting with people at personal level.  

  In order to interact with the social environment, one needs to learn skills like listening, non-verbal 

communication, clarity and concision, friendliness, confidence, empathy, feedback and the selection 

of right medium for communication. 

  Requirement gathering is an essential step in every project. Through effective communication, 

requirements are gathered from the customer. Clearer the requirements, finer will be the product. 

  Every department is dealing with the stakeholders. Negotiating with stakeholders and letting them 

know about mutual benefits enables them to undertake decision as partners. 

  Communication can be performed in two ways, oral and written; oral communication is easy and has 

in-time response. Written communication contains concrete document that can be used for future 

reference. 

  All the gathered information from the customer is then documented, objectives are defined and final 

product specifications are developed. 

  It is important to use your communication skills to exchange ideas and collect information from your 

colleagues, seniors and juniors. It will develop healthy working relationships, and allows you and your 

colleagues to resolve issues in a collaborative manner.  

  Organize and clearly present the outcomes giving relevant examples which are in the interest of the 

audience.  

 

  



 Module 7: Communicating with Others 

Teaching and Learning Material: Information Technology (Computer Graphics – Print)                                                         | 261 

Frequently Asked Questions (FAQs) 
FAQ 1:  Why is communication important for an organization? 

Answer 
Communication is important for an organization because without effective communication, there 
will be no mutual sharing of thoughts, ideas, news etc. 

FAQ 2:  What is the difference between communication and interpersonal communication? 

Answer 
The process of exchanging information or news etc. is called communication. Interpersonal 
communication refer to the communication we do in our daily life at personal levels. 

FAQ 3:  What does the communication skill empathy means? 

Answer 
Empathy means always respecting other people’s point of view even when you disagree with an 
employer, coworker, or employee. 

FAQ 4:  Why is requirement gathering important? 

Answer 
Requirement gathering is one of the most important task in deciding the success of a project 
because, a poor requirement gathering will result in a poor outcome thus useless. 

FAQ 5:  What are useful skills for exact requirement gathering? 

Answer 
Involve the customer form start, clarify the doubts, confirm gathered material by playing them 
back, and create a prototype to confirm the requirements. 

FAQ 6:  Who are stakeholders? 

Answer A stakeholder is an individual or group who has an interest in the outcome of body of work. 

FAQ 7:  What is goal or objective? 

Answer 
A specific result that a person or system aims to achieve within a time frame and with available 
resources.  

FAQ 8:  What is feasibility study? 

Answer 
Feasibility study is an analysis of the achievability of an idea keeping in view the resources and 
time available. 

FAQ 9:  What is the purpose of effective communication with colleagues? 

Answer 
Communicating effectively with your colleagues decreases misunderstandings and increases 
work efficiency as much as possible. 

FAQ 10:  How can you present your point clearly? 

Answer 
By making comparisons, providing examples that relate to the interests of the audience and 
using a range of methods to illustrate complex points. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  Select the non-verbal type of communication from the following: 

a.  Oral b.  Written 

c.  Gestures d.  Clues 

2.  Requirement are gathered through ____________________. 

a.  User involvement. b.  Pre assumption 

c.  Your perception d.  Documentation 

3.  Stakeholders are facilitated to increase understandability as ____________. 

a.  Showing them documentation b.  Presenting project specifications 

c.  Accepting their terms d.  Telling them mutual benefits and negotiating. 

4.  Advantage of written communication is ____________. 

a. 
A written document that can be used 
for future reference 

b. Writing a document is easy 

c. Consumes less time in communication d.  Increases understandability of the document. 

5.  Select the INCORRECT option, A goal set should be __________________. 

a. Relevant b. Broad 

c. Achievable d.  Time Bound 
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6.  Feasibility study keeps in account______________________. 

a. Time, resources, orders b. Resources, legalities, stakeholders 

c. Time, resources, legalities d.  Stakeholders, orders, time 

7.  Constructive criticism means __________________. 

a. Appreciate all type of work. b. Point out the negative points. 

c. 
Keep your personal feeling out while 
giving feedback. 

d.  
Keep yourself out of other’s work. 
 

8.  You can monitor and reflect on your use of communication skills including ___________. 

a. Obtaining feedback from others b. Making changes yourself 

c. Updating according to latest trends d.  Developing good relation with other 

9.  Assess the effectiveness of your strategy by ____________________. 

a. Looking at audience expressions b. 
Identifying the factors that had an Impact on 
outcomes 

c. From the evaluation results d.  Reviewing the planning 

10.  Final product requirements that meets customer needs depends upon _______________. 

a. The resources b. Requirement gathering 

c. Customer behavior  d.  Times available 

  



Module 7: Communicating with Others 

264 |                                                         Teaching and Learning Material: Information Technology (Computer Graphics – Print) 

Answer Key 
MCQ Number Correct Answer 

1 c 

2 a 

3 d 

4 a 

5 b 

6 c 

7 c 

8 a 

9 b 

10 b 
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Module 8: Duties and Rights at a Work 
Place 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Understand and perform the mandatory standard for 

Responsibility, Respect, Fairness and Honesty. 

  Identify tasks, their scheduling, define milestones, and learn 

optimal utilization of resources. 

  Recognize the aspirational requirements of human rights in 

employment context. 

  Understand the legal right granted to an author, composer, 

publisher, production, or any other artist’s work. 

  Understand that unauthorized use or reproduction of 

copyright or patented material is illegal 

  Understand that you can’t give the design made for and sold 

to one client to the others. 
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Learning Unit 1: Ethics and Professional Conduct 

Overview 

In this leaning unit, you will learn the four values that serve as the foundation for decision making and guidance 

to the action of the employees i.e. Responsibility, Respect, Fairness, and Honesty. After the completion of this 

learning unit, you will be able to identify and practice the mandatory standards for these four values. 

 
Four Values of Ethics and Conduct 

 

1. Responsibility 

“Responsibility” is our duty to take ownership for the decisions we make or fail to make, the actions we take or 

fail to take, and the consequences of those decisions and actions. The responsibility involves two types of 

standards working in a work place. 

1- Aspirational Standards 

2- Mandatory Standards 

Aspirational Standards 

Working in an organization, following aspirational standards need to be followed. 

 

 Take decisions and perform actions which are in the best interests of the society, are not a risk for public 

safety, and beneficial for the environment. 

 Accept only those assignments that are consistent with your background, experience, skills, and 

qualifications so that you can fulfill the assignment with professional conduct. 

 Always fulfill the commitments that you undertake, you should do what you say you will do. 

 If you make errors or omissions, take responsibility and make corrections instantly. If you come to know 

that the errors or omissions were caused by others, communicate them to the appropriate person as 

soon they are discovered. Accept accountability for any issues resulting from your errors or omissions. 

Ethics and 
Professional 

Conduct

Resposibility

Respect

Fairness

Honesty

The state or fact of 
having a duty to deal 
with something or of 
having control over 
someone. 

Responsibility 
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 Protect proprietary or confidential information shared with you by the customer as a result of trust on you. 

Mandatory Standards 

Requirement standards that all the employees must fulfill include: 

 You should know and maintain the policies, rules, regulations and laws that control your work, 

professional behavior, and volunteer activities. 

 Report unethical or illegal behavior to appropriate management and, if necessary, to those affected by 

the manner. 

 Bring violations to these standards to the attention of the suitable body for resolution. 

 Only those ethics complaints should be filed which are validated by facts. 

 Follow disciplinary action against an individual who reacts against a person raising ethics concerns. 

2. Respect 

Respect refers to show a high regard for ourselves, others, and the resources assigned to us. Resources 

entrusted to us may include people, money, reputation, the safety of others, and natural or environmental 

resources. 

An environment of respect creates trust, confidence, and performance excellence by raising mutual cooperation. 

An environment where various thoughts and views are encouraged and valued. 

Aspirational Standards 

The aspirational standards of respect include 

 Should inform ourselves about the rules and traditions of others and avoid engaging in behaviors they 

might consider disrespectful. 

 Listen to others’ points of view, in order to understand them. 

 Approach directly those persons with whom you have a conflict or disagreement. 

 Conduct in a professional manner, even when it is not replied the same way. 

Mandatory Standards 

The mandatory standards of respect are as follows 

 Negotiate in good faith. 

 Do not exercise the power of your expertise or position to influence the decisions or actions of others in 

orders to get benefit personally at their expense. 

 Do not act in a rude manner towards others. 

 Respect the property rights of others. 

3. Fairness 

Fairness is our duty to make decisions and act neutrally and objectively. Our conduct must be free from competing 

self-interest, bias, and favoritism. 

Aspirational Standards 

The aspirational standards for fairness are: 

 Always demonstrate transparency in your decision-making process. 

 Constantly re-examine your neutrality and objectivity, taking corrective action if necessary. 
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 Provide equal access to information to those who are authorized to have that 

information. 

 Make opportunities equally available to qualified candidates. 

Mandatory Standards 

The mandatory standards for fairness are as under: 

 Fully disclose any real or potential conflicts of interest to the appropriate 

stakeholders. 

 If you realize that you have a real or potential conflict of interest, avoid engaging in the decision making 

process or otherwise attempting to influence outcomes until you have made full disclosure to the affected 

stakeholders. 

 Never hire or fire, reward or punish, or award or deny contracts based on personal considerations, bias, 

or favoritism. 

 Never discriminate against others based on gender, race, age, religion, disability, nationality, or sexual 

orientation. 

 Apply the rules of the organization (employer, Project Management Institute, or other group) without 

favoritism or prejudice. 

4. Honesty 

Honesty is our duty to understand the truth and act in a truthful manner both in our communications and in our 

conduct. 

Aspirational Standards 

Aspirational standards for honesty includes: 

 Sincerely try to understand the truth. 

 Always be truthful in your communications and in your conduct. 

 Provide accurate information in a timely manner. 

 Always make commitments and promises, unspoken or clear, in good faith. 

 Should strive to create an environment in which others feel safe and comfortable to tell the truth. 

Mandatory Standards 

Mandatory standards for honesty include: 

 Do not engage in or ignore behavior that is designed to deceive others, making misleading or false 

statements, stating half-truths, providing information out of context or withholding information that, if 

known, would render your statements as misleading or incomplete. 

 Do not engage in dishonest behavior with the intention of personal gain at the expense of another 

 

  

In the workplace, 
perceived injustice 
has been directly 
linked to burnout 
and job 
dissatisfaction. 

Remember 
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Learner’s Activity 

Taking ownership of decisions made 

Description:  This activity requires all the students to plan a role play that will depict the importance 

of taking responsibility of decision made and their consequences.  

 

Time Guideline: 30 min 

 

Purpose:  To highlight the importance of responsibility 

 

Presentation: 

 1- Call two volunteers from the class one who will act as customer and other as 

employee. 

2- Brief them about the role play that the employee will confess about a 

decision that caused some loss at client side and now he is ready to take the 

responsibility and make up for the loss. 

3- Encourage the students to give suggestions. 

4- Have a discussion with students, what did they learn from this activity. 
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Learning Unit 2: Planning of the Business Process 
Activities 

Overview 

In this learning unit, you will learn about different concepts and activities involved in the planning of the business 

process activities. After the completion of this learning unit, you will be able to assist the in-line managers, define 

activities like specific life cycle methodologies, estimate time for activities, and perform breakdowns of the work 

and leveling the resources. 

 

1. Provide due Assistance to In-Line Manager 

While working at a workplace, it is important and adds to good list that you provide assistance to the managers. 

You can provide assistance in the following tasks 

Coordinating Recurring Meetings 

It is important that every meeting run as smoothly as it can. But this is especially important for recurring meetings 

when the same group of people regularly gather to accomplish the same goal.  

 Schedule recurring meetings properly using software like outlook calendar, or 

some other good schedule software so that can be kept informed about 

schedule every time.  

 Organize the meeting venue  

 Inform the attendees about the schedule and make the agenda of the meeting 

clear to them.  

 Make sure that documents to be used and other equipment like computer etc. 

are ready to use. 

Intimate Resource Availability 

A project plan is considered to be good if tasks are as clearer as possible and 

resources needed to accomplish those tasks are readily available. Before assigning 

individuals to tasks, associate a task with a resource type. Then enter the expected 

duration of that task based on the resource chosen. This ensure the intimate resource 

availability. 

Create and Keep Documentation 

You can assist in-line managers by maintaining the documents about meetings, resource assignments, project 

assignments and completion status, client history etc. This involves the creation and updating of documentation. 

Documentation provides a great help as a written proof and for future consultations. 

Validate Applicable Company Defined Standards 

It is definitely important to validate and follow established company standards for the duration of your 

employment. Be honest to yourself about your conduct and make adjustments where necessary. You should be 

informed and understand all the company standards but pay particular attention to the ones that are specific to 

Resources needed 
to be available can 
be machinery, 
equipment, human 
or time 

Remember 

The agenda of 
recurring meeting 
depends upon the 
management 
decision. It may be 
to present status 
report to attendees 
or to plan for the 
next phase. 

Do you know! 
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your job role in the company. Try to help other employees to understand and follow the company applicable 

standards. 

 

2. Explain Activities 

In order to perform good project management, you should be able to apply specific life cycle methodology to the 

project development. During a project development, the undergone activities belong to some specific phase. It 

is necessary to define what phase an activiy belongs to. Application of life cycle methodology help a company 

to deliver projects effectively. 

The different phases of life cycle are: 

Requirement Gathering 

Requirement gathering is the first and the most important phase of any project development. The specifications 

of the project results are an outcome of requirements gathered. The acivities involved in this phase include 

interviewing the potential users or employees of the company about their needs for the final product (in case of 

new system replacing an old one, interviewing them about the problems they face in the existing system), 

verfication of the gathered information, documentation of information for further development. 

Design Solution 

During this phase, the gathered requirements are analysed and assesed to find out 

the problem. The activities in this phase include plans are laid out concerning the 

physical construction, hardware, operating systems, programming, communications, 

and security issues.  

Prototype  

At this phase, instead of freezing the requirements before a design or coding can 

proceed, a prototype is built to understand the requirements. This prototype is 

developed based on the currently known requirements. By using this prototype, the 

client can get an “actual feel” of the system, since the interactions with prototype can enable the client to better 

understand the requirements of the desired system. 

Testing 

After the prototype is approved, the life cycle proceeds to the final product that fulfills the gathered requirements. 

This product is then tested throughly using series of testing techniques. Product should be tested from every 

aspect and in all the possible conditions and audience. If any problem arise during testing, should be corrected. 

Documentation 

In this phase, the activities performed include, preparing documentation of the various area that need to be 

documented. This documentation can be used as written proof, can be used as a help for future consultation if 

some problem arises. 

 

 

 

A prototype is an 

instance of a 

working product, 

representing all the 

specification of final 

project. 

Prototype 
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3. Estimate Time 

Whether you bill clients hourly or on a per project basis, a necessary step of all projects 

is estimating the time it will take. You need to estimate time accurately if you're going 

to deliver your project on time and on budget. Without this skill, you won't know how 

long your project will take, and you won't be able to get commitment from the people 

required to help you achieve your objective. Not only does the client want to have an 

idea of how much money they will be spending, but they also need to plan around an 

estimated timeline. And you need to be able to ensure you have the time and resources 

necessary to complete the project. 

Time estimation depends on a number of factors, including how much experience you 

have with the type of work you’re doing. 

 

Identify the Product Deliverables 

The first step is to identify the main project (i.e. Website Redesign), and then pinpoint the specific deliverables 

associated with the project. For example, upon completion of the redesign, you will be providing the client with a 

newly designed website by transferring the site files and sending the client a CD or USB drive with the working 

files. 

Breaking the Project in Sub Tasks 

Next, take the project and break it down into simple tasks. At the end of this step, you will have a list of activities 

that will take us to the deliverables. Now, list all of the activities you identified in the order in which they need to 

happen. 

Estimate Time for Each Step 

The next step is to estimate time in hour for each task or activity, rounding up. To begin with, estimate the time 

needed for each task rather than for the project as a whole. Then take the total time for all of the tasks and add 

in a buffer. The buffer can be anything, although I usually stick with a 10-25% addition. This helps to deal with 

any unexpected situations or challenges that arise. 

Things to Keep in Mind 

Following points need to be kept in mind while calculating total time required by a project 

 Project management time 

 All the constraints that are relevant, it will help to identify risks. 

 Consider calendar year official leaves,  

Work timings of the company. 

 Debugging 

 

 

 

 

Time estimation 
depends on a 
number of factors, 
including how much 
experience you have 
with the type of work 
you’re doing. 

Remember 



Module 8: Duties and Rights at a Work Place 

274 |                                                        Teaching and Learning Material: Information Technology (Computer Graphics – Print) 
 
 

4. Achieve Work Breakdowns 

Dividing complex projects into simpler and manageable tasks is the process identified 

as Work Breakdown Structure (WBS). Usually, the project managers use this method 

for simplifying the project execution. In WBS, much larger tasks are broken down to 

manageable chunks of work. These chunks can be easily supervised and estimated.  

Following are a few reasons to achieve work breakdown in your project. 

 Accurate and readable project organization. 

 Accurate assignment of responsibilities to the project team. 

 Indicates the project milestones and control points. 

 Helps to estimate the cost, time and risk. 

 Illustrate the project scope, so the stakeholders can have a better understanding of the same. 

 

Construction of Work Breakdown Structure 

Identifying the main deliverables of a project is the starting point for a work breakdown structure. This important 

step is usually done by the project managers involved in the project. Once this step is completed, the subject 

matter experts start breaking down the high-level tasks into smaller chunks of work. 

In the process of breaking down the tasks, one can break them down into different levels of detail. One can detail 

a high-level task into ten sub-tasks while another can detail the same high-level task into 20 sub-tasks. 

Therefore, there is no hard and fast rule on how you should breakdown a task in WBS. Rather, the level of 

breakdown is a matter of the project type and the management style followed for the project. 

 

Module Work Breakdown Example 

Goals of Work Breakdown 

There are many design goals for WBS. Some important goals are as follows: 

 Giving visibility to important work efforts. 

 Giving visibility to risky work efforts. 

 Illustrate the correlation between the activities and deliverables. 

 Show clear ownership by task leaders. 

Work breakdown is 

not restricted to a 

specific field when it 

comes to 

application. This 

methodology can be 

used for any type of 

project 

management.  

Do you know! 
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Conclusion 

The efficiency of a work breakdown structure can determine the success of a project. The WBS provides the 

foundation for all project management work, including, planning, cost and effort estimation, resource allocation, 

and scheduling. 

Therefore, you should take creating Work Breakdown as a critical step in the process of project management. 

 

5. Level Resource due to Work Load 

Research indicates that it is not just the amount of work that makes a difference in 

employee satisfaction and success, but also the extent to which employees have the 

resources (time, equipment and support) to do the work well.  

Resource leveling is a technique in project management that deals with resource 

allocation and resolves any possible conflict that can arise from wrong allocation. When 

project managers take a project, they need to plan their resources accordingly. This 

helps an organization to avoid any conflicts and being able to deliver the project on 

time. Resource leveling is considered one of the key elements to resource 

management in the organization. 

An organization starts to face problems if resources are not allocated properly i.e., some resource may be over-

allocated whilst others will be under-allocated. Both will bring about a financial risk to the organization.  

Key Elements of Resource Leveling 

The main aim of resource leveling is to allocate resource efficiently, so that the project can be completed in the 

given time period. Resource leveling can be broken down into two main areas.  

 Projects that can be completed by using up all resources, which are available and projects that can be 

completed with limited resources. 

 Projects, which use limited resources can be extended for over a period of time until the resources 

required are available.  

Process of Resource Leveling 

Resource leveling helps an organization to make use of the available resources to the maximum. The idea behind 

resource leveling is to reduce wastage of resources i.e. to stop over-allocation of resources. 

Project manager will identify time that is unused by a resource and will take measures to prevent it or making an 

advantage out of it.  

By resource conflicts, there are numerous disadvantages suffered by the organization, such as: 

 Delay in certain tasks being completed 

 Difficulty in assigning a different resource 

 Unable to change task dependencies 

 To remove certain tasks 

 To add more tasks 

 Overall delays and budget overruns of projects 

 

Resource leveling is 
a (project 
management) 
"technique in which 
start and finish dates 
are adjusted based 
on 
resource constraints
. 

Level Resource 
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Learning Unit 3: Awareness to Rights 

Overview 

In this learning unit, you will learn about their rights at the workplace. After the completion of this module, you will 

be able to define and know the importance of the policies, rules and regulations that administer the work and 

workplace, reporting the illegal conduct or illegitimate action to appropriate management and the importance of 

protecting the propriety or confidential information. 

 

1. Inform Ourselves and Uphold the Policies 

Policies, rules or regulations communicate an organization’s values and the 

organization’s expectations of employee behaviors and performance. Workplace 

policies support and clarify standard operating procedure in a workplace. They help 

organization to manage staff more effectively by clearly defining acceptable and 

unacceptable behavior in the workplace, and define the effects of not complying with 

those policies.  

A policy may also be required where there is a large number of interests and 

preferences, which could result in unclear and conflicting objectives among those who 

are directly involved.  

They set rules and guidelines for decision-making in routine situations so that employees and managers do not 

need to continually ask senior managers what to do. They help you to adopt a consistent and clear response 

across the company to continually refer to situations involving employee interaction.  

We should understand well and support these policies, rules, regulations and laws that govern our work, 

professional, and volunteer activities. These rules, regulation and policies protect business and workers and if 

correctly implemented and executed, create and maintain a better work environment for all. 

 

2. Report Illegal Conduct or Illegitimate Action to Appropriate Management 

From time to time, workers may violate the policies or laws established for a business 

or company. Even if an employee breaks the rules with the best of intentions, the flow 

of the workplace can be impacted negatively.  

It is the responsibility of a worker to report illegal or illegitimate action to appropriate 

management. That needs to encourage employees to bring ethical and legal violations 

they are aware of to an internal or responsible authority so that action can be taken 

immediately to resolve the problem.  

It important to minimize the exposure of organization to the damage that can occur when employees circumvent 

internal mechanisms. For this purpose organization should let employees know the organization is serious about 

adherence to codes of conduct. 

The main barriers to lack of confidence in employees to report illegitimate conduct can be 

 A lack of trust in the internal system 

 Unwillingness of employees to be "informers" 

 Misguided union solidarity 

A policy is a 
statement which 
explains how human 
resource 
management issues 
will be dealt with in 
an organization. 

Policy 

In an organization a 
whistleblower is a 
person who raises a 
concern about a 
wrong doing in their 
workplace. 

Whistleblower 
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 Belief that management is not held to the same standard 

 Fear of revenge 

 Fear of isolation from peers  

It is the moral and social responsibility of the employees to report unethical or illegal 

conduct to appropriate management and if necessary to those affected by the conduct. 

If he sees any illegal behavior including but not limited to theft, fraud, corruption or 

bribery. Furthermore someone taking or abusing the property of others including 

intellectual property. 

 

3. Protect propriety or Confidential Information 

Protecting confidential and proprietary business information, good will and relationships with clients, customers 

and key employees are matters of most important concern to any successful business. Theft of trade secrets, 

harassment of clients and customers, raiding of key employees, employee disloyalty and violations of trusty 

duties can cause irreparable loss. 

The Company’s confidential information falls into two main categories:  

a) Information developed and owned by Company.  

b) Information temporarily given to Company by its customers, collaborators and 

others.  

Every Company team member, whether a manager, employee or contractor, has a key 

role in maintaining the Company’s confidential information. 

Following policies can help to protect the company’s proprietary and secrets  

1- The Company should establish a written confidentiality protection guide and 

share it with all staff who interact with confidential information related to the 

Company. 

2- Upon hiring, each Company staff member should sign a contract that must 

include a confidentiality provision about their confidentiality promises. 

3- The staff member should refrain from disclosing a confidential information until 

management has provided clarification. 

4- A staff member should not disclose confidential information unless the staff member obtains authorization 

from management and the receiving party has signed a confidentiality agreement. 

5- Staff members should not store or keep open the confidential information on desktop or computer screen 

exposed to view when not actively used.  

6- A staff member should only share confidential information with only those staff 

members of other Company who need to know the information. 

7- The Company should prevent unauthorized user access to any electronic and 

physical areas containing confidential information.  For computers, staff 

members should password protect screensavers and password protect files. 

For hardcopy documents, staff members should limit the physical access to the 

document by locking the office door, locking a desk drawer, locking a filing 

cabinet, and / or restricting room access. 

8- A sender of an email should assume unauthorized readers will view the text 

and files contained in an unencrypted email.  A sender should not send sensitive data in an unencrypted 

email or file. 

 

It is unlawful to 
terminate an 
employee who 
reported, complains 
about some illegal or 
fraudulent conduct 
by an employer or 
co-workers. 

Do you know! 

All key staff 
members should 
read and become 
familiar with the 
guide.   

Remember 

Peer is someone at 
your own level. Peer 
comes from letin 
word “par” which 
means equal. When 
you are on par with 
some on you are 
peer. 

Peers 

Encryption is the 

conversion of data 

into a form that 

cannot be easily 

understood by 

unauthorized 

people. 

Do you know! 
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Learning Unit 4: Understanding of Copyrights and Piracy 

Overview 

In this learning unit, you will learn about the concepts of copyright material, royalty free 

contents and things that can be used and that cannot be used. After the completion of 

this unit, you will be able to adapt and purchase copyright material and royal free 

contents and will develop a sense about what can be used and what cannot be used 

from internet or other resources.  

 

1. Purchasing Copyrighted Material 

There are many "authorized" services on the Internet that provide you the facility to 

purchase copyrighted material present online including music, ebooks, or motion 

pictures. By purchasing material through authorized services, you can avoid the risks of 

infringement liability. This will also help to avoid your exposure to other potential risks, 

such as viruses, unexpected material, or spyware, which are common in file sharing 

networks. 

Legitimate Providers of Copyrighted Material 

There are many Internet-based services that provide legal access to copyrighted 

material. They have contracted with the copyright holders to allow them to provide the 

material at a discounted or per piece price. Many of the services are also based on 

monthly subscriptions. It is the responsibility of the user to identify the legitimacy of a 

service. 

Using Copyrighted Material 

Many a times it becomes necessary for you to use copyrighted materials. You must 

assure permission in written to use the material from the copyright holder. If you know 

the copyright holder, you may contact them directly to get his permission for using his 

work. If you are not sure about the owner of the copyrighted material, you can request 

the information from the United States Copyright Office. 

 

2. Royalty Free Contents 

Royalty-free, means the right to use copyrighted material or intellectual property without 

paying the royalties or license fees for each use or per volume sold, or some time period 

of use or sales.  

In photography and the illustration industry, it means a copyright license where the user 

has the right to use the picture without restrictions based on one-time payment to the 

licensor. It doesn’t mean that you have bought the file outright. The user will pay for 

license once and use the image in many projects without a need to purchase additional licenses. Royalty Free 

licenses cannot be given on private basis. In stock photography, RF is one of the common licenses. 

A photo that is royalty-free might have licensed hundreds or even thousands of times, it might have appeared in 

different projects from major advertising campaigns to homemade postcards. 

It means violation of 
laws, regulations are 
agreement. 

Infringement  

Copyright is a law 
that protects any 
original creation, 
and grants the 
holder of the 
copyright exclusive 
control over when, 
how, and by whom 
their work may be 
copied, distributed, 
or exhibited. 

Copyright 

The unauthorized 

use or reproduction 

of another's work is 

called Piracy 

Do you know! 
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Advantages of Royalty Free License 

A royalty-free license helps you to: 

 To buy licensed contents, relatively inexpensive as compared to content shot expensive for your project. 

 Keep using the content again and again with no time limit. 

 Use the content in many different ways (i.e.: print, video, or on the web). 

Thing you can do with Royalty Free Files 

 Publish photos or text on websites or in web ads. 

 Use photos in print ads 

 Use these contents in printed promotional projects 

 Add video footage to commercial film and video 

 In books or on book covers, on CD and DVD covers, and in editorial content 

3. What to use and what not to use from Internet 

The biggest advantage of using the Internet as a research tool is the ease with which 

you can find information. The biggest disadvantage, then, is going through the crowd of 

information to find credible, reliable, accurate information. 

It is essential to evaluate online and other sources to assure that the material you take 

from them is credible, reliable, and accurate. 

Following points can help you to decide what is reliable at internet or other resources 

 If you fail to accurately evaluate your Internet and other information sources, it 

will question the credibility of your speech subject and require its intense 

scrutiny. 

 Consider the "age, depth, author and money" of every source you use from the 

Internet. 

 Top-level domain of a website can give you clues about the reliability of its 

contents. Generally, it's safe to trust information from sites with domain names 

that end in .edu, .gov and .ngo and sometimes .org. 

 While using and evaluating social media sources, you should be aware of sites that have a poor 

reputation for checking facts or moderating content. 

 

Social Media and Multimedia Sources 

The rapid growth of social media and its ability to distribute relevant information to multiple users based on shared 

interests and relationships has increased its importance in the world of Internet research. Wikipedia, one of the 

most popular research websites in the world, relies on scholarly material and is providing accurate, targeted, and 

comprehensive information to the users. 

Self-published media like e-books, newsletters, open wikis, blogs, social networking pages, Internet forum 

postings, or tweets should be used with caution. Self-published material may be acceptable when it has been 

produced by an established expert on the topic he has a good command on, and whose work in the relevant field 

has been previously published by reliable third-party publications and proved itself.  

 

  

The objective and 
subjective 
components of the 
believability of a 
source or message 
is called credibility. 

Remember 
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Summary of Module 
 

  If you make errors or omissions, take responsibility and make corrections instantly. If you come to 

know that the errors or omissions were caused by others, communicate them to the appropriate 

person as soon they are discovered. 

  Should inform ourselves about the rules and traditions of others and avoid engaging in behaviors 

they might consider disrespectful. 

  If you realize that you have a real or potential conflict of interest, avoid engaging in the decision 

making process or otherwise attempting to influence outcomes until you have made full disclosure to 

the affected stakeholders. 

  Do not engage in or ignore behavior that is designed to deceive others, making misleading or false 

statements, stating half-truths, providing information out of context or withholding information that, if 

known, would render your statements as misleading or incomplete. 

  You can provide assistance to the manager by coordinating meetings, intimate resource availability, 

creating and keeping documentation, validating company’s defined standards. 

  It is a professional approach to apply life cycle methodology to project and define its activities as 

phase like requirement gathering, planning design, prototype, testing and documentation. 

  You need to estimate time accurately if you're going to deliver your project on time and on budget. 

The first step is to identify the main project, take the project and break it down into simple tasks, 

estimate time in hour for each task or activity, then take the total time for all of the tasks and add. 

  Resource leveling is a technique in project management that deals with resource allocation and 

resolves any possible conflict that can arise from wrong allocation. 

  We should understand well and support these policies, rules, regulations and laws that govern our 

work, professional, and volunteer activities. 

  It is the moral and social responsibility of the employees to report unethical or illegal conduct to 

appropriate management and if necessary to those affected by the conduct. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What are the four values that serve as the foundation of ethical and professional conduct? 

Answer These are Responsibility, Honesty, Fairness and Respect. 

FAQ 2:  What is meant by fairness? 

Answer 
Fairness is, our duty to make decisions and act neutrally and objectively. Our conduct must be 
free from competing self-interest, bias, and favoritism. 

FAQ 3:  What is recurring meeting? 

Answer 
Recurring meetings are where the same group of people regularly gather to accomplish the same 
goal. Its agenda may depend upon the company’s policy. 

FAQ 4:  What are the phases of life cycle? 

Answer 
The main phases of a life cycle are requirement gathering, design solution, prototype, testing 
and documentation. 

FAQ 5:  What is prototype? 

Answer 
A prototype is an instance of a working product, representing all the specification of final project. 
Prototype is developed to verify and asses customer’s needs about the final product. 

FAQ 6:  What is buffer in time estimate? 

Answer 
The buffer can be anything, although I usually stick with a 10-25% addition. This helps to deal 
with any unexpected situations or challenges that arise. 

FAQ 7:  What rule is used for work breakdown? 

Answer 
There is no hard and fast rule on how you should breakdown a task in work breakdown structure. 
Rather, the level of breakdown is a matter of the project type and the management style followed 
for the project 

FAQ 8:  What is meant by resource leveling? 

Answer 
Resource leveling is a technique in project management that deals with resource allocation and 
resolves any possible conflict that can arise from wrong allocation 

FAQ 9:  Why are policy important for an organization? 

Answer 
Workplace policies help organization to manage staff more effectively by clearly defining 
acceptable and unacceptable behavior in the workplace, and define the effects of not complying 
with those policies. 

FAQ 10:  What is copyright law? 

Answer 
Copyright is a law that protects any original creation, and grants the holder of the copyright 
exclusive control over when, how, and by whom their work may be copied, distributed, or 
exhibited. 
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Test Yourself! 
Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  _____________ is our duty to take ownership for the decisions we make.  

a.  Respect b.  Honesty 

c.  Responsibility d.  Fairness 

2.  
 ____________________ refers to show a high regard for ourselves, others, and the 
resources assigned to us. 

a.  Respect b.  Honesty 

c.  Responsibility d.  Fairness 

3.  First step of life cycle methodology is _________________. 

a.  Design Solution b.  Requirement gathering 

c.  Testing d.  Prototype 

4.  Goal of work breakdown is _____________. 

a. Giving visibility to important work efforts. b. Giving visibility to risky work efforts 

c. Show clear ownership by task leaders d.  All of them 

5.  The idea behind resource leveling is ____________. 

a. Reduce wastage of resources b. Purchase resources 

c. Assign resources permanently d.  Estimate time for resources 

6.  Buffer in time estimate adds _________________ to time estimate. 

a. 30 – 40 % b. 25 – 35 % 

c. 5 – 10 % d.  10 – 25 % 

7.  Select the INCORRECT option: reasons to achieve work breakdown are: 

a. 
Accurate and readable project 
organization 

b. Point out the negative points in project. 

c. 
Indicates the project milestones and 
control points 

d.  Helps to estimate the cost, time and risk. 
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8.  A policy is __________________. 

a. 
A statement which explains how human 
resource management issues will be 
dealt with in an organization. 

b. 
A rule that helps in estimating the time for 
project. 

c. 
A statement that describes the history 
concerns of the organization. 

d.  
All of them 
 

9.  The unauthorized use or reproduction of another's work is called _________________. 

a. Copyright b. Royalty Free content 

c. Piracy d.  Trade Mark 

10.  Royal Free allows you to ______________. 

a. Purchase contents b. Change contents 

c. Purchase license d.  Both A and B 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 a 

3 b 

4 d 

5 a 

6 d 

7 b 

8 a 

9 c 

10 c 

 

 




